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Preface

This instruction manual describes how to use the inverter support software VFD Doesa-Loader. This
instruction manual does not cover the handling of inverters. For information on the handling of inverters,
refer to instruction manuals or user's manuals.

If you use a folder name or file name that contains environment-dependent characters
created in a Windows that differs from the language specifications of your Windows, you
may not be able to read or write the file. Use folder and file names that do not contain
environment-dependent characters.

If the settings shown below are set in the Windows of use, the characters may protrude.

+ When the size of text or the like is set to a size larger than specified in the [Display]
setting of the control panel.

- In the Windows10, when the size of text or the like is set to a size larger than the
specified size in [Settings]—[System]—[Display] settings.

Some of the views may be in languages or fonts that depend on your Windows

preferences.

If you do not install language packs Microsoft. NET Framework Ver. 4.5 or higher, some of
the displayed languages may become English.

The resolution of the monitor is recommended to be 1920 x 1080 or more. Below that, the
operability may deteriorate.

Example screens shown in this manual might differ from actual displaying screen by the
software version or specifications change.

m Safety Precautions

Prior to the use (including connection, wiring, operation, maintenance, inspection, etc.), be sure to read
this instruction manual as well as the "RS-485 Communication User's Manual", instruction manuals
and user's manuals, as needed, to gain an understanding of how to handle the product and ensure
correct use of related devices. Incorrect handling may hinder normal operation or result in inverter
failure or shortening of product life.

Use your devices after ensuring a thorough understanding of device knowledge, safety information,
and all related precautions.

Safety precautions contained in this instruction manual have been categorized as follows.

&WARN I NG Failure to heed the information indicated by this symbol may result in

death or serious injury.

ACAUTION Failure to heed the information indicated by this symbol may result in

minor or light injury and/or substantial property damage.

Failure to heed the information contained under the CAUTION title may also result in serious
consequences.
All items indicate important content and therefore must be observed.




Wiring

AWARNING

e Before wiring the RS-485 ports and connecting the cables, ensure that the power is off (the switch is
open).
Failure to observe this could result in electric shock.

ACAUTION

o Before connecting wires to the RJ-45 connectors on the inverter (such as the RJ-45 connector for
keypad connection, the RS-485 communication card's RJ-45 connector, and the inverter's RJ-45
connector for RS-485 communication), check the wiring of the devices to be connected. Refer to the
" RS-485 Communication User's Manual” for details.

Failure to observe this could result in a failure.

Operating Precautions

AWARNING

o Carefully note that resetting the alarm with the operation command on causes the inverter to start
unexpectedly as soon as the alarm is cleared.
Failure to observe this could result in an accident.

AWARNING

¢ |If the loader goes down or is forcibly terminated during the operation with the test drive screen open,
it will be impossible to stop the inverter operation with the loader. If this is the case, stop the inverter
by doing one of the following:
Failure to observe this could result in an accident.
<How to stop the inverter when the loader goes down or is forcibly terminated>
1) If an emergency stop switch is available, use the switch to stop the inverter.
2) Turn off the inverter power.
3) Turn off the inverter operation command and switch the inverter from "remote command mode"
to "local command mode".
More specifically, do one of the following:
- Turn off the terminal to which the "LE" command is assigned.
- Zero the data for the link function for support (function code: y99).
- Zero the data for the link function (function code H30).

e Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test drive
screen open. Doing so would be dangerous because it would be impossible to stop the inverter
operation with the loader.

Failure to observe this could result in an accident.
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Chapter 1

Before Use

This chapter provides an overview of the inverter support loader software VFD Doesa-Loader
(hereinafter referred as "the Loader"), descriptions about preparations before using the Loader, and
procedures for installation and uninstallation.
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1.1. Overview

1.1.1. Features

- The Loader is a software that supports remote operation of our inverters from a personal
computer (hereinafter referred as "the PC") using the RS-485 communication port and the
USB connection (including the connection via the Keypad), and is designed to operate on the
Windows operating system (hereinafter referred as "the OS").

- The Loader facilitates simple operation to set or manage function codes of the inverter.

[Function code]

Can be used to read or write, edit, compare, initialize, save, or print
the parameters (function code setting data) that set the inverter
operations.

[Operation monitor]

Can be used to check the status of the external 1/0 (I/O monitor), the
Loader information or maintenance information (system monitor),
alarm occurrence information (alarm monitor), or information such as
the current frequency (operation monitor).

O

[Customizable logic]

Can be used to extend the inverter functionality and to customize for
the user interface.

[Real-time trace]

Can be used to monitor operation conditions in the form of continuous
waveform information with the maximum of four analog channels and
the maximum of eight digital channels (to the maximum total of eight
channels).

XY

[Historical trace]

Can be used to monitor inverter operation conditions in the form of
waveform information in a sampling time that is shorter than the
realtime trace. (The number of samplings is limited.)

X

[Test run]

Can be used to manipulate the frequency command or operation
command on the Loader screen to test run the inverter.

]

[Communication setting]

Can be used to make communication settings between the PC and
the inverter or with the remote keypad with USB.

Tl
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1.1.2. Loader Functions by VF1A Series Inverter Model

This section lists functions that can be used by each VF1A series inverter.

Table 1-1 Correspondence between VF1A Series Inverter Models and Loader Functions

Function VF1A series Inverter
[Function code window] ©
[Customizable logic
©
function code window]
@ [Operation monitor] ©
EZD' [Customizable logic] ©
|/\/R [Real-time trace] ©
|/\/H [Historical trace] ©
”@ [Test run] ©
=)
£
B | RS-485 (Loader ( Doesa)) ©)
5 | B
— 38
f=
g
€ | USB (via VF1A-PH1) ©
S,
Remote keypad with USB ©
(VF1A-PH1) Copy function "

©: Supported, O: Supported with restrictions, X: Not supported

*1 Supported by the VF1A-PH1 remote keypad with USB (ROM version 1600 or later).
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The following table shows the Loader functions that can be used when accessing the keypad

memory from the Loader.

Table 1-2 Correspondence between the Keypad and Loader Functions

Keypad
Function

VF1A-PH1
— O
p— [Function code window] *1
C\} [Operation monitor] ©
O
[Customizable logic] *0
|/\/R [Real-time trace] X
|/\/H [Historical trace] X
@ [Test run] X
— T usB o

A [Communication setting] (Data in Keypad)

©: Supported, O: Supported with restrictions, X: Not supported

*1 Auto tuning cannot be used.

*2 Start/stop and monitoring functions of the customizable logic cannot be used.



1.1.3. Product Warranty

Limitation IDEC CORPORATION accepts no responsibility for any losses (this includes,
of liability but is not restricted to lost profits, suspension of business, loss of business
information, or other financial loss) arising from the use, or inability to use this
software or its documentation.

1.1.4. Menu Command and Operation Button Notation

Menu commands and operation buttons for each screen are expressed as follows in this user's
manual.
For example, [Open...] is abbreviated as [Open] ("..." is omitted ).

However, square brackets [ ] are omitted, and bold font is used in chapter and section titles, as
well as in captions.

1-4



Chapter 1 Before Use

1.2. Connecting Inverters to the PC

1.2.1. Connection Methods

This section describes basic connection methods. Connection methods are different depending
on the type of inverters to be connected. Check the relevant instruction manuals for the inverters
and use the correct connection method.

Numbe'r of PC side Invgrter Connection Methods Refergnce
connections side section
RS-485 Connection via the USB/RS-485
uUsB
1:n (Note 3) converter (Note 1)
(n=1.2,..., 1.2.2.1
32) COM port RS-485 Connection via the RS-232C/
(RS-232C) (Note 3) RS-485 converter (Note 1)
Connection using the USB cable.
Remote
keypad If the keypad cannot be attached
1:1 usB with USB to the inverter, connect the 1.2.3.1.[1]
keypad to the inverter using the
(Note 2) LAN cable.

Note 1: When using the RJ-45 connector, use a branch adapter for multi-drop connection from the second
inverter onward.

Note 2: This connection is possible only for inverters that support the remote keypad with USB. For

information on the keypad support details, refer to "1.1.2. Table 1-1 Correspondence between

VF1A Series Inverter Models and Loader Functions" or catalogs of relevant inverters.

Note 3: Inverter models with different RS-485 communication protocols cannot be placed in the same
network for communication. For the RS-485 communication protocol by model, refer to "1.1.2.
Table 1-1 Correspondence between VF1A Series Inverter Models and Loader Functions" or

catalogs of relevant inverters.

Note 1)

H

"1.2.2.2. Devices Required for RS-485 Connection".

For information on the RS-232C/RS-485 converter and USB/RS-485 converter, refer to

2) When connecting inverters with the LAN cable using the RJ-45 connector, refer to "1.2.2.2.
[2] Cables" and "1.2.2.2. [4] Branch Adapter for Multi-drop Connection".

3) Ifthe RS-485(RJ-45 connector) is commonly used with the keypad connection connector
for the inverter, the keypad must be removed from the inverter.

4) To minimize the effects of noise, avoid wiring in the same bundled cable as for the power
supply and, instead, wire in a separate line. (Refer to "1.2.2.3. Noise Countermeasures for
RS-485 Communication".)




@ 5) ltis not possible to use the Loader with a PLC or other host devices at the same time.
Before using the Loader, disconnect the connection cables to other host devices.

6) For configuring the multi-drop connection, assign different station addresses to inverters to
be connected.

AWARNING

e Be sure to turn off the power to the inverters and related devices before wiring or making RS-485.

Failure to observe this could result in electric shock.

AWARNING

¢ Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the inverter using the
LAN cable.
The RJ-45 connector of the inverter is not for LAN communication.
The voltage level and pin arrangement are different from those of the LAN terminal of the PC.
A trouble such as a power short-circuit or signal line collision may occur and may damage the
product.

Failure to observe this could result in a product failure.

ACAUTION

e When connecting cables to the RJ-45 connectors on the inverter (RJ-45 connector for connecting to
the keypad, RJ-45 connector for connecting to the RS-485 communication card, and RJ-45 connector
for the inverter's RS-485 communication), be sure to check the wiring of the devices to be connected.
For details, refer to the "RS-485 Communication User's Manual”.

Failure to observe this could result in a product failure.
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1.2.2. RS-485 Communication Port Connection

1.2.2.1. Basic Connection Drawings

[1] Multi-drop Connection Using the RJ-45 Connectors

The following diagram shows an example of multi-drop connection using RJ-45 connectors.

PC Branch adapter for ~ Doesa VF1A series

multi-drop connection Inverter RS-485
Communication

VFD .
Doesa- Converter %}E / device
Loader /‘ | RJ-45 connector
Terminating resistor o
(100 — 120 ohm) ON Terminating
Cable 2 resistor SW
OFF

Cable 1 Cable 2 \
%}E ¢« RJ-45 connector

Terminating
resistor SW
OFF

e RJ-45 connector

Terminating
resistor SW
ON

Figure 1-1 RS-485 Connection Diagram (RJ-45 connector Connection)

The following devices are used for the connection. For information on recommended devices,
refer to "1.2.2.2. Devices Required for RS-485 Connection".

Devices used Description
Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485
converter or USB/RS-485 converter is required.

To connect to the RJ-45 connector of the inverter, a converter equipped with the
RJ-45 connector is required on the RS-485 port side.

Cable 1 Follow the specifications of the converter.

Cable 2 Use commercially available LAN cable (straight).

Branch adapter for | The branch adapter is convenient to use when using the cable with RJ-45
multi-drop connector for the multi-drop connection. The branch adapter is not necessary for
connection the inverter equipped with the RJ-45 connector for functional extension.

AWARNING

e The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45 connector
for the RS-485 communication (communication port 1). When connecting to other devices,
be careful not to connect to pins assigned to the power supply. Connect only pin 4 and pin
5.

e Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the
inverter using the LAN cable.

Failure to observe this could result in a product failure.




For information on RS-485 communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

For information on the inverter's terminating resistor switch, refer to the instruction manuals or
the RS-485 Communication User's Manual.

@ e For the selection of connection devices to prevent damage or malfunction in the
control PCB caused by an external noise and to eliminate the influence of the
common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485
Connection".

e The maximum wiring length must be 500 m in total.
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[2] Multi-drop Connection Using Terminal Blocks
The following diagram shows an example of multi-drop connection using terminal blocks.

PC Doesa VF1A series
‘ Inverter
VFD Converter | PX(*)
Doesa- DX(-)
Loader \ DX(+) Terminating
Terminating resistor DX() E)e;lstor Sw
(100 — 120 ohm) ON
Cable 1 Shield DX(+) Terminating
DX resistor SW
() OFF
Cable2 —»
DX(+) Terminating
resistor SW
DX(-) ON

Figure 1-2 RS-485 Connection Diagram (Terminal Block Connection)

The following devices are used for the connection. For information on recommended devices,
refer to "1.2.2.2. Devices Required for RS-485 Connection".

Devices used Description
Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485
converter or USB/RS-485 converter is required.

To connect to the terminal block of the inverter, a converter equipped with the
terminal block is required on the RS-485 port side.

Cable 1 Follow the specifications of the converter.

Cable 2 Use a shielded twisted-pair cable for long distance transmission.

For information on RS-485 communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

@ e For the selection of connection devices to prevent damage or malfunction in the
control PCB caused by an external noise and to eliminate the influence of the
common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485
Connection".

e The maximum wiring length must be 500 m in total.



1.2.2.2. Devices Required for RS-485 Connection

This section describes about the devices required when connecting to a PC with non RS-485
interface.

[1] Converter

PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485 converter or
USB/RS-485 converter is required. Always use a converter that meets the recommended
specifications shown below in order to ensure correct use. Note that the software may not
function properly if a converter other than those recommended is used.

Recommended converter specifications

Transmission/receipt Automatic switching through monitoring transmission data at the PC

switching method: side (RS-232C)

Isolation: Must be dielectrically isolated from the RS-485 side.
Fail-safe: Must be equipped with a fail-safe function (*).

Other requirement: Must have excellent noise resistance properties.

* The fail-safe function is a function capable of ensuring that the RS-485 receiver output is
logic high even when the RS-485 receiver input is open or shorted or when all the RS-485
drivers are inactive.

Recommended converters

Manufacturer:  System Sacom Industry Corp.
Model: KS-485PTI (RS-232C/RS-485 converter)
USB-4851 RJ-45-T4P (USB/RS-485 converter)

Transmission/receipt switching method

RS-485 communication involves half-duplex operation (two-wire system), and therefore
converters require a function for switching between transmission and receipt. There are the
following two switching methods.

(1) Automatic switching through monitoring transmission data
(2) Switching with RS-232C flow control signals (RTS or DTR) from the PC

The VFD Doesa-Loader does not support the above switching method (2). Therefore, use the
converter with the above switching method (1).
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[2] Cables (for RJ-45 connector connection)
The connection cable specifications are set as follows to ensure reliable connection.

Specifications

Common specifications 10BASE-T/100BASE-TX straight cables (commercially
available LAN cable) that satisfies the US ANSI/TIA/EIA-568A
Category 5 standard.

When connecting to the keypad, use an 8-conductor straight cable. Use commercially available
LAN cable (20 m or less).

Recommended LAN cable

Manufacturer: ~ Sanwa Supply Inc.
Model: KB-10T5-01K (1 m)
KB-STP-01K (1 m shield cable: possible to conform to the EMC Directive)

@ e The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45
connector for the RS-485 communication (communication port 1). When connecting
to other devices, be careful not to connect to pins assigned to the power supply.
Connect only pin 4 and pin 5.

[3] Cables (using terminal blocks)
Use a shielded twisted-pair cable for long distance transmission with the wire gauge of AWG 16
to AWG 26 to ensure reliable connection.

Recommended cable

Manufacturer: Furukawa Electric Co., Ltd.
Model: AWM 2789 Long-distance connection cable

[4] Branch Adapter for Multi-drop Connection
The RJ-45 connectors are used as communication connectors. When configuring a multi-drop
connection using the standard LAN cable, a branch adapter for the RJ-45 connector is required.

Manufacturer: SK KOHKI CO., LTD.
Model: MS8-BA-JJJ



1.2.2.3. Noise Countermeasures for RS-485 Communication

Depending on the operating environment, the system may malfunction due to noise generated
by the inverter. To prevent such malfunction, countermeasures can be taken by separating
wiring lines, using shielded cables, isolating the power supply, or adding an inductance. As an
example, addition of an inductance is shown below.

Addition of an inductance

Form an inductance component in the circuit to generate a high-impedance state against the
high frequency noise by inserting a choke coil in series with the signal circuit or by passing the
wiring through the ferrite core.

Ferrite core
RS-485 communications cable

RS-485 TRD+
converter TRD-

T [ H
I : Inverter
H

FG

Pass the wiring through the ferrite core or
wind the ferrite core with the wiring a few times

Figure 1-3 Addition of an Inductance
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1.2.3. USB Communication Port Connection

1.2.3.1. Basic Connection Drawings

[1] Connection with the Inverter via the remote keypad with USB
The following section describes a connection of the PC with the inverter via the remote keypad
with USB. Connect the keypad to the keypad coupling connector on the inverter with a
communication cable. Be careful with the connector. If it is connected to any connector or port
other than the keypad coupling connector, no communication will be possible.

Inverters with removable keypad that support the remote keypad with USB

The keypad mounted on the inverter as standard must be removed.

Doesa VF1A series

Remote keypad with USB Inverter

USB A connector Cable 2

PC

Cable 1
RJ-45 connector
VFD on back side
Doesa- Loader
USB mini B connector Keypad coupling connector
(RJ-45)

Figure 1-4 USB Connection Diagram (Connection with the Inverter via Remote keypad with USB (1))

Devices used Description
Remote keypad For the inverter models that support the remote keypad with USB as an optional
with USB item, the keypad needs to be purchased separately.
Cable 1 Use a commercially available USB cable (mini B connector).
Cable 2 Use a commercially available LAN cable (straight).

For information on USB communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

On the Loader side, select [Data in Inverter (via VF1A-PH1)] for the USB connection under [Port]
on the [Communication setting] window.

@ e This connection is possible only for inverters that support the remote keypad with
USB. For information on the keypad support detail, refer to "1.1.2. Table 1-1
Correspondence between VF1A Series Inverter Models and Loader Functions" or
catalogs of relevant inverters.

e Be sure to connect the remote keypad with USB to the keypad coupling connector
on the inverter.
For example, the keypad coupling connector for the VF1A is available only on the
RS-485 communication port 1. Therefore, if the keypad is connected to the RS-485
communication port 2, no communication is possible.
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e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

¢ When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)

1.2.3.2. USB Specifications

[1] USB Specifications for the remote keypad with USB
Table 1-3 USB Specifications for the VF1A-PH1

Specifications Conforming to USB1.1
Transfer speed 12 Mbps
Wire length 5 m max.
Connector USB Mini-B connector

When connected to the inverter:  Self power
Power supply

When connected to the PC: Bus power
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1.3. Connection between the PC and the Keypad with USB

1.3.1. Memory Function of the keypad

The remote keypad with USB (VF1A-PH1) can be used as a temporary memory medium.
Retrieve the inverter operation condition data into the keypad, remove the keypad, and, at a
location such as an office other than the work site, connect the keypad to the PC with the Loader
installed. Using the Loader, the retrieved function code data can be edited, set, or monitored.
The settings edited using the Loader can be retrieved into the keypad and, at the work site, the
data can be written into the inverter from the keypad.

Even if the inverter does not support the USB communication via the keypad (see 1.2.3.1. Basic
Connection Drawings [1]), the keypad can be used as a temporary memory medium as long as
the inverter support the copy function of the remote keypad.

1.3.2. Connection between the PC and the keypad

The following section describes a connection between the PC and the remote keypad with USB
when using the keypad as a temporary memory medium.

Remote keypad with USB

USB A connector

pC Cable

VFD Doesa Loader

USB mini B connector

Figure 1-5 Connection Diagram between the PC and the keypad

Devices used Description
Remote keypad For the inverter models that support the remote keypad with USB as an optional
with USB item, the keypad needs to be purchased separately.
Cable Use a commercially available USB cable (mini B connector).

For information on USB communication settings, refer to "1.5.5. Communication Setting and
Connection Setting for the Loader".

There is no function for communication setting on the keypad side.

On the Loader side, select [Data in Keypad] for the USB connection under [Port] on the
[Communication setting] window.

@ e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

¢ When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)



1.3.3. Connection between the keypad and the Inverter

The following section describes a connection between the remote keypad with USB and the
inverter when using the keypad as a temporary memory medium.

Use the copy function of the keypad to retrieve the data from the inverter into the keypad and to
write the function code setting data into the inverter from the keypad. For information on the
copy function, refer to the instruction manuals.

Inverters with removable keypad that support the remote keypad with USB

The keypad mounted on the inverter as standard must be removed.

Doesa VF1A series Keypag
Remote keypad Inverter supported as

with USB Cable standard
/ Removal

RJ-45 connector
on back side

Keypad coupling connector
(RJ-45)

Figure 1-6 Connection Diagram between the keypad and the Inverter (1)
(Connection Using a Communication Cable)
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1.4. Installation and Uninstallation

1.4.1. Installation Methods

1.4.1.1. Flowchart of Installation Procedures

Perform installation according to the following procedure.

START

¢

[ Perform pre-installation check. (See section 1.4.1.2.)

Estal the Loader and a set of required

(See section 1.4.1.3.)

applications.
/ (*1) The following devices can be used for USB
\l/ communication with the VFD Doesa-Loader.
Use USB communication (*1) with the\ - Remote keypad with USB: VF1A-PH1
Loader?
[No]

[Yes]

Perform pre-installation check before
installing the USB driver. (*2)(*3)

J

Install the USB driver. (See section 1.4.1.4.)

(See section 1.4.1.4.)

(*2) For the installation of the USB driver, connect the PC
with the USB device. Therefore, the following devices

END are required.

- USB device
(Remote keypad with USB: VF1A-PH1)

- USB cable
(Used for connecting the PC with the USB device)

(*3) The VFD Doesa-Loader and the Message Manager
must be closed.



1.4.1.2. Perform Pre-installation Check.

Perform the following tasks prior to installation.

Task Description

Checking Windows version Make sure that the version is one of the following.
Windows 8.1 (32-bit/64-bit)
Windows 10 (32-bit/64-bit)

Exiting running applications Exit any applications that are currently running.

@ ¢ For installing the Loader, use an account authorized to install this software.



Chapter 1 Before Use

1.4.1.3. The Loader Installation Procedure

This application requires the following applications.

At the time of installation, these applications are installed as required. Follow the instructions on

the screen to install them.

1 Microsoft .NET Framework 4.5.2 Full
2 Microsoft Visual C++ 2015 Redistributable Package
3 Message Manager (MsgMgr USB Setup)

The following section describes the Loader installation procedure.

START

Execute the installer
VFD Doesa-Loader_[OOO setup.exe.

v

Select the language for installation. j

Install a set of required applications. \

/

@) ) o ) Automatically selected.
Select required applications. o .
Applications that are already installed are

\l/ not selected.

J

Install the Microsoft .NET Framework Automatically executed.
Not executed if it is not selected at the

above stage (a).

Install the Microsoft Visual C++ 2015 Itis automatically executed.

Redistributable Package.

Not executed if it is not selected at the

above stage (a).

4.5.2 Full Package.

v
.

2

Install the Message Manager.

Follow the instructions on the wizard.
Not executed if it is not selected at the

above stage (a). /

Follow the instructions on the wizard.

— | N \ J L

[ Install the VFD Doesa-Loader.

®

END




Install the Loader according to the instructions on the wizard.

The following shows installation procedures in English.

[Boowaoads =loix|
G(\) [ ~ Donrloads v §83 [[sesrch Donrionds [0
Orgonze v F Open  Sharewith > v [0l @

B Desktop
& Downicads
&, Recent Places 2un 85
L
T Share with »
- o Restore previous versons
b Pictres Send to »
B Videos ot
Copy
R
: “,w‘“ Create shortaut
& Local Dk (C) Delete
Rename
Network
*ﬁ Properties

Doesa Loader - InstallShield Wizard

= W Select the language for the installation from the choices below.

[1] Installation of Required Software

Right-click

[VFD Doesa-Loader OO setup.exe]
and select [Run as administrator] from
the right-click menu that appears.

The setup will automatically run the
installation wizard.

Select the language, either [Japanese] or
[English], to be used in the installation.

The selected language affects
registration items of the start menu.

Select [English] here.

Click [OK].

If all the required softwares have already been installed, the following screen does not appear.

Proceed to [[3] Installation of the ].

Doesa Loader - InstallShield Wizard

4 Doesa Loader requires the following items to be installed on your computer. Click Install
LY t5 begin installing these requirements.

Status Requirement

Pendng Mcrosoft NET Framework 4.5.2 Ful

Pendng Mcarosoft Vieual C++ 2015 Redstrbutable Package (x26)
Pendng MsgMgr USS Setwp

1-20

A list of required softwares is displayed.

Click [Install].
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@ User Account Control

/ﬁ\ Do you want to allow the following program from an unknown
* / publisher to make changes to this computer?

Programname: VFD Doesa-Loader_V1.1.0.32.0_setup.exe

Publisher: Unknown
File origin: Hard drive on this computer
v | show getais

hi

E% Microsoft NET Framework 4.5.2 |
Installation Progress N
Flease wait while the .NET Framework is being installed. waf

File security verification:

I

Verifying netfx_Ful_GDR.mzz

Installation progress:

|

Installing necessary components for .NET Framewark

Canice!

[2] Installation of the Message Manager
Doesa Loader - InstallShield Wizard

P Doesa Loader requires the following items to be installed on your computer. Click Install
L= o begin instaling these requirements.

Status  Requirement
Succeeded Maosoft NET Framework 4.5.2 Ful
Succeeded Mcrosoft Vieual C++ 2015 Redstrbutable Padage (x86)

Instaling C_MsgMor USB Sed

Instal Cancel

When the screen on the left is
displayed, click [Yes].

If "MsgMgr USB Setup” is displayed on the
screen shown to the left after clicking [VFD
Doesa-Loader_ [ setup.exe], the
Message Manager will be installed.

If "MsgMgr USB Setup" is not displayed, it
means that the Message Manager has
already been installed.

If the Message Manager has already been installed, the following screen does not appear.

Proceed to [[3] Installation of the ].
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Message Manager - InstallShield Wizard

Message Manager - InstallShield Wizard

Welcome to the InstallShield Wizard for Message Manager

The InstaliShield Wizard wil install Message Manager on your computer. T cantinue, dlick Next.

Please read the following license agreement carefully.

Software End User License Agreement

Important

Carefully read the following license agreement.

This agreement, regarding this software product (hereinafter called "this
software”) which you are in possession of, is a legal agreement that is

Alle celhiince Ahe ciicbocecs o commcdadic cacee e Ahe boccee falkia
(@1 accept the terms in the license agreement \
(O1 do not accept the terms in the license agreement

concluded between the customer (individual or corporation) and the IDEC
Corporation (hereinafter called "IDEC"). This software may include computer
software and related media, printed materials (manuals and other documents)

as well as "online” or electronic documents. By installing, copying or using v

InstaliShield -

<o [ o> )] |

1-22

Cancel

First, select the language to be used in
the installation of the Message
Manager.

Select [English] here.

Click [Next].

Click [Next].

Carefully read the Software End User
License Agreement.

To view the full text of the contract
agreement:

Press the [Page Down] key or [Page
Up] key.

You can also use the scroll bar to view
the whole page.

If you agree to the terms of the
agreement, click [Yes].
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Message Manager - InstallShield Wizard x|

Select a destination folder.

Setup wil install Message Manager in the following folder.

To install to this folder, dick Next. To install to a different folder, dick Browse and select another

To install in a different folder, click the
[Browse] button and select another
— destination folder.

When the above selection is finished,
click [Next].

estination Eoldk
C:\Program Files (x85)\Common Files\Fuji Electric SharedMe: n@ ‘

The default folder for the 32-bit OS is C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message
Manager.

Here,“C:” is a drive letter for the disk or partition where the Windows is installed. If the Windows is installed
in a different drive, substitute a drive letter for that drive.

With the 64-bit OS, "Program Files" in the above address string is replaced with "Program Files (x86)".

Message Manager - InstallShield Wizard x| Set Up a program fOlder.
Setup will add program icons to the Program Folder listed below. You may type a new folder The default folder name is Message

name, or select one from the existing folders list. Click Next to continue.

Manager".

When the setup is finished, click [Next].

Message Manager - InstallShield Wizard x|

A confirmation screen is displayed.

Setup has enough information to start copying the program files. If you want to review or
change any settings, dick Back. If you are satisfied with the settings, dick Next to begin
copying files.

Current Settings:

Distination Folder 2]
C:\Program Files (x86)\Commen Files\Fuji Electric Shared\Message Manager
Distination Program Folder
- Message Manager
g . : .
h If a change is required, click [Back] to

return to the previous screen.

If no change is required, click [Next].
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Message Manager - InstallShield Wizard

When the installation of the Message
Manager is finished, the screen shown
to the left is displayed.

InstallShield Wizard Complete

The InstaliShield Wizard has successfully installed Message Manager. Click Finish to exit the
wizard.

Click [Finish].

i ——— -

When installations of all the required softwares are completed, proceed to install the Loader.
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[3] Installation of the Loader

47 Doesa Loader - InstallShield Wizard X

Welcome to the InstallShield Wizard for Doesa
Loader

The InstallShield(R) Wizard will install Doesa Loader on your
computer, To continue, dick Next,

WARNING: This program is protected by copyright law and
international treaties.

Click [Next].

15! Doesa Loader - InstallShield Wizard X Carefully read the Software End User

License Agreement License Agreement.
Please read the following license agreement carefully.

To view the full text of the agreement:
Press the [Page Down] key or [Page

Software End User License Agreement

. Up] key.
Important

Carefully read the following license agreement. You can also use the scroll bar to view

This agreement, regarding this software product (hereinafter called "this the whole page.
software”) which you are in possession of, is a legal agreement that is
concluded between the customer (individual or corporation) and the IDEC
Corporation (hereinafter called "IDEC"). This software may include computer
software and related media, printed materials (manuals and other documents)
as well as "online” or electronic documents. By installing, copying or using
H -l a bbha siisbemsssia bha bl n bocmea ok dlla

U

v

_— demmaded b meaa s

Print

If you agree to the terms of the
agreement, select [ accept the terms in

Instalshield the license agreement] and then click
s [ || cand [Nexq.
43! Doesa Loader - InstallShield Wizard X
Customer Information

Please enter your information.

e Enter the user name and company
User [ 4

' name.

QOrganization:

|{User Company] |

When the input is finished, click [Next].

Instalishield

< Back | Next > | Cancel
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43! Doesa Loader - InstallShield Wizard X Select the destination folder.

Destination Folder The default folder is ¥IDEC
Click Next to install to this folder, or dlick Change to install to a different folder, VFD¥Doesa-Loader in the C or D drive.
el D D o (Note: The drive that has the largest
/" ci¥1EC FoNDoess Loader¥ hard disk space is selected.)

To install in a different folder, click the
[Change] button and select another
destination folder.

InstaliShield
< Back Cancel When the above selection is finished,
click [Next].
42l Doesa Loader - InstallShield Wizard X
Ready to Install the Program A confirmation screen for selected

The wizard is ready to begin installation. contents is dISpIayed .

If you want to review or change any of your installation settings, dick Back. Click Cancel to

exit the wizard.

Current Settings:

Setup Type: If a change is required, click [Back] to
Typical return to the previous screen.

Destination Folder:
C:¥IDEC VFD¥Doesa Loader¥

RO If no change is required, click [Install].

Name: User
Company: User Company

InstallShield

[J
< Back I Install I Cancel

@ User Account Control i x|

0 Do you want to allow the following program from an unknown
publisher to make changes to this computer?

Program name:  C:\Users\sz00858\AppData\Local\Downloaded
Installations\{AB99CDBE -EE96-4E04-82DC-9CBCF... | VFD Doesa

-Loader.msi
Publisher: Unknown When the screen on the left is
File origin: Hard drive on this compute: . .
oo VTS0t 1 B A TR displayed, click [Yes].
| show detais e [[ ™ ]
hange when ification: r
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4] Doesa Loader - InstallShield Wizard X

InstaliShield Wizard Completed When the installation of the Loader is
finished, the screen shown to the left is
displayed.

The InstallShield Wizard has successfully installed Doesa
Loader. Click Finish to exit the wizard.

To end the installation work and to
return to the Windows, click [Finish].
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1.4.1.4. USB Driver Installation Procedure

To establish communication by connecting to the USB device (VF1A-PH1 remote keypad with
USB), first you must install the USB driver. This installation work is required only once at the
start of using your system.

@ o If the USB driver is not properly installed, communication is not possible via the
USB connector on the VF1A-PH1.

[1] Before Installing the USB Driver
Preparing Devices

For the installation of the USB driver, connect the PC with the USB device.
Prepare the following devices.

USB devices: VF1A-PH1 remote keypad with USB

USB cable: Used for connecting the PC with the USB device.

Installation of the Loader

Install the Loader in advance.
The files required for the installation of the USB driver are saved in the Loader installation folder.
For information on the installation methods, refer to "1.4.1.3. The Loader Installation Procedure".

Close the Loader

If the Loader was started after installation, close the Loader.

Close the Message Manager.

Close the Message Manager. The Message Manager is automatically started when the Loader
is started. However, it does not close automatically.

The following section describes how to close the Message Manager.

Procedure for Closing the Message Manager

Show hidden icons

@ e . 1041
A () it el 2015/08/18

Left-click here, and hidden icons are displayed as shown below.

Right-click the Message Manager icon, and an option for exiting the Message Manager
appears.
Select the option, and the Message Manager is closed.
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MessageManager 3

l " Exit MessageManager 7

Exit MessageManager

CARPS &

kv » =~ A |"F W 70 s 15:57

The icon may be displayed here.

@ o If an attempt is made to install the USB driver with the Message Manager
already started, the Message Manager cannot recognize the USB driver and, as
a result, a communication failure may occur in the communication between the
Loader and connected devices. In such a case, close the Loader and the
Message Manager and then start the Loader again.

[2] Installation of the USB Driver.

Windows 10
Connect the PC with the USB device (VF1A-PH1) using the USB cable.

When the OS recognizes the USB device of this Loader, the following display appears.

The wizard used to install the USB driver does not start automatically. Therefore, install the USB
driver according to the following procedure.

Skype video Search

Select [START] -> [Control Panel] and
then left-click.

Cid

[& File Explore
ile Explorer Snipping Tool

@ Settings

als
1 -
™ Power -'-

£= Allapps New DDC Loader Get Started

A Search the web and Windows m . ﬁ

1-29



[E5] A1l Control Panel ltems -

4~ [Z » Control Panel > All Control Panel ltems v O Search Cont

When the Control Panel home screen
Adjust your computer’s settings View by:  Small icons » is diSp|ayed, select [DeVice Manager]
and then left-click.

i1 Administrative Tools (g AutoPlay @Eackup and Restore (Windo
D BitLofker Drive Encryption CCX Diagnostic Utility Kl Color Management
[B Credgntial Manager ) Date and Time [@ Default Programs

oy Device Manager Ffa Devices and Printers =0 Display
® Ease of Access Center File Explorer Options £ File Histary
Flash Player (32-bit) A Fonts L1 Y HomeGroup
& Indexing Options Intel & HD Graphics Internet Options
% Device Manager - O *
File Action View Help When the Device Manager screen is

displayed, select "Unknown device"

e | m B HE B EXG R . _
and then right-click to display options.

v % DESKTOP-84IDNCT
I Audio inputs and outputs
3 Batteries
€} Bluetooth
3 Computer
s Disk drives
& Display adapters
- DVD/CD-ROM drives
iy Human Interface Devices
=2 |DE ATA/ATAPI controllers
E=2 Keyboards
@ Mice and other pointing devices
[ Monitors
[ Metwork adapters
v B Other devices

|
B33 Print queues Update Driver Software... Select "Update Driver Software" and

[ Processors Disable then left-click.
B Software devices Uninstall

i Sound, video and ga

S Storage controllers Scan for hardware changes

i3 System devices
5 P rti
@ Universal Serial Bus ¢ roperties

Launck .

B Update Driver Software - Unknown Device

How do you want to search for driver software?

—» Search automatically for updated driver software
‘Windows will search your computer and the Internet for the latest driver software

for your device, unless you've disabled this feature in your device installation When the screen on the left is
settings. .

’ displayed, select "Browse my computer
for driver software".

— Browse my computer for driver software
Locate and install driver software manually.

Cancel
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IC:\Users\Default\Documents]

& 0 Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

<] [ Browse..

[HAInclude subfolders

—> Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Cancel

Browse For Folder

Select the folder that contains drivers for your hardware.

v IDE

CVFD

v Doesa Lod

> CstmlLog

DATA
Driver
VF1A

en

ader

jic

Folder: [ VF1A

& B Update Driver Software - Unknown Device

Search for driver software in this location:

Browse for driver software on your computer

[ Include subfolders

IC:¥IDEC VFD¥Doesa Loader¥Driver¥VF1A]

Browse...

=> Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

When the screen on the left is
displayed, click [Browse].

Select "...¥Driver¥VF1A" inside the
Loader destination folder and then click
[OK].

The default folder is C:¥ IDEC
VFD¥Doesa-Loader¥Driver¥VF1A
when the installation drive is C.

(Note: The drive that has the largest
hard disk space is selected.)

| Next Cancel
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X
B Update DriverSoftware - Unknown Device The installation will begin.
Installing driver software...
|
X
B UpdateDriver Software - river for FRENIC U8 nterface When the installation of the Loader is
Windows has successfully updated your driver software finished, the screen shown to the left is
displayed.

Windows has finished installing the driver software for this device:

- Driver for FRENIC USE interface

| To end the installation work and to
return to the Windows, click [Close].
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Windows 8.1

Connect the PC with the USB device (VF1A-PH1) using the USB cable.

When the OS recognizes the USB device of this Loader, the following display appears.

The wizard used to install the USB driver does not start automatically. Therefore, install the USB
driver according to the following procedure.

Select the [Computer] icon and then
right-click to display options.

Unpin from Select "Properties” and then left-click.

Manage

Properties
Map network drive
Disconnect network drive

Resize

i System

4 (8 » Control Panel + System and Security » System v

When the Control Panel home screen
is displayed, select "Device Manager"
and then left-click.

Control Panel Home

View basic information about your computer

H Windows edition
) Remote settings Windows 81 Pro --

) System protection © 2013 Microseft Corporation, All rights . \
@ Advanced system settings reserved. .

Get more features with a new edition of
Windows
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Device Manager - o [IEN

View Help

=

File  Action

= | T E HE 8 F %S

4 = WIN-EB45RNSPYVEE A
> & Audio inputs and outputs
I & Batteries
I Bluetooth
i M Computer

[ Disk drives

Display adapters
DVD/CD-ROM drives
Floppy disk drives

Floppy drive controllers
Human Interface Devices
IDE ATA/ATAPI controllers

When the Device Manager screen is
displayed, select "Unknown device"
and then right-click to display options.

Keyboards

Memory devices

Mice and other pointing devices
Maonitors

Metwork adapters

4 |5 Other devices

Unknown device *—

] RLE e,

Select "Update Driver Software" and
then left-click.

b f? Ports (COM & LPT) update Driver Software...

1P

[ @3 Print queues Disable
& ¥ Processors Uninstall

Launches the Upde

W

Scan for hardware changes

Properties

I Update Driver Software - Unknown Device

How do you want to search for driver software?

< Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

When the screen on the left is

Browse my computer for driver software
Locate and install driver software manually.

Cancel

displayed, select and click "Browse my
computer for driver software".

@ [l Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

[C:\Users\Public\Documents| v

[w] Include subfolders

Browse:,

= Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Cancel

—— When the screen on the left is
displayed, click [Browse].
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Browse For Folder X

Select the folder that contains drivers for your hardware.

v IDECVFD "
v Doesa Lopder

CstmLog

DATA

C

v Driver

> VF1A

en v

Folder: | VF1A

& 0 Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

VFD¥Doesa Loader¥DriversVF1A T

[ Include subfolders

—> Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

[ ] [ conce
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Select ".. . ¥Driver¥VF1A" inside the
Loader destination folder and then click
[OK].

The default folder is C:¥ IDEC
VFD¥Doesa-Loader¥Driver¥VF1A
when the installation drive is C.
(Note: The drive that has the largest
hard disk space is selected.)

When the screen on the left is
displayed, click [Next].



Installing driver software...

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

FRENIC
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The installation will begin.

When the installation of the Loader is
finished, the screen shown to the left is
displayed.

To end the installation work and to
return to the Windows, click [Close].
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1.4.1.5. Checking the USB Driver

Check whether the USB driver for VF1A-PH1 remote keypad with USB is properly installed or
not using the Device Manager of Windows.

Windows 10

Select as follows to open the Device Manager: [Start] -> [Control Panel] -> [Device Manager]

Windows 8.1

Right-click the icon on the [Computer], select [Properties] and then select [Device
Manager].

Confirm that [Driver for FRENIC USB interface] is displayed under [Loader USB device] on the
Device Manager.

o: Installation succeeded. x: Installation failed.
= Device Manager =@ =1 Device Manager =@
File Action View Help File Action View Help
ol ARealNEIN 7 Nool AN X7 ol ARl NEHN 7 Boe AR . 3.
4 2 USERNAME-PC 4 24 USERNAME-PC
@ Batteries @ Batteries
> -8 Computer » -yM Computer
a Disk drives > Disk drives
> B Display adapters B Display adapters
-y DVD/CD-ROM drives i3 DVD/CD-ROM drives
> g Floppy disk drives =4 Floppy disk drives
> -\:E Floppy drive controllers b &= Floppy drive controllers
> g IDE ATA/ATAPI controllers > g IDE ATA/ATAPI controllers

» & Keyhoa

-§ Loader USB device
‘. i Driver for FRENIC
. ,.B Mice and other pointing devices
¥ Network adapters

» &2 Keyboards

)| Mice and other pointing devices
s . | cada
2[5 Other devices
‘g_, Unknown

B interface

device

5 Other devices XF Po PT)
.Y Ports (COM & LPT) -2} Processors
; 2 Processors > &5 Storage controllers
&7 Storage controllers . -{Ml System devices
-yM System devices . Universal Serial Bus controllers

.. @ Universal Serial Bus controllers - — — —
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1.4.1.6.

Installation of the Message Manager

Normally, when the VFD Doesa-Loader is installed, the Message Manager is installed at the
same time. Therefore, there is no need to separately install the Message Manager.

However, after the VFD Doesa-Loader is installed. The Message Manager may need to be
uninstalled as a step to recover a communication failure. In such a case, the Message Manager

can be separately installed.

32.0_setu...

E MsgMgr USB Setup Date mod

fied: 2/27/2017 5:44 AM
Size: 512 MB

[ e ==
@Qv‘ & » Downloads vlo,” §e)
Organize v =) Open Shargwith v Burn  » - T ®
dotNET VFD
Setup Doesa-Loa
der_V1.1.0.

Tip

To install only the Message
Manager, double-click [MsgMgr
USB Setup.exe].

The installation wizard will be
started automatically.

Install the Message Manager
according to the instructions on the
wizard.

¢ After you uninstall the Message Manager, the VFD Doesa-Loader installer can
also be used to install the Message Manager.

When using the VFD Doesa-Loader installer, after you install the Message
Manager according to the procedure in "1.4.1.3. The Loader Installation
Procedure" click [Cancel] on the step "[3] Installation of the ".

o If the VFD Doesa-Loader installer does not recognize the Message Manager as
one of the installation targets even if the Message Manager has been uninstalled,
use [MsgMgr USB Setup.exe] to install the Message Manager.
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1.4.2. Uninstallation Methods

@ o All files inside the Loader destination folder will be deleted.
If necessary, move or back up the user files created by the Loader before uninstalling.

1.4.2.1. The Loader Uninstallation Procedure

Windows 10
On the Windows, select icon ] = [BE START] = [IDEC VFD] - [Doesa-Loader
Uninstall].

Windows 8.1
Left-click [All apps] icon and then select [IDEC VFD] - [Doesa-Loader Uninstall].

'@ Default Programs
W Desktop Gadget Gallery
& Internet Explorer (64-hbit)
‘& Internet Explorer
‘; Windows Anytime Upgrade
& Windows DVD Maker
G2 Windows Fax and 5can
€ Windows Media Center
@ Windows Media Player
£ Windows Update
-8 XPS Viewer
. Accessories

. IDEC VFD
. Doesa Loader
& DoesaLoader Start
.25 Doesa Loader Uninstall

, Games

. Maintenance
. Message Manager
| Startup

1

Back

| |Search programs and files je |

@ .- O

Windows Installer 3

The uninstallation confirmation screen
will be displayed as shown here.

Are you sure you want to uninstall this product ?

Upon confirmation, click [Yes].

[ fes ] [ No
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ﬂﬂeﬂemﬁﬁmmmm

| Cancel

Program name:
Publisher:
File origin:

() Show details

CA\Windows\Installer\9607fd.msi

Unknown
Hard drive on this computer

ves [ Mo

)

Change when these notifications appear

displayed.

Click [Cancel] to stop uninstallation.

When the screen on the left is
displayed, click [Yes].

Time remaining: 31 seconds

ﬂm“mmmmm

- -

| [ Cancel

Uninstallation is executed according to the above procedure.
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1.4.2.2. Uninstallation of the Message Manager
Uninstall the Message Manager according to the following procedure.

START

®

Close all the Loaders.

\2

@) Close the Message Manager.

Tasks required prior to uninstallation

Is [Message Manager] listed in the
start menu?

[No] s @

[Yes] END

Click [Uninstall Message Manager].

4 )

Execute uninstallation according to the
instructions on the wizard.

v

Restart the Windows.

®
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®

Tasks required after uninstallation

Did you close the Message Manager in
the above step (a)?

[Yes]

[No]

Does the installation folder for the
Message Manager exist?

[No]

[Yes]

Delete the installation folder for the
Message Manager.

®

END
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[1] Before uninstalling the Message Manager

Close the Loaders.

Make sure that the loaders are not running before uninstalling (deleting) the Message Manager.
If any one of the loaders is running, close the loader before starting uninstallation.

Close the Message Manager.

Be sure to close the Message Manager before uninstalling (deleting) the Message Manager.
The Message Manager is automatically started when the Loader is started. However, it does not
close automatically.

The following section describes how to close the Message Manager.

Procedure for Closing the Message Manager

Show hidden icons

@ T T
AEE I o 2015/08/18

Left-click here, and hidden icons are displayed as shown below.

Right-click the Message Manager icon and select [Exit MessageManager] on the context
menu, and a dialog box appears. Click [Yes], and the Message Manager is closed.

MessageManager 3

I Exit MessageManager

; l\ Exit MessageManager 7

1038PM | | Py No
10/1/2017 | |

B

CARS & ) ~ -
ki » =~ A |"F W 70 de  15:57

The icon may be displayed here.

Tip o If the Message Manager cannot be closed using the above procedure, shut down
Windows or log out.

@ o If an attempt is made to uninstall without closing the Message Manager, some of
the files will not be deleted. Under such situation, if an attempt is made to install
the Message Manager again, the installation will turn out to be incomplete and a
communication failure may occur in the communication between the Loader and
connected devices. Be sure to start uninstallation after the Message Manager is
closed.
If uninstallation is performed while the Message Manager is running, execute "[3]
After Uninstalling the Message Manager" after uninstallation.
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[2] Uninstallation of the Message Manager
This section describes how to uninstall the Message Manager from the start menu by selecting
[Message Manager] -> [Uninstall Message Manager].

Windows 10
On the Windows, select [Start] -> [All apps] -> [Message Manager] -> [Uninstall Message
Manager].

Windows 8.1
Left-click [All apps] icon and then select [Message Manager] -> [Uninstall Message
Manager].

Message Manager

MessageManager Unin

Microsoft Edge

Microsoft Solitaire Collection

Microsoft Wi-Fi

'MessageManager-lnstallShieId Wizard 232 When [Unlnsta” Message
Manager] is selected, the
uninstallation confirmation screen
e T will be displayed as shown here.

Do you want to completely remove the selected application and all of its features?

Upon confirmation, click [Yes].
Uninstallation is executed according to the above procedure.

Message Manager - InstallShield Wizard

Uninstall Complete

InstallShield Wizard has finished uninstalling Message

Manager. To complete the uninstallation, you must restart your |f the System iS Considered to be in

computer.

a good state for restarting after
uninstallation, click [Finish].

) No, | will restart my computer later.

Remove any disks from their drives, and then click Finish to
complete setup.

Restarting is particularly important
if uninstallation is performed
without closing the Message

et @ el Manager. Be sure to restart the
system.
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[3] After Uninstalling the Message Manager
The following actions are required if uninstallation is performed without closing the Message
Manager.

Restarting the PC

Be sure to restart the PC at the end of "[2] Uninstallation of the Message Manager" on the
previous page.

Checking the Installation Folder for the Message Manager

When the PC is started, using the Windows Explorer, access the installation folder for the
Message Manager and confirm that the installation folder is deleted.

Tip ¢ The installation folder for the Message Manager is a folder specified under
"1.4.1.3 [2] Installation of the Message Manager" if the Message Manager has
been installed using the VFD Doesa-Loader.

The default folder is as follows.
- 32-bit OS
C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message Manager
- 64-bit OS
C:¥Program Files (x86)¥Common Files¥Fuji Electric Shared¥Message
Manager

Here,"C:" is a drive letter for the disk or partition where the Windows is installed. If
the Windows is installed in a different drive, substitute a drive letter for that drive.

Deleting the Installation Folder for the Message Manager

If the installation folder for the Message Manager exists, delete the installation folder.

Fuji Electric Shared
Message Manager
Message Manager
Open
Open in new window
Share with 3
Restore previous versions

Include in library »
Send to 4

Cut
Copy

Create shortcut
% Delete
¥ Rename

Properties
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[4] Supplement: Presence of Files during Uninstallation
The following table shows the presence of files contained in the Message Manager installation
folder during uninstallation.

Uninstallation

Presence of files inside the installation folder

When the Message
Manager is stopped

When the Message Manager is executed

Before Starting | GommD0 Lini (%) Flnet_sdll M Meghing exe || Readme txt All the f”eS
uninstallation [ COMMOBIINI | |Flretsini | |MSGMNGINI  |%|SvUsball required are

%) comyv24dll %) InvUsbdll [%| MegMnel01dll %] sxbus s dll present_

] dfnetdll @] isapledll @] MseMng08 1Al [&)] Usball

% duplex dll %) LeMetdll %] pelink dll

(% ether dIl || loader_if ini (%] pelink_pcidll

(%) Flnet_bdll %] loaderIF dII 1% plink dll

| Flnet bini (%] memdll (% plink_peidil
When The installation folder Some files are

. . . . 2| loaderIF dil
uninstallation is | does not exist. — present.
completed M Meebing exe
%] Mzehng0314I11
v \

After restarting the | The installation folder | The installation folder | MjMseMngexe

PC

does not exist.

does not exist.

Some files may
be present.

When the
installation folder is
manually deleted

The installation folder

does not exist.

¢ Do not install the Message Manager when some files are present in the folder.

Otherwise, the installation will turn out to be incomplete and a communication
failure may occur in the communication between the Loader and connected
devices.
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1.5. Settings Required Before Using the Loader

1.5.1. Setting Function Codes Related to Communication on the
Inverter Side

The following section describes the function codes on the inverter side that are related to the
communication with the Loader. Be sure to perform this setting before connecting the Loader
with the inverter.

Table 1-4 Inverter Function Codes Related to Communication with the Loader

Function

code Name Setting range
y01, y11 Station address 1 to 255
0: 2400 bps 1: 4800 bps
2: 9600 bps 3: 19200 bps

y04, y14 Baud rate 4: 38400 bps

0: Modbus RTU protocol
y10, y20 Protocol selection 1: Doesa protocol (Loader protocol)
etc.

The setting range and setting contents might differ depending on the model of the using inverter.

Function codes that require settings depend on where the Loader is connected to. The function
code setting ranges and guidelines by connection point are shown below.

Table 1-5 Function Code Setting Ranges by Loader Connection Point

Loader connection point
RS-485 communication RS-485 communication
: : USB connector on the
port 1 on the inverter port 2 on the inverter
: . VF1A-PH1
(via a converter) (via a converter)
yo1l 1to 255 - 1to 255
o y04 Oto7 - -
©
8 y10 Oto2 - -
S| yu ; 1to 255 ;
(8]
S y14 - Oto7 -
L
Other than 1
y20 Oto2 -
(In case of y10=1)
- Not used.
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Setting Guidelines
Table 1-6 Setting Guidelines when the RS-485 Ch.1 and RS-485 Ch.2 are Connected

. , . Reference section for
Function code Setting Guidelines ]
Loader setting

Match with the [RS-485 station address] of the Loader.
y01, y11 For multi-drop connection, avoid giving a duplicate
address for other inverters.

1.5.5.2.

Connection Setting

1551

yo04, y14 Match with the [Baud rate] of the Loader. o _
Communication Settings

€ For models that support “Loader (Doesa)” protocol
RS-485 Communication Port 1

y10, y20 Set "1" to y10 and a number other than 1 to y20. 1551
' RS-485 Communication Port 2 Communication Settings
Set "1" to y20.

@ e For Doesa protocol (Loader protocol), the Loader cannot be used simultaneously by
multiple communication ports of the inverter. If the Doesa protocol (Loader protocol)
is used simultaneously by multiple communication ports, the Loader communicates
with the communication port that has the highest priority.

The order of priority of the communication ports is as follows: the lowest priority is
given to the RS-485 communication port 1 and the higher priority is given to the
RS-485 communication port 2, and the next higher priority to the USB (via the
remote keypad with USB).

For example, if 1 is set to both y10 and y20, the Loader cannot communicate with
the RS-485 communication port 1. So, be careful with the setting.

Table 1-7 Setting Guidelines when the USB Connector on the VF1A-PH1 is Connected

Reference section for

Function code Setting Guidelines .
Loader setting
) ) 1.55.2.
y01 Match with the [RS-485 station address] of the Loader. _ _
Connection Setting
y1 Not used. -

y04, y14 Not used. .

y10, y20 Not used. 3
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1.5.2. Checking Communication Ports on the PC (when Using a
Converter)

The communication port (COM) is used for the interface between the Loader on the PC and the
inverter.

Because of this, the converter to be used requires a function that operates as a virtual
communication port (COM) and it is necessary to check the communication port (COM) number of
the connected PC.

(For details about the converter to be connected, refer to "1.2.2.2. Devices Required for RS-485
Connection".)

The following section describes the procedure to check the communication port number for each
operating system.

Windows 10

Right-click the icon FH and select [Device Manager] to open it.

Windows 8.1
Right-click the icon E on the [Computer], select [Properties] and then select [Device
Manager].
= Device Manager E\@

Eile Action View Help
ol AN RENN 7 W AN

4= USERNAME-PC

[ @ Batteries

.18 Computer

Click the * mark for Ports (COM &

g Disk drives LPT) and check the number indicated

- B Display adajpters

1__HJ DVD/CD-ROM drives in the square box in "USB Serial Port
-4 Human Interface Devices (comn)™.

g IDE ATASATAPI controllers

. @ Keyboards

- .| Mice and ofher pointing devices In the example shown to the left, the
. M Monitors number is assigned as"COM13".
l;_:" Network adapters

- E1] PCMCIA adapters

» KB Portable Davices
A--‘? Ports (COM & LPT)

" USB Serial Port (COM13)
D Process

b & Sound, video and game controllers
.---{,‘— Storage controllers

-7 System devices

- § Universal Serial Bus controllers
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1.5.3. Starting the Loader
Windows 10
On the Windows, select the icon [ > [BE START] = [IDEC VFD] > [Doesa-Loader Start].
Windows 8.1

Left-click [All apps] icon and then select [IDEC VFD] - [Doesa-Loader Start].

@ Default Programs

. Desktop Gadget Gallery

& Internet Explorer (54-bit)
€ Internet Explorer
‘E;. Windows Anytime Upgrade
&) windows DVD Maker
i Windows Fax and Scan
€ Windows Media Center
@ Windows Media Player

::-_I Windows Update

< XPS Viewer

. Accessories

. IDEC VFD

. Doesa Loader
DoesaLoader Start >

"y Doesa Loader Uninstall

. Games

. Maintenance
| Message Manager
L Startup

4 Back

&£ I.

files 0 |

| |Search programs and
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Setting the Operating Environment

When the Loader is started for the first time after installation, the language selection screen and
region selection screen are displayed.

These screen are displayed only once at the start of using your system.

On the [Select language] window, select a language

Select language to be used for subsequent displays.

Pleaze zelect vour language.

| English -|

@ e The language can be changed from the main menu by selecting [Setup] ->
[Language].
For details, refer to "2.4.3. Language”.

Next, select the "regional spec." for the inverter to be

Select Region spec. used

Pleaze zelect vour region spec.

| JJAPAN -

@ ¢ The "regional spec." of the inverter can be found in the nameplate on the inverter. For
details, refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" or the
instruction manuals of relevant inverters.

@ e The "regional spec." can be changed from the main menu by selecting [Setup] ->
[Regional spec.]. For details, refer to"2.4.4. Region Spec.".
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1.5.4. Overview of the Message Manager

The Message Manager is software that is used to control the Loader communication.
Unless the Message Manager is started, the Loader cannot communicate with devices
connected.

1.5.4.1. Checking the Startup of the Message Manager

When the Loader is started, the Message Manager is automatically started.

Confirm that the Message Manager icon M, is displayed on the task bar.
The display examples of the Message Manager icon are as shown below.

Display Examples of the Message Manager Icon

Show hidden icons

S P T
AE iy M s 2015/08/18

Left-click here, and hidden icons are displayed as shown below.

o(®)

Customize...

E [ BN 'iJ;l

The icon may be displayed here.

Tip e If the Message Manager icon M, is not displayed even after the Loader is started,
reinstall the Message Manager.
For information on the installation procedure, refer to "1.4.1.6. Installation of the
Message Manager".
e You can also check the status of the message manager on the communication
setting screen. Refer to “1.5.5.1 Communication Settings”.
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1.5.4.2. Procedure for Closing the Message Manager

The Message Manager does not automatically close even when the Loader is closed.
Normally, there is no need to close the Message Manager. However, the Message Manager
must be closed when it needs to be uninstalled, when the USB driver needs to be installed, or
when the Message Manager needs to be restarted as a step to recover a communication
failure.

For information on procedures for closing the Message Manager, refer to "1.4.1.4. [1] Before
Installing the USB Driver]" or "1.4.2.2. [1] Before uninstalling the Message Manager".

@ o If an attempt is made to close the Message Manager while the Loader is running, a

communication failure will occur in the Loader. When closing the Message
Manager, be sure to close the Loader first.
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1.5.5. Communication Setting and Connection Setting for the
Loader

When the Loader is started, the following screen (Quick Access menu) is displayed.

By clicking an icon on the screen, you can start the corresponding function. The details of these
functions are described in the later section.

This section starts with an explanation on the communication setting function.

File Menu Setup View Window Help
DEH &R X B2 M |/=0@808kMKS BOEX (&R |E DHEEES =

Doesa Loader is a utility tool that allows you to set up, run, control, and monitor the
Doesa series of inverters via a PC. Click the icon corresponding to the functicn you

want to perform,
[Function Code] [Trace back]
To set up, edit, compare, To graphically view the status

transfer, or initialize function
codes.

of the inverter in the event of
an alarm.

[Operation Monitor] [Real-time Trace]

To open 1O monitor, system To graphically view the running
monitor, alarm monitor, and status of the inverter in
operation status monitor. real-time.

X

[Customizable Logic] [Historical Trace]

To open, edit or create a new To graphically view the

Ry

LB % O i

project of Customizable Logic. historical tracing data.
[Schedule Operation] [Test Run]
To read, write or set-up the 42] To control/run the inverter
Schedule Operation. through loader.
[Communication Settings] [Exit]
To configure communications x To save changed files and exit
environment between the the utilty.
inverter and the PC.

[ Hidg this window at next start-up. Close

[ Mo T-Unknown

[ Communication settings ]

( Tip e If the Quick Access menu is not displayed, click the icon on the toolbar (the bar
with various icons below the main menu as shown below) to display the Quick Access
menu.

'aaa’@@lx%m@a =0 aBD &I

[ Quick Access Menu ]
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1.5.5.1. Communication Settings

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the
[Communication setting] window.

[Communication Settings]

To configure communications
environment between the inverter
and the PC.

o
&

The [Communication setting] window can also be displayed, without using the Quick Access
menu, by selecting [Setup] -> [Communication Settings] on the main menu or by clicking the ﬁ
icon on the toolbar.

File  Menu | Setup | View Window Help
== ﬁli(ommunication settings... [ Communication settings ]

DEH &R XE DS W= EE@@D&I&I&I&@

Referring to the following explanation, set the [Communication setting] window.

Communication Settings X
Port . L .
® RS-485 Click the [Communication Setting
Wizard] button to start a wizard to set

Protocal Lol e (D] e communication settings easily.
COM port COMS3 e Refar to “1.5.5.1 [1] Communication
Baud rate 19200 v Setting Wizard”.
Parity Even
Stop bit 1bit

O use
Tareet Data Data in Inverter (via VF1A=-PH1)

Keypad COM COM3

Communication Conditions Srriien i
Retry count 2 times -

Timeout 15 [s] -
. | oK |
Click the [Connection setting] button to

Device Manager Cancel display the [Connection setting]
MessageManager: ON window.

For information on the [Connection
setting] window, refer to "1.5.5.2.
Connection Setting".
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[1] Communication Setting Wizard

Communication settings can be completed by selecting the inverter to be used and the
connection method in step by step , and the setting results are reflected in [1.5.5.1.[2] Port].
The next setting screen changes depending on what you select, so you can set it easily.

The following is an example of screen transition when connecting to the VF1A series using USB

via VF1A-PH1 remote keypad.

Communication Sesting Wizard x
Model Selection

Please select the model to be connected.

VFIA Doesa VF1A
Datain Keypad  VF1A-PH1

Model Selection

Communication Setting Wizard X

Connection Type Selection

Please select the type of connection.

&

Direct USB connection

Back Cancel Hext

Connection Type Selection

c Setting Wizard x

Communication Setting Wizsed

Keypad Selection

Please select the Keypad to be used.

Back Cancel

Keypad Selection

=

Communication setting |

Please configure the conditions of the communication.

Communication setting

COM port COM3 <USB Serial Device (COM3)> -

Communication setting

Communication Setting Wizard X

Setting Gonfirmation |

Following settings will be applied to the Loader.

[ Model Selection ]
[Inverter model]Data in Keypad
Protocol : Loader (Doesa)

[ Connection Type Selection |
USB : Data in Keypad (in VF1A-PH1)

[ Keypad Selection |
VF1A-PH1

Back Finish Cancel

Setting Confirmation
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[2] Port

Set the following items related to communication.

@ o If the communication settings using the settings wizard on the previous page have
been completed, you do not need to reconfigure in this section.

RS-485 Connection

Select this for connecting the PC directly to the inverter via RS-485.
For information on connection examples, refer to "1.2.2.1. [1] Multi-drop Connection Using the
RJ-45 Connectors" or "1.2.2.1. [2] Multi-drop Connection Using Terminal Blocks".

- Protocol
Select the communication protocol.
The supported protocols differ depending on the inverter.

- COM port
Select the communication port of the PC connected to the USB/RS-485 converter or

RS-232C/RS-485 converter.

@ e Check the communication port of the PC using the Device Manager of the OS.
Refer to "1.5.2. Checking Communication Ports on the PC (when Using a

Converter)".

- Baud rate
Set the baud rate. It must be set to the same value as the baud rate set for the inverter.

@ ¢ For information on the baud rate of the inverter, refer to "1.5.1. Setting Function
Codes Related to Communication on the Inverter Side".

- Parity
Cannot be set in case the protocol is “Loader (Doesa)”. It is internally fixed to "Even".

- Stop bit
Cannot be set in case the protocol is “Loader (Doesa)”. It is internally fixed to "1 bit".

@ e For information on recommended conditions of the RS-232C/RS-485 converter or
USB/RS-485 converter, refer to "1.2.2.2. [1] Converter".
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USB Connection

Select when connecting the PC to the inverter or keypad using a USB cable.
Select the following depending on the connection target.

- Target Data
- Data in Inverter (via VF1A-PH1)

Select this when connecting the PC to the inverter using the USB connector of the
VF1A-PH1.

For information on connection examples, refer to "1.2.3.1. [1] Connection with the Inverter
via the remote keypad with USB".

- Data in Keypad
Select this to access the memory in the VF1A-PH1.

Select this when using the kepyad as a temporary memory medium.
For information on connection examples, refer to "1.3.2. Connection between the PC and
the keypad".

1-58



Chapter 1 Before Use

[3] Communication Conditions
Set the following items related to communication retries.

- Retry count
Set the number of retries for when a communication failure occurs. If you set to a high
number of retries, the possibility of recovering communication becomes high. However, the
time until the error dialog is displayed becomes long as well.
1 time or more is recommended.

- Timeout
If a response is not returned from the inverter within the time set here, the communication
error dialog will be displayed. The shorter the timeout time is set, the more quickly the error
display appears. However, if it is too short, a communication error may occur even when
communication is normal because of the time taken up by the inverter for its processing.

[4] Other

- Device Manager

Open Windows Device Manager to check the installation status of the USB driver.

- Message Manager

Displays the startup status of Message Manager. (ON: Indicates that it is working)
For the Message manager, refer to [1.5.4 Overview of the Message Manager].
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1.5.5.2. Connection Setting

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the
[Communication setting] window. On this window, click the [Connection setting] button to display
the [Connection setting] window.

The [Connection setting] window displays information corresponding to the equipment name
(inverter) on each row as shown below. Double-click the row for the equipment to be changed or
added, and the [Advanced...] window shown on the next page is displayed.

Selection of inverters for communication

Put the mark in the checkbox to the left of the "No." column to assign the corresponding inverter
to be the communication target.

— Communication status

Displays the state of communication between the
Loader and the inverters.

Unknown: The communication status has not
been confirmed. — Model

Connected: Communication has been established. Displays the model read from the

Disconnected: Communication has not been inverter.
established. If communication has not been
established at all, [Unknown

Model] is displ .
Connection setting x| odel] is displayed
Bdvance.. | Delate L L
———_¢ .
| Mo. | (Statuz ) |(Model ) {Equipment fddress @ Equipment name, RS-485
v | {Urknown | [Unknown Madel MW 1 station address
v 2 Urknowr Urknown Mode! N2 2 .
= ; Displays what has been set on
- I the [Advanced...] window.
- ]
I " Number of display rows
Ol 7
- P The number of rows depends on
r 7 the port selected on the
- 1 [Communication setting] window.
| n If [RS-485] is selected, a multiple
C | 12 s number of rows are displayed.
EQ"SB K Gancel | If [USB] is selected, only one row
is displayed.
— Connection check
Click the [Browse] button to check whether the connection is established between the Loader and the
inverter specified by the |¥| mark in the checkbox to the left of the "No." column.
The check result is displayed in the "Status" column.

Setting

Select the row to be edited and then click the [Advance...] button to display the [Advanced...]
window shown below.

It is also possible to double-click the row to be edited to display the [Advanced...] window.
Settings on the [Advanced...] window are provided on the next page.

Delete

Used to delete the inverter registered on the selected row.
Used when removing inverters are disconnected from the Loader.
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The [Advanced...] window is used to set [Equipment name] and [RS-485 station address].

Equipment name

Enter the name of equipment where connected inverters
are installed.

Not used for communication.

As shown in the display example below, the equipment
name is used in the list menu for selecting target
inverters on each screen.

Display example of target inverters

[Ma. 10 11 V1 =l

Equipment name
RS-485 station address

Advanced...

Tnverter Mo.

Equipment name

R5-485 station address

Cancel

RS-485 station address

According to the port setting on the [Communication setti
the address.

ng] window, follow the setting guidelines shown below to set

Port setting on the [Communication setting] window

Setting Guidelines

RS-485 Connection

Used for communication.

Match with the inverter's station address (function code
y01 or y11).

USB

. Data in Inverter (via VF1A-PH1)
Connection

Used for communication.

Match with the inverter's station address (function code
y01).

Data in Keypad

Used for communication. Only "1" can be set.

e For information on the station add

Tip

ress of the inverter, refer to "1.5.1. Setting

Function Codes Related to Communication on the Inverter Side".

the inverters registered under the

If a communication failure occurs due to a disconnection or other faults in one of

[Connection setting] window, the response

becomes extremely slow. Remove the faulty inverter from the list for the

connection setting.

for monitoring in the No.1 row. W

When using the operation monitor function, be sure to register the target inverter

hen you want to monitor multiple devices

connected in multi-drop connection, specify the monitored inverters serially in rows

No.1, No.2, No.3, and so on.

Example: When monitoring two inverters using the operation monitor function

Good example

No. | Communication Model
status
1 Connected VF1A
2 | Connected VF1A
[]1]3
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@ Bad example

No. | Communication Model No. | Communication | Mode
status status
M |1 Connected VF1A [] 11
(]2 Unknown status | VF1A 2 Connected VF1A
M |3 Connected VF1A 3 Connected VF1A
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Chapter 2

Function Description

This chapter describes the main functions of the loader.






Chapter 2 Functional Description

2.1. Main Window

This is the window that first appears when the loader is started. The Quick Access menu is
displayed on this screen when the loader starts. (The display has been omitted here.)

Main menu Toolbar

You can select all the loader functions. You can select the primary loader functions.

ZOEDEINKKI FNES 2 B IET D,

Status Bar

The text that describes the selected function appears in this
area. It also displays the status of connection with the inverter
in the lower right box.

Main menu
It contains six selectable functions: [File], [Menu], [Setup], [View], [Window], and [Help].

(When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options
are added to the main menu.)

Toolbar

This allows you to select common functions quickly and easily. For example, to open a file which
contains the function code data, you should normally click [File] on the main menu and then click
[Open] under the [File] menu; accordingly two actions are required. Using the toolbar, you can
open the file simply by clicking the = icon.

Status Bar

Hover the mouse pointer over a function icon or menu displayed. Then, the text appears that
describes the meaning of the function or menu.

Display example: The following text appears when you hover the mouse pointer over the
[Perform Connection Check] icon on the toolbar.

DEE &R X |BLE=
5

EnablesDizable Connected %! Descriptive text appears.
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The lower right box is enabled when you configure the loader to "check the connection” using
the communication settings (see "1.5.5.1. Communication Settings") or the [Connection Check]
icon on the toolbar (see the display example above).

When configured to check the connection, the loader checks the status of the devices marked
with ] in the [Connection Setting] window (see "1.5.5.2. Connection Setting") in the ascending
order of their numbers at certain intervals and displays the result.

Display example

| Mo 1: Alarm detection | Mo 1:Connected

i

L

No (number): Identifies each device checked.
The [Number] corresponds to the [No.] column of the [Connection Setting]
window.

No (number): Alarm status No (number): Communication status

Alarm status: Shows the inverter's alarm status.

Displayed

Description
content P

Nothing is

displayed The inverter is operating normally.

Alarm detection

. An alarm condition has occurred with the inverter.
(flashing)

The alarm status is not displayed if the connection check is disabled or the
connected device is the keypad.

Communication Shows the status of the communications between the loader and the

status: connected device.
Displayed _—
Pay Description
content
Connected The communications link has been established.
Not connected The loader cannot communicate with the device.

"Unknown" appears when the connection check is disabled.
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2.2. File

The [File] menu provides the following submenus:

File | Menu Setup  Wiew  Window

] Mew.
5 Open.
CGloze
=l Save
Save fs..
= Frint.
4, Frint Preview

Print selected Symbol — [Print selected Symbol]

[Print Preview selected Symbol]
Page Setup.. These submenus are available when the
[Customizable logic] window is open.

Print Preview selected Swmbol

Recent File

Exit

This section describes the main functions available under the [File] menu.

2.2.1. Create a New File

This function creates a new file of function code data.

From the main menu, click [File] > [New...] to open the [Select function code data to edit]
window.

Standard function code window

Select function code data to|edit x|

Select this when you want to edit standard
function codes (such as F, E, C).

Create the function code window

; : , : ° Customizable logic function code
Create the customizable logic function code window window

Select this when you want to edit
customizable logic function codes (such
as U, Ul, UA, UB).

Click either button to open the [Default setting] window.



The [Default setting] window lets you configure the information on the inverter for which you

want to edit function codes.

Default setting

':e' Select the following parameters

Model VF14
Region spec.  LIUSA

Voltage dphase 400V
Capacity 75 HP (0012)

Model

Select the model number.

Regional specification

’f Displays the region specified by selecting

Voltage

Read date 2/1/2022 4:38:37 PM

Definition file

Definition file 0900

Cancel

From the definition files installed, the loader

automatically selects the most recent definition file.

Change Capacity

Select the inverter capacity.

Change

Select the inverter voltage.

[Setup] -> [Region spec.] from the main menu.

Change the definition file according to the

inverter ROM version.

Refer to "[2] Guidelines on Selecting a

[1] Model, Regional Specification, Voltage, Capacity
Correctly set these values according to the inverter for which you are editing function codes.

Definition File" on the next page.

You can identify these values from the inverter model number printed on the rating nameplate of

the inverter.

The following example shows the format of an inverter model number. For details, refer to the
instruction manual of your inverter.

VF1A

I

- G 02A1 S 4

I
Code | Power supply
4 | Three-phase 400V

Code

[ Applicable tiled \

| Basic type (No buit-in EMC filter) |

[ code | Series name
| VF1A | Doesa VF1A series
[ code | Applicable tiled \
‘ G ‘ General purpose ‘
Code Rated output curent [A] | Nominal applied motor [W(HP)]
02A1 2.1 0.75 (1) \
D4A1 4.1 1.1(1.5)
05A5 5.5 22(3)
0BAY 6.9 3(4)
12A0 12 5.5(7.5)
21A5 215 7.5(10)
28A5 285 11(15)
37A0 37 15 (20)
44A0 44 18.5 (25)
59A0 59 22 (30)
T2A0 72 30 (40)
85A0 85 37 (50)
105A 105 45 (60)
139A 139 55 (75)

For inverter type VF1A-GLI[1[J[ 1S4, the destination value (function code H101) is “5: Americas”

by the factory default.
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You can change the regional specification by selecting [Setup] -> [Region spec.] from the main
menu. Once you have changed the regional specification, you have to quit and restart the loader.
Refer to "2.4.4. Region Spec." for detalils.

@ o If your specified model, regional specification, voltage, or capacity is different from
that of the inverter, an error may occur when reading or writing function codes due
to unmatched function code attributes or other reason.

[2] Guidelines on Selecting a Definition File
A definition file contains the information required to identify each inverter model and its functions.

Select the appropriate definition file based on the definition file version, revision index, and
inverter ROM version.

Definition file version and revision index

The displayed four-digit number is the ROM version, and one letter following to the version is the
revision index.

e In case of the Simplified display

OOOOO0 XXXXXX
—I_— Revision index
(Initially omitted and newer revisions are given a, b, c...)

ROM version

Display example:

Cefinition file  1300a ROM version: 1300, and Revision index: a.

e |n case of the File name display

Format of the definition file name (Example: VF1A)

fnc_E_ x 8 _LIHOIOIO_XXXXXX.csv

—Il Revision index (Initially omitted and newer
revisions are given a, b, c...)

ROM version

Code representing the inverter model

Language (omitted for Japanese, E for English)

Display example:

Definition file fnc_E_x_8_0900csy ROM version: 900, and Revision index: -.
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ROM version of the inverter

You can identify the inverter ROM version from the inverter keypad. For more information, refer
to the instruction manual of your inverter.

Tip °

Tip °

When the Loader is connected to an inverter, you can identify the inverter ROM
version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation
Monitor] window, which you can access by selecting [Operation Monitor] from the
Quick Access menu.

When the Loader is connected to an inverter, you can automatically select the
optimum definition file by selecting [Read from the Inverter] (to read the settings
from the inverter) from the [Edit data selection] window, which you can access by
selecting [Menu] -> [Setting function code] -> [Edit data selection].

If the selected definition file is not appropriate for the inverter ROM version, an
error such as failure to read or set the desired function code may occur due to the
difference in the number of function codes or other reason. If this is the case, you
will have to use a different method such as the inverter keypad to access the
desired function code.

If the inverter ROM version is unknown when creating a new definition file, you
can change the definition file later. For more information, refer to "2.3.1.3. [3]
Changing a Definition File".

Changing a definition file may, however, cause an error due to the difference
between definition files. You are recommended to select a definition file that is as
appropriate as possible when creating a new one.

Guidelines for selecting definition files

Some guidelines on selecting a definition file are shown below.

e |f there is a definition file of the same version as the inverter ROM version:

Select the definition file that is of the same version as the inverter ROM version and has the
newest revision index.

If there is not a definition file of the same version as the inverter ROM version, select the
appropriate definition file as described below.

e |If the inverter is VF1A

Select the definition file that is of the same version as the replaced version according to the
"3.2.5. Replacement of Inverter ROM Versions" and has the newest revision index.

e |f there is not the inverter ROM version in "3.2.5. Replacement of Inverter ROM Versions":

The inverter may have been upgraded after the release date of your loader. Access the
technical support page on IDEC website and check for the latest loader version upgrade file. If

one exists,

download and use it.

If the loader or the definition file is up-to-date but the inverter ROM version is still later than the
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Chapter 2 Functional Description

versions of all the definition files, select the definition file that is of the version earlier than but
closest to the inverter ROM version and has the newest revision index.

e If there are only definition files whose versions are different and later than the inverter ROM
version:

Select the definition file that is of the version earlier than but closest to the inverter ROM
version and has the newest revision index.

Tip ¢ If an error occurs in reading or writing function codes after you have selected a
definition file in accordance with the above guidelines on selecting a definition file,
contact your IDEC representative.
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2.2.2. Open

Selecting [Open] displays a window that allows you to open and edit or view a saved, existing
file that contains function code, realtime trace, historical trace, trace back, customizable logic, or
scheduled operation information.

B Open =
:_,-'@' « IDECVFD » Doesaloader » DATA w | 44 ||| Search DaTA »
Organize » New folder = - I 7
& Downloads *  Mame : Date modified Type Size F| |ter
= Recent Places
) CstmLogicPrjl.cml 362 PM ML File 1 KE
e Function1 FNL 3/6/2017 1:26 PM  FNL Fil Select the type of files displayed in
- 'D""'H _| Function2.FBL 9/6/201 PM 3L F 1 KE
- M”“f'“"‘“ . Historical trace.HT2 2017 1:25PM  HT2 File 21 K the list. Change the filter to display
o’ P Real-time trace.RT2 36/2017 1 PM  RT2 File 2 KE
E::‘“" £ Timerscdi.csv 9/6/2017 1:20 PM  Microsoft Ex the files saved from a loader other
— than VFD Doesa-Loader.
% Computer
&, Local Disk (C3)
Ca Local Disk (D) '\
File pamne: =~ Loader4 files (*.FNL; *.FBL; ~ Open
Opens the selected file.
File types
VFD Doesa-Loader
. * FNL
Function code data
* FBL
. *RT2
Realtime trace data
(*1)
Historical trace data *HT2
Customizable logicitproject data * CML

(*1) To open an RT2 file that contains the traces of the signals added using the trace monitor
function and correctly display the signal names, units, and data step sizes, you have to
provide the customizable logic project data with which the trace monitor information was
saved.

Tip e For more information on the trace monitor function, refer to "2.3.4.10.
Combination with the Customizable Logic Function”.
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Tip o The file types shown on the previous page are the types of the files available in the
[Open] dialog. For more information on the file types used in VFD Doesa-Loader,
refer to "3.2.1. Type of Files Used by VFD Doesa-Loader".

You can also drag and drop a file on the loader screen to open it.

Li Downloads A Mame

"5l Recent Places )
H‘ | | Function1.FNL

3 Libraries

File Menu Setup \View Window Help

NEH &SR XMAS= M E0@05KKKSIEEOEX|VE B JHHEES =

Doesa Loader is a utility tool that allows you to set up, run, control, and monitor the
Doesa series of inverters via a PC. Click the icon corresponding to the function you
want to perform.

[Function Code] [Trace back]
T Toset up, edit, compare, To graphically view the status
«——  transfer, or initialize function of the inverter in the event of
codes. an alarm.
[Operation Monitor] [Real-time Trace]

[No T:Urknown
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2.2.3. Close

Closes the currently active window.

2.2.4. Save

This function is available when [Function Code List], [Customizable Logic], [Realtime Trace],

[Historical Trace], or [Trace back] window is active. Selecting [Save] saves the data in the active
window.

If the data has not been saved before, the [Save] function does the same operation as "2.2.5.
Save As".

2.2.5. Save As

This function opens the following dialog, which allows you to enter the name of the active file
and save it under the entered name.

T Dswvers =

=
.2 [ Jo « IDECVFD » Doesaloader > DATA v ‘ N [ Search DATA el

Organize v New folder

o Name Date modified Typ
~u Libraries ; SIE /90 e DA
|| Functionl.FNL 8/6/2017 1:26

| Function2.FNL

| Documents
J Music

&=/ Pictures
E Videos

m

/M Computer
&L Local Disk (C)
@ Local Disk (D:)

File name: Function3.FNL

Save as type: | Function code setting data file (*.FNL) v‘

4 Hide Folders Save Cancel J

* The types of files you can save are as follows:

- Function code data: *FNL, *.FNB
- Realtime trace data: *RT2, *.CSV
- Historical trace data: *HT2, *.CSV
- Trace data (graph image): *JPG, *.BMP
- Customizable logic project file: *.CML

@ e The length of the path and file name should be up to 200 single-byte characters (up
to 100 double-byte characters). Otherwise the file cannot be saved.
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2.2.6. Print

This function allows you to specify the printer, its properties, the print range, and the number of
copies to be printed.

Printer Name
*®
x| Select an available printer

r~ Printer
Mame: II'\"Iic:rosoﬂ *PS Document Writer j Properties...
Status:  Ready Properties
Type: Microsoft XP5 Document Writer Specify the detailed settings
Where:  XPSPort: specific to the selected printer
l:"m{"eﬂt' =—Prnttofie Print Range
0]
r Print range Copies Currently fixed to the [All]
Lo Number of copies: |1 3: option
- T s [ |
Fages frar fi S8 ) e Number of copies
| Selecti ll—l 2|—| 3|—| - . .
2=actin Specify how many copies to

print

ok | cancel |

1 OK

L
Click this button to start
printing

2.2.7. Print Preview

This function allows you to view the print preview of the data in the currently active [Function
Code List], [Trace], or [Customizable logic] window.

Example:  Print preview of the data in the [Function Code List] window

Print preview - a X
S,Ov“ﬂm.mﬂ Close Page 1%

Elostrmis tharmal poarlsnd grovestion fow mosse 1 Zalest moter dhasarter . [ '
ernestio For motee 1 verleed dutetio Lo . 2

wtertim foe mate | Tharmal time semitest

Rastart made shiee menter: prews failors Bade solestiom

Frommnay limiter Serer liain
Frommay limiter Loew liain

Bian Fae Fromenas sovting 1

O beaing | Bediing marting froment;
B2 hesking | Bedbing ool 2

B braiing | Brdking tims 1] 600

"
[

0
-
3
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2.2.8. Page Setup

This function, which is available when the [Function Code List] or [Trace] window is active,
allows you to configure page settings.

Page Setup il

— Paper
Size: IM j
Source: I.Al.rtomati-:alh' Select j
r—Orientation Margins (inches)
' Portrait Left: ID.E- Right: ICI'.EI
" Landscape Top: ID.E- Bottom: ID.E

oK Cancel
I |

2.2.9. Exit

This function allows you to exit from the loader.
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2.3. Menu

[Menu] provides the following submenus:

Menu | Setup  Edit  Wiew

Function code edit..
Test run

Operation maonitor ...

Customizable logic

Schedule setting

Trace

Cuick Access Menu..

Drive operation

Terminal operation

Feal-time trace..

Hiztorical trace..

All the options except [Terminal operation] and [Quick Access Menu] are accessible from the
[Quick Access Menu] window as well.

This section describes the main functions available under [Menu].



2.3.1. Function Code Settings

Select [Menu] > [Function code edit] from the main menu or click on the main window
toolbar and click [Function Code] to open the [Select function code to edit] window.

[Function Code]
" — To set up, edit, compare, transfer,
B e— or initialize function codes.

The [Select function code data to edit] window allows you to select the source of the function

code data you want to view/edit.

Select function code data to edit |

Select editing data source

¥ Create the function code window @

" Create the customizable logic function code window e4———

Create new function setting 0—|7

Read fram the file ®

Read from the inverter

Select inverter : IN-:._ 1L 1T TNV LI
°

Cancel

[Select inverter] —

([Select keypad])

From the list of the registered inverters in the
[Connection Setting] window, select the inverter you
want to read function code data from.

Refer to "1.5.5.2. Connection Setting".

Once you select [Data in Keypad] for [USB Connection]
on the [Communication Setting] window, this label
changes to [Select keypad].

2-14

Standard function code list

Select this when you want to edit standard
function codes (such as F, E, C).

Customizable logic function code list

Select this when you want to edit customizable
logic function codes (such as U, U1, UA, UB).

[Create new function setting]

Click this button to open the [Function Code List]
window when you want to create a function code from
scratch.

Refer to "2.2.1. Create a New File".

[Read from the file]

Click this button to open a function code data file
saved in your PC.
Refer to "2.2.2. Open".

[Read from the inverter]
([Read from the keypad])

Click this button to read function code data from
the selected inverter and open the [Function
Code List] window.

Once you select [Data in Keypad] for [USB
Connection] on the [Communication Setting]
window, this label changes to [Read from the
keypad].

In this case, click this button to read function

code data from the selected keypad and open
the [Function Code List] window.
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2.3.1.1.

Function Code Edit

The following is the description the [Function code edit] tab of the [Function Code List] window.

This tab allows you to edit function code data while viewing the function code settings and their

ranges.

You can sort function codes based on various criteria.

When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options

are added to the main menu.

Tree view

[Function]:
[Change from Factory-set Values]:

[Contents of change (blue)]:
[R/W failure (pink)]:

[User Definition]:

[Communication Code]:
[Comparison Result]:

[Search Result]:

Edit

Display the function codes by group.

Displays the function codes with settings different from the factory-set values
(excluding communication codes).

Displays the edited function codes before written to the inverter or keypad.
Displays the function codes that could not be written to or read from the inverter
or keypad.

The user can freely define the display items.

Displays communication function codes only.

Displays the results of the comparison with the inverter or keypad function code
settings or saved files only.

Displays the result of the [Edit] —> [Search] operation only.

Function Code Edit

This menu item is added once you open the
[Function Code List] window. [Edit] provides the
following menu options: [Undo], [Factory-set] (see
"2.5. Edit"), and [Search] (see "2.3.1.1 [8]
Search").

These menu items are added once you open the [Function Code
List] window.

You can save and load function code settings in the CSV format.
This feature is useful when you want to edit function code settings
in an external application such as Microsoft Excel and then load
them into the loader.

Refer to "2.7. Function Code Edit" for details.

— Change of Setting
Values

You can select the function

View

Once you open the [Function Code List] window, the following menu options are added
to [View]:

[Function code info]: Same as the [Function code info] button displayed at the bottom.
[Font size]: Allows you to change the font used for function code names, etc.

Refer to "2.6.3. Parameter Information and Character size" for

code data from the drop
down-menu or edit window.

details.

ﬂ Doesa Loader - Function - [Funcfioni]

Rp=y=

FunctionCodeE:

R X Bz Mz =080 ik e BEEHES & & ] [ BE 2 ][5 o
Function code edit  Auto-tuning  File infarmation
= Functi —
Hnéolodr; group \ " Charge Mo, Function code name Setting value  Setting range  Defallt zetting M:?alm:m Mi);'r::m Ir “
... F code -
- £ code - 7
- G code FO1 |Frequency setting 1
Elziiee F02 |Operation method 2: Digable data protection and enable digital reference protection
3: Enable both data protection and digital reference protection
:1 Czde FO03 | Maximum output frequency 1 T 25 T T L T
WA F04 |Base frequency 1 §0.0|25.0 o 5000 . 600 250 5000
rJEDd; F05 |Rated voltage at base frequency 1 4600 ; 80 to 240 .. 460 160 500
e FO6 | Maximum output voltage 1 45080 10 240 V.. 450 160 500
--d code FO7 | Acceleration time 1 6.000.00t0 6000 = .00 L] Goon
d
R FU8 | Deceleration time 1 £00/0.00 to 6000 5 5.0 100 5000
-0 code F09 |Torque boost 1 000010 200% 0o 0o 200
1 cods
---Chaigecég:;lnry sett F10  |Electronic thermal overload prote 1|1to2 1 1 2
- Contents of change(f v F11 |Electronic thermal overload prote 930(000; 001 to 930 01 annn | v
< >
Read Wiirite Factory zet Func. code =et Func. code info Thitialization Advanced Print Comparizon
Select Twerter Mo. 10 1] EQUIPT Close

Nat:Uniknoer
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The following buttons are available at the bottom of the [Function code Edit] tab:

% Bead.. | Wikite... | Factary setl Func. code set... | Func. code info. | Thitialization... | Advanced.. | FPrint... | Camparisan.. | ]
[ Select werter No. 10 11 TNV 'l Cloze
[ [MNa:Gonnected
[Read]: Allows you to read the function codes from the selected [Select inverter]
inverter or keypad and load them into the loader. ([Select keypad])
[Write]: Allows you to write the edited function codes to the inverter o
Refer to the description
or keypad.
below.
[Factory-set]: Resets the selected function code to the factory-set value.
[Func. code set]: Displays the selected function code setting in the [Setting
value] window. For function codes whose settings are [Close]
available for selection from the list, however, the [Setting
value] window does not appear. Closes the [Function Code
. . . . - Setting] window.
[Func. code info.]: Displays the selected function code information in the gl
[Function code info] window.
[Initialization]: This button, available when an inverter is selected,
initializes the function code settings within the inverter.
It is not available when a keypad is selected.
[Advanced]: Displays a dialog that allows you to change the display
items and print settings. Select [Error Clear] to delete the
list of function codes that could not be written or read so
that no function codes are displayed in [R/W failure (pink)]
in the tree view.
[Print]: Prints the function code list selected in the tree in the left
pane.
[Comparison]: Allows you to compare the inverter data with the list, the

keypad data with the list, or the function code settings in a
saved file with the list.

The results of comparison appear in [Comparison Result] in
the tree view.

[Select inverter] ([Select keypad])

Select the inverter or keypad you want to write the data to. When there is only one inverter or
keypad, you do not have to select it. When you are using RS-485 multi-drop connection, you
have to select the desired one from the list.

As described in the following table, whether you should select an inverter or keypad as the
read/write target is determined by the port setting in the [Communication Setting] window. The
list corresponds to rows marked with in the [No] column in the [Connection Setting] window,
and the number of list entries is equal to the number of |v| marks.

For information on the [Communication Setting] window, refer to "1.5.5.1. Communication
Settings".
For information on the [Connection Setting] window, refer to "1.5.5.2. Connection Setting".

Table 2-1 Relationship between [Communication Setting] and your inverter (keypad) selection

o o ) ) Target inverter (Target keypad)
Port setting in the [Communication Setting] window - .
Target List entries
RS-485 connection Inverters 1 or greater
USB Data in inverter (via VF1A-PH1) Inverters 1
connection | pata in keypad Keypad 1
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[1] Read the Function Code Settings from the Inverter or Keypad
If you have selected an inverter, click [Read] button to open the following dialog.
Click [OK] to read the function code setting values from the inverter.

Doesa Loader X

0 Do you want to read the function code settings from connected inverter?

cancel |

The above applies also if you have selected a keypad. Click [OK] to read the function code
setting values from the keypad.

@ e Be sure to read from a keypad that contains data. You cannot read from a keypad
that contains no data, as is the case when you have purchased a new keypad.

- If function codes you want to read or write are password-protected:

@ o |[f the inverter has password protection enabled, do not read function codes from it.
Before reading from the inverter, be sure to disable password protection. If you
attempt to read from the inverter with password protection enabled, you may fail to
read your desired function codes or the read operation may take a long time.

This applies also to the write operation. Disable password protection before writing
to the inverter.

Tip e For more information on password protection, refer to the instruction manual or
user's manual.

[2] Write the Function Codes from the Loader to the Inverter or Keypad
To write function codes to the inverter or remote keypad with USB, use the [Write] button
displayed at the lower left of the [List Edit] window that appears when editing function codes.

The [Select function code data write operation] window opens.

Select function code data write operation x|

Wirite function code data to the inverter.
Select function code data write operation.

Cancel |

+ Editing function code data (blue part) anly

" Feeistered user definition function code data anly

" Different fram the factory default function code data (with *) anly
= Al function cods data

-
% Write function code to the EEPROMWrite 2 to v97)

~ Write function code following w97 setting
(Do not write v97 function code

[~ After writing, read out the function code data from the inverter.




These option buttons are only enabled for inverter models that have function code y97. They
are disabled (as shown below) for inverter models that do not have function code y97 or when
you write to a remote keypad with USB.

{7 Write function code to) the EEPROMINkite 2 to w470

i Wite function code following w97 settine
(e riet write w97 function code.)

Hereinafter in this manual, the inverter or remote keypad with USB you want to read to or write
from is referred to as the "target device".

- [Editing function code data (blue part) only]

Writes to the target device only the function code settings edited in the loader but not yet
written to the target device (blue part).

- [Registered user definition function code data only]

Writes to the target device only the function code settings registered as user definitions in
the [List Edit] window.

- [Different from the factory function code data (with *) only]

Writes the settings to the target device only when they are different from the factory-set
values (with *) (excluding Read-only function codes).

- [All function code data]

Writes all the function code settings to the target device (excluding Read-only function
codes).

- [Write function code to the EEPROM (Write 2 to y97)]

This option is disabled for inverter models that do not have function code y97 or remote
keypads with USB.

Select this option if you want to:

Save your edited function codes to an inverter configured to save the data in the
temporary storage memory (i.e., with y97 set to 1) and retain them in the non-volatile
memory

Change the setting of function code y97 (from 1 to O or from O to 1)

Write a large number of changed function code settings to an inverter configured to
save the data to the non-volatile memory (with y97 set to 0)

The loader sets y97 to 2 to save the function code settings to the non-volatile memory of
the inverter. This ensures that the function code settings are saved to the non-volatile
memory even if y97 is set to 1 (i.e., the inverter is configured to write to the temporary
storage memory).

(However, some function codes such as S01 are saved to the temporary storage
memory.)

In addition, when function code y97 exists in the [Function code edit] window and you
write the function codes, the loader writes the setting of y97 as well.
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Chapter 2 Functional Description

Tip

H

Note

Tip

Therefore, when function code y97 exists in the [Function code edit] window and you
write the function codes, do not forget to edit y97 in the [Function code edit] window
as appropriate. Even if you do not select y97 as the function code to be written, the
loader writes y97. If you do not want to change y97 in the inverter, ensure that the
y97 setting in the loader is the same as in the inverter.

Be sure to select this option when you write a large number of changed function
code settings to an inverter configured to save the data to the non-volatile memory
(with y97 set to 0). You can shorten the write time by selecting this option rather than
the [Write function code following y97 setting (Do not write y97 function code)]
option.

Selecting this option causes the loader to save all function codes (including those
not selected) to the non-volatile memory.

When the inverter is configured to save the data in the temporary storage memory
(i.e., with y97 set to 1) but you want to save the selected function codes to the
non-volatile memory, follow these steps:

First select [Write function code to EEPROM (write 2 to y97)] to set y97 to 0.

Next, select [Write function code following y97 setting (Do not write y97 function
code)] to write settings to the function codes you want to change.

Finally, select [Write function code to EEPROM (write 2 to y97)] to set y97 to 1.
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The loader writes function codes in accordance with the following flowchart when [Write
function code to EEPROM (write 2 to y97)] is selected:

Write standard function codes from Write customizable logic function codes
the [Function code edit] window to from the [Function code edit] window to
the inverter the inverter
START START

¢

[ Read y97 from the inverter (a) ]

N
[ Write 1 to y97 J Write 1 to y97 j
(b) ==-=z===-=-=----- e ettt e
Write settings to all the specified Write settings to all the specified
function codes function codes
N V2
[ Write 2 to y97 J [ Write 2 to y97 j

Write the setting read in (a) to y97 ]
v v

( ) (
[ Write 2 to y97 J [ Write 2 to y97 J
® ®

END END

@ ¢ If the write operation is cancelled during the period between (b) and (c) in the
flowchart above, function code y97 is set to 1. Therefore, when you restore the
settings before the write operation after cancellation, you should also restore the
original setting of y97.
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Chapter 2 Functional Description

- [Write function code following y97 setting (Do not write y97 function code)]
This option is disabled for inverter models that do not have function code y97 or remote
keypads with USB.

Select this option if you want to:

e Save your edited function codes to an inverter configured to save the data in the
temporary storage memory (i.e., with y97 set to 1) and retain them in the temporary
storage memory (you do not want to save them in the non-volatile memory).

e Write a smaller number of changed function code settings to an inverter configured to
save the data to the non-volatile memory (with y97 set to 0).

The setting of y97 in the inverter determines whether the function code settings written are
saved in the non-volatile or temporary storage memory of the inverter.

When you write to an inverter configured to save the data to the non-volatile memory (with
y97 set to 0), the settings are saved one by one to the non-volatile memory of the inverter.
For this reason, when you write a large number of changed function code settings, the write
time is longer than when you select [Write function code to EEPROM (write 2 to y97)].

Even if the function codes written include y97, the setting of y97 is not written to the
inverter. If you want to write the setting of y97 to the inverter, select [Write function code to
EEPROM (write 2 to y97)].

Tip e If you want to update to the latest settings after the write operation. check [After
writing read out the function code data from the inverter] (.
The above applies also if you have selected a keypad. Check [After writing read out
the function code data from the keypad] (.

- What to do if the write operation fails

The loader is not able to identify function codes whose write attribute (write
enabled/disabled) dynamically change (for example, function codes that cannot be changed
during operation). If you attempt to write such function codes, the write operation may fail.

If your selected function codes include those that cannot be written, the loader attempts to
write all the selected function codes and, after the write operation, displays a list of the
function codes that could not be written.

Inverter access error (Write) o [m] |

MNum. | Function code name Error code
(1NN Terminal [%1] function (Inverter status error) It can't be written, (ficcess toward a function which df

Terminal [%2] function {Inwerter statuz error) It can't be written. {Aeccess toward a function which of

ok | _swe. D

You can save the displayed list to a CSV file by clicking [Save...] at the lower right of the screen.
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After you closed the error window, you can save same information in CSV format by [Export
to CSV (Last error Info.] in [Function Code Edit] (see [2.7.Function Code Edit]) on the Main
Menu.

To check the function codes that could not be written, select [R/W failure (pink)] from the
[Function code edit] tree.

Function code edit | Auto-tuning | File information |

-0 code |

ool code Chanee

: Ma.
. Changel Factory settir
artentsof change

Function code name Setting value Errar code

EN | Terminal [41] function 1 |{Inverter status error) It can'

tailuretPink

: * E02 |Terminal [42] function 2 |{Inverter status error) It can't
= Uszer definition

The settings of the function codes that could not be written are displayed in pink.

Setting value

@)— Displayed in pink.

The write operation may fail due to the following reasons:

¢ An attempt was made to write to a function code that cannot be changed during inverter
operation.

e An attempt was made to write to a function code protected from edit via a link
(communication).
Example: When the frequency command for RS-485 communication port 1 was enabled
(with H30 set to 1) and the loader was connected to RS-485 communication port 2, an
attempt was made to write to SO1 (frequency command).

¢ An attempt was made to write to a password-protected function code.

e Write was cancelled in the middle.

To hide function codes from [R/W failure (pink)], right-click [R/W failure (pink)] in the
[Function code edit] tree.

- ChangelFactory sett Then click [Clear] on the context menu to hide the function

- Cantents of changed] .
s iJEI:-“:, codes that could not be read or written.
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Chapter 2 Functional Description

Alternatively, you can also hide the function codes that could not be read or written by

clicking the [Advanced] button at the bottom of [Function code edit] and then clicking [Error
Clear].

Advanced... x|

Select the items to be dizplayed on the editing list.

Print zetting.. | Set printz in zimplified way.
Clear the errar infarmation of Function code.
—
Cloze |

- Writing customizable logic function codes from the list

@ e When customizable logic function codes (U, U1, UA, UB, etc.) are displayed in the
[Function code edit] window and you wish to write your edited function codes by
selecting [All function code data], edit UAOO to UAG9, rather than UO1 to U70, for
customizable logic steps 1 to 14.

U01 and UAOO, U02 and UAOQ1, ..., U70 and UAG9 are written, respectively, to the same

memory addresses of the inverter. If you write by selecting [All function code data], UO1 to
U70 are overwritten with UAOO to UA69, which are written later.
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[3] Change the Settings
How to change the setting varies among function codes.

(1) To change the setting of a function code that sets frequency, time, voltage, or other numeric
value, click the field of the function code setting.

Setting value

R0

Select the desired function code and click the [Set] button at the bottom of the screen or
double-click the setting field. In the [Setting value] window that appears, change the
setting.

x
Function code Mo,  FO3

| 60.03 =

Ciancel

For function codes whose settings are available for selection from the list, however, the
[Setting value] window does not appear.

(2) For function codes whose settings are available for selection from the list (for example, FOO
"data protection” or FO1 "frequency setting 1"), click the desired function code setting field
to display the = button. Then click the = button to select the desired data from the list.

0: Dizable bol | REE

0: Dizable both data protection and digital reference protection
I: Enable data protection and dizable digital reference protection
2 Dizable data protection and enable digital reference protection
¥ Enable bath data protection and digital reference protection

Tip e When the changed function code data has not been written to the inverter, the data
is displayed in blue.

¢ When the changed function code data is different from the factory-set values, the
[Change] column is marked with * in the [Function code edit] window.
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Chapter 2 Functional Description

[4] Save

To save the function code settings opened in the loader, select [File] -> [Save] or [Save As ...]

from the main menu.

File | Menu Setup  Edit  Wiewm  Fu

] Mew.

5 Open.
Cloze

|H Save
Save Az

= Print.

__:1’ Print Prewiem
Page Setup...
Fecent File
Excit

When selecting [Save] for the data for the first time, the following dialog will open in the same

manner as when selecting [Save As ...].

Select [Save to ...] and enter the file name under which the data is saved in [File Name]. Then

click [Save] to save the file.

x
.\HJ.\“} [ )0 = IDECWD » Doesaloader » DATA - E | Search DATA EJ
Organize v  New folder = v B
8 Downloads 2| name = | ate modified | Type

1 Recent Places
|| Function1.FNL 10/2/2017 6:54PM FL Fle
4 Libraries
| Documents
J‘- Music
&=/ Pictures
E Videos
) Homegroup
1 Computer
£, Local Disk (C:) LI | | ﬂ
File name: |Funcbon2 ﬂ
Save as type: IFuncI:iDn code setting data file (*.FNL) j
~ Hide Folders Save | Cancel |
P
* FNL:

File format specific to the loader. Standard function code data (such as F, E, C). Files in

this format can be opened only in the VFD Doesa-Loader.

*.FBL:

File format specific to the loader. Customizable logic function code data. Files in this

format can be opened only in the VFD Doesa-Loader.

Ti

p e You can also save standard function code data (such as F, E, C) in the CSV format.

For more information, refer to "2.7. Function Code Edit".

e The length of the path and file name should be up to 200 single-byte characters (up

to 100 double-byte characters). Otherwise the file cannot be saved.
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[5] Print
You can print the items selected from the tree in the left pane of the [Function code edit] window.

Once you select [Function] or [Code group] from the tree in the left pane of the [Function code
edit] window, function codes such as F, E, C, ... or the group name appears.

Click the [Print] button displayed at the lower right of the [Function code edit] window or select
[File] -> [Print] from the main menu to display the [Print] window.

Refer to "2.2.6. Print".

How to set simple printing...

To print only the function code numbers and setting values from among the items displayed in
the [Function code edit] window, click the [Advanced] button at the bottom of the window to open
the [Advanced] dialog and click [Print Setting]. On the [Print Setting] dialog that appears, check
() [Simple Printing] and click [OK]. Note that this operation only determines the settings and
does not actually print the data.

x
| Select.. I Select the items to be displaved on the editing list.
m | et printz in simplified way.

Error clear | Clear the error information of Function code.
Cloze |

Print zetting x|

IV Prints in =implified way

] 4 I Cancel |

How to view the print preview before actually printing...

Select [File] -> [Print Preview] from the main menu.
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Chapter 2 Functional Description

[6] Compare

You can compare the function code setting data you are currently editing with the function code
settings in the inverter selected in [Select inverter], the function code settings in the selected
keypad, or the function code settings saved in a file and view the results.

Setting of comparison ﬁi

Select destination comparizon

| Compared with inverter oli

Compared with file =H

[T Comparison resultz include BeadOnly e—

[T Comparison resultz include Communication code e

Cloze

Close

Close this dialog.

[Compared with
inverter]s{[Compared with keypad])
If the target device is an inverter, the loader
compares the function code setting data you
are currently editing with the function code
settings in the inverter.

If the target device is a keypad, the label
changes to [Compared with keypad] and the
loader compares the function code setting
data you are currently editing with the
function code settings in the keypad.

[Compared with file]

The loader compares the function code
setting data you are currently editing with the
function code setting data saved in the file.

[Comparison results include
ReadOnly]

Check this checkbox to include "Read-Only"
function codes in the scope of comparison.

[Comparison results include
Communication code]

Check this checkbox to include
"Communication Code" function codes in the
scope of comparison.

* You should select the inverters to be compared in advance by clicking * nextto the [Select
Inverter] box at the bottom of the [Function code edit] window.

Upon completion of comparison, the focus automatically moves to [Comparison Result] in the
left pane tree of the [Function code edit] window and the comparison results are listed.

Function code edit I Auto-tuning ] File information |

Gomparison source : |Function1.FNL Comparison destination : IVFIA*G21A5S4 Difference 80 points
User definition 1 a f PPN
User definition 2 _I Change | No. Function code name Setting value 32;"3:;{?32 Setting range | Default setting M:gm:_l
User definition 3 r_J
User definition 4 MT0 [Thput power 000 056 0,00 to 399.99 (K]
User definition 5 M13 |Operation command (Final comm.. 0x0 0x800 |0000H to FF.. 0x0
=) Code for communicati "
: S code M14 |Operation status 0x0 0x28 [0000H to FF.. 0x0
M code M16  |Latest alarm contents 0 10{0 to 254 (00.. 0
W code
W1 code M17 |Last alarm contents 0 180 to 254 {00.. 0
y c‘;’de M20 |Cumulative operation time 0 11840 to 65535 0
code
ode M21 |DC link bus voltage 0 300|0 to 1000 V 0
M25 |ROM version 6000 900 |0 o 9999 6000
¥ MAT | Frmanmnevrelerenee T a =29 26 8 taa0 4 L9 ¥
< » <| | »
Read... | Wite .. | Factory set Func. code set.. Func. code info. .. | Initialization... Advanced... | Print... | Comparison... |
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[7] User Definition (Display desired function codes only)
Registration
To register function codes in a user definition, select your desired function code(s) from the list
of function codes displayed in the [Function code edit] window and click the right mouse button.
The available user definition group names ("User Definition 1" to "User Definition 5" in the
example below) are displayed on the submenu. Click your desired user definition name. The
selected function codes are then registered in that user definition.

Function code edit | Auto-tuning I File infarmation I

(=1- Function - . . . 2 Minimum Mazximum
B Code group Chanee | Mo. Function code name Setting value | Setting range | Default setting e whe

F code
.. E code 0|0to 2 0 0

- C code : 0040 12

- P code £ =

- H code
H1 code

- A code

-.b code

DC;D%Z Uszer definition 3

M code FO6  |Maximum output voltage 1 !ZI User definition 4 . 200 80 24

~d code F07 |Acceleration time 1 L. .00 0.0 600

..y code T —T—— Uszer definition & w0 w0 o

K eods Freleration tme Release user definition

-0 code FO9 |Torque boost 1 I . 49 0 20.
ol code I I

- GhangelFactary settiv _ | FI0 |Electronic thermal overload prote... | Tt 2 1 1

Data protection

Factory setting

User definition 1

Uszer definition 2

-l

Display

From the list of user definition groups displayed in the tree in the left pane ("User Definition 1" to
"User Definition 5" in the example below), select and left-click your desired group to display the
function codes registered in that group.

Function code edit | Auto-tuning I File information I

= Function . f
- Code eroup Change | Mo. Function code name Setting value | Setting range | Default sstting M:L'Ezm Mi);'m;"m I
Change(Factory setting « -

. Contents of chanee(Blue F01 |Frequency setting 1 0{01to 12 1] 0 12

f F02 |Operation method 2|0t 3 2 0 3

F03  |Maximum output frequency 1 600|250 to BOOD .. 600 250 500.0

Fid4 |Base frequency 1 B0.0{250 to BOOD .. 500 250 500.0

User definition 3
User definition 4 Fi% |Rated voltage at baze frequency 1 2000 ; 80 to 240 . 200 40 240
User definition §_- FO7 |Acceleration time 1 £.00(0.00 to 6000 = 600 0.00 6000
ication

[?--Oumparisun result F08 |Deceleration time 1 G.00{0.00 to G000 = 600 ] G000

- Search result Ji1 |PID contral (Made selection) {048 0 0 3
|

Unregistration

To unregister a function code(s), select your desired function codes and click the right mouse
button. Select your desired user definition group from among the user definition groups marked
with ¥ on the submenu, and left-click it. The selected function codes are unregistered.

If your selected function code is registered in two or more user definition groups, you can
unregister that function code from all the user definition groups by left-clicking [Release user
definition] on the submenu.

Function code edit | Auto-tuning | File information |

= Function . .
- Code group Ho ‘ Function code name ‘ Setting value | Setting range | Default setting M{gm:m Mi?;llrﬂgm I
- Change(Factory setting + -
... Contents of chanee!Blue Fi .
- RAW failurel Pirk) FO? |Operation methad fecioivietting 2 0 3
=] Uger definition
| [ e— FO3  |Maximum output frequency 1 |7| User definition 1 .. g60.0 250 5000
User definition 2 FO4 |Base frequency 1 User definition 2 E 500 250 5000
User definition 3
User definition 4 F05  |Rated voltage at base freque User definition 3 .. 200 a0 240
Uzer definition § FO7 | Acceleration time 1 User definition & S .00 0.00 G000
[ Caode for communication -
.. Comparisan result FO8 | Deceleration time 1 User definition § = .00 0.00 G000
- Gearch result J01 |PID contral (Mode selection) Fl=ss ve i ] ] 3
| "
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Renaming a user definition name

- User defi

it iorn

: User definition
i Uzer definition

[ twocwee

About writing and reading to the inverter

To rename a user definition, left-click or
right-click one of "User Definition 1" to "User
Definition 5" in the tree in the left pane and
left-click [Name change].

For supported inverter models, the contents of favorites (formerly known as quick setup) set in
the inverter are read as user-defined, and conversely, the contents of user-defined are written as

inverter favorites.

Refar to “2.3.1.1 [1] Read the Function Code Settings from the Inverter or Keypad”.
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[8] Search (Search function code terminologically)
Select [Edit] -> [Search] from the main menu to open the [Search] dialog.

e =l From among the words contained in the

Search string

I ok | Function code edit window, enter the keyword
Seareh conditons cnel | | to be searched and click the [OK] button.

* AND  OR
I~ Gapital letter # small letter iz distinguished.

I™ 1 bvte character / 2 byte character is distinewished.

The focus automatically moves to [Search

4| Result] in the left pane tree of the [Function
code edit] window and the function codes that
include the entered keyword are listed.

Use the space delimiter .
If you do a search to include the space,

is used

The following is an example of searching keywords "voltage" and "current” with the OR
condition.

Delimit keywords "voltage" and "current" with

gearch|string a single-byte space.

|vn|tage current

Search conditions Select [OR].
’Tf" GHD + OR

Function codes that include "voltage" OR "current" are listed.

Function code edit | Auto-tuning | File infar mation |

[=]- Function - . -
- Code eroup Chanee | Mo. Function code name Setting value | Setting range | Default setting Mgm:m Mf:;'{::m_
- Chanes(Factory setting «
Contents of chanee(Blue Fi% |Rated voltage at baze frequency 1 200(0; 80 to 240 .. 200 40 X
R failured Pink) FOf  |Maximum output voltaze 1 20080 to 240 ; 200 a0 n
Uzer definition — -
F43  |Current limiter (Mode selection) 20102 2 0
F4d | Current limiter (Level) 18020 to 200 % 180 i 2
E34 [Owerload early warning/current d.. 22500000; 001 to .. 22480 oot anr
E35 |Owerload early warning/current d.. 1000 {007 to G00.0.. 1000 0.0 GO0L
E37 |Current detection 2/ low current .. 2250000001 t0 .. 2260 o 3o
E3d |Current detection 2/ low current .. 1000|0071 to GO00... 1n0n nm GO0
ESS  |Current detection 3 {Level) 2250(000; 00110 . 22560 000 300
ES6 |Current detection 3 (Timer) 1000|000 to GO00... 1n0n 01 GO0
E?6 |DC link bus low-voltage detectio. 285|200 to 4000 235 200 40

@ e The search target range includes all items (changes, No., function code names,
setting values, and so on).
However, the items hidden by clicking [Advanced] -> [Display Item] are also
included in the search target.

e The text of function code information are not included in the search target.
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2.3.1.2. Auto Tuning

This function automatically measures the motor parameters and saves them to the inverter.

@ o Before performing tuning, carefully check the description of tuning (including the
settings required before tuning, machine preparation, precautions, etc.) in the
User's Manual of your inverter.

—— [Motor tuning (Select)]
Select the tuning method.

Check the condition of the machine to determine whether to perform "Inactive tuning" or "Active tuning".
(For more information, refer to the User's Manual of your inverter.)

— [Motor] — [Tuning result] — [Tuned result]
Displays the currently | Displays the tuning result Clicking the [START] button causes the loader to read the
selected motor. upon completion of tuning. motor parameters from the inverter and display them in

the [Before] column.

Upon completion of tuning, the loader reads the motor
parameters from the inverter and displays them in the
[After] column.

Function code ed File information

Matar tunine (Select) (Tuned results 2

L

Function code name Eefore After

0 : Tnactive

TunwL

G
Operating procedure

1. Select the inverter to be tuned.
2. (Only when multiple motors are connected)
Select target motor with input terminal ete.
3. Select tuning operation, and the rotation direction.
4. Press the [START] button to start tunine.
5. Upon completion, the result of tuning will be displaved.

—Motor parameter

Mumber of poles — paolez
Motor capacity L
Motar rated current — .y
Rated voltage

& Loader (FWD)

START
T Loader (REV) —I

(~Rotation direction — Auto-tuning 1

Select Inverter IND. 10 11 IMw1 vl Gloze

L [Rotation — [Motor parameter] [Auto tuning] [Select inverter]
direction] Clicking the [START] Click the [START] button to start  Select the inverter
[Loader (FWD)]: Forward button causes the loader tuning. you want to tune.
rotation(] to read the motor ;

[Loader (REV)]: Reverse parameters from the \éVI:te nyou C“?-k th?- [S-LA-RlT]
rotation inverter and displa utton, a confirmation dialog

. Inve y appears. Click [OK] on the
Select either of the two them.

confirmation dialog to start tuning
in the direction selected under
[Rotation direction].

rotation directions
according to the direction
in which the machine
actually rotates.
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2.3.1.3. File Information

This function displays the information related to the currently displayed list of function codes.
You can change [Voltage], [Capacity] and [Current definition file] as you want.

— [Properties] — Comment

- If you have read function codes from the inverter,(Ithis area You can save a comment as needed.
displays the inverter information.

- If you have read function codes from the keypad,(ithis area
displays the inverter information saved in the keypad.

- If you have opened the [Function Code Setting] window by clicking
[Create new function setting], this area displays the initial settings
for creating a new function code.

- If you have opened a saved data file by clicking [Open] under the
[File] menu, this area displays the information contained in the
saved file.

Function code edit  Auto-tuning File information

ropert \ /Gomments N\
‘f Chanee |)

File name Function

Mode! VFI1A

Region spec.  LEUSA
Voltage 3phase 400V

Capacity 75 HP (0012)

Current definition file  fnc_E_x_8_0900csy

Read date 2022/02/10 - 11:35:27

Saved definition file

AN J

Mote) Even if the 'Region spec’, ‘voltage' and 'capacity' are changed on this screen,
It does not write it in the inverter.

Select Ihwerter No. 1L 1] EQUIP1 ~ Close

— [Change] Setting X
Click this button to open the [Setting] dialog shown at
right. ._9:. Select the following parameters
Model VF14

Region spec. | LLUSA

Voltage 3phase 400V v
Capacity 75 HP (0012) ~
Definition file  fnc_E_x_8_0900csv Chanee

Garee
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Chapter 2 Functional Description

[1] Changing the Input Power Supply Voltage
You can change the input power supply voltage of the inverter whose function code data is
currently displayed in the function code list.

Correctly set these values according to the inverter for which you are editing function codes.

Tip ¢ You can identify the input power supply voltage from the inverter model number
printed on the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional
Specification, Voltage, Capacity” for details.

Changing the value in the [Voltage] box automatically modifies the [Setting], [Factory-Set Values],
[Minimum] and [Maximum] values of function codes whose factory-set values change depending
on the voltage setting (for example, function codes whose data copy attribute is set to "1").

Wnltage 3phase 200y x|
: Iphaze 200
Capacity Sphaze 200
|

A Are you sure you want to change the voltage setting?
0' Changing it automatically reverts the related function code data to
= factory defaults.

Cancel |

@ ¢ As shown in the above dialog, changing the voltage setting automatically
initializes the settings of the function codes related to the voltage. So, save the file
you are currently editing as needed.
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[2] Changing the Inverter Capacity

You can change the capacity of the inverter whose function code data is currently displayed in
the function code list.

Correctly set these values according to the inverter for which you are editing function codes.

Tip ¢ You can identify the inverter capacity from the inverter model number printed on
the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional
Specification, Voltage, Capacity” for details.

Changing the value in the [Capacity] box automatically modifies the [Setting] and [Factory-Set
Values] values of function codes whose factory-set values change depending on the capacity
setting (for example, function codes whose data copy attribute is set to "2") to the values
associated with the new capacity value.

Capacity 75 HP (0012) v

1 HP (0002)
2 HP {0004)
3 HP (0006)
4 HP (0007) Doesa Loader X
7.5 HP (0012)

Definition file

B Are you sure you want to change the capadity setting?

20 HP (0029 J Char‘:ghgita:twatlcally reveﬂgs the relaptaedt:uncﬁor?mde data
25 HP (003?) to factory defaults.

30 HP (0044)
40 HP (0059)
50 HP (0072)
60 HP (0085) L

* For some models, current types are displayed enclosed in (). Example: 11 kW (0022)
@ ¢ As shown in the above dialog, changing the capacity setting automatically

initializes the settings of the function codes related to the capacity. So, save the
file you are currently editing as needed.
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Chapter 2 Functional Description

[3] Changing a Definition File
Select a definition file appropriate for the inverter ROM version.
For example, your selected definition file may not be appropriate if you have been using a

definition file with default settings because the inverter ROM version was unknown when you
created the function code list. If this is the case, you should select a different definition file.

@ o If the selected definition file is not appropriate for the inverter ROM version, an
error such as failure to read or write function codes may occur due to the
difference in the number of function codes or other reason.

Tip ¢ If you read the settings from the inverter by selecting [Read from the inverter] on
the [Menu] -> [Function code edit] -> [Select function code to edit] window, the
loader automatically selects the optimum definition file and therefore you usually
do not have to select a different definition file.

To change the definition file, click the [Change] button on the [Setting] dialog.

Definition file fnc_E_x_8_0900csv ‘

LaliEniie x From among the definition files
ROM Version displayed on the list, select the
E;EE" definition file appropriate for the
0600 inverter ROM version and click the
g;gg [OK] button.
For information on how to select a
definition file, refer to "2.2.1. [2]

T Guidelines on Selecting a Definition
File".
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Changing a definition file may, however, cause an error due to the difference between the
definition files before change and after change.

The figure below shows an example of an error that may occur when you change the definition file
from "fnc_E_x_8 0900.csv" to "fnc_E_x_8_0600.csv". The function code settings not affected by
the file read error are applied as-is.

Num. Function code name Error code
Overload Stop Function (P gain) The address of the function is wrong. Refer to the comparison result in the
J91  Overload Stop Function (Integr.. | The address of the function is wrong. Refer to the comparison result in the
J92  |Overload Stop Function (Curre_. The address of the function is wrong. Refer to the comparison result in the
y96  Communication compatible mo_. The address of the function is wrong. Refer to the comparison result in the

W130 Power state The address of the function is wrong. Refer to the comparison result in the

Tip e Any function codes that existed before the change of the definition file but do not
exist after the change are deleted from the [Function code edit] window.
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Chapter 2 Functional Description

2.3.2. Operation Monitor

You can monitor the status of the inverter during operation.

Select [Menu] > [Operation Monitor] from the main menu or click on the main window
toolbar and click [Operation Monitor Setting] to open the [Operation Monitor] window.

)

[Operation Manitor]

To open IO manitor, system
monitor, alarm monitor, and
operation status monitor.

You should use the [Operation Monitor] window only when the loader is connected
to an inverter or keypad. The loader displays no signal if you open the [Operation
Monitor] window without connection.

Depending on the communication link condition, it may take a long time to detect
the communication target. The loader does not respond until the communication
target is detected. To avoid the inability to operate the loader for a long time, you
should use the loader in an environment with as good communication conditions
as possible.

Whenever you use the [Operation Monitor] window, specify the monitored inverter
in the No.1 row on the [Communication Setting] -> [Connection Setting] window.
When you want to monitor multiple devices connected in multi-drop connection,
specify the monitored inverters serially in rows No.1, No.2, No.3, and so on. For
information on [Connection Setting], refer to "1.5.5.2. Connection Setting".

If you have selected [Data in Keypad] for [USB Connection] on the [Communication Setting]
window and the loader is connected to a keypad, the [Operation Monitor] window displays the
inverter information saved in the memory of the keypad. For information on the memory function
of the remote keypad with USB, refer to "1.3.1 Memory Function of the keypad".

Be sure to read from a keypad that contains data. You cannot read from a keypad
that contains no data, as is the case when you have purchased a new keypad.
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2.3.2.1. 1/0 Monitor (for monitoring inverter input and output terminals)

You can monitor the status of an inverter's input and output terminals.

~lolx
rm“ System momtor| Alarm mommr| Operation status monitor |
Input terminal Qutput terminal
Terminal ft"_:‘m Normal | Status = Terminal ft‘:i‘m Mormal | Status =
%1 [551] Select .. |Open 1 [RUN] Inverte.. |Open
%2 [552] Select .. |Open 2 [OL] Motor ov... |Open
X3 [554] Select .. |Open 30Ry [ALM] Alarm .. |Open
¥4 [B%] Coast to.. |Open
b [RST] Reset .. |Open
ENI1 . Close
EN2 o Close
cumn (=TT I = P e ¥ x
Terminal Iten Unit Value = Terminal Foocion Unit Value =
12 [None] v 00 FM (FMV) [F-out 1] Out.. |V 0.0
G1(C1 functi. |[[Mone] ma 0.0 FM (FMD [F-out 11 Out.. |mA 32767
G1 (W2 functi.. [[None] W 0n || FM (FMP) [F-out 1] Out... |p/s 0 =
FM2 (FMY)  |[I-AC] Output... |V 00
FM2 (FMD [I-AC] Output... | mA 32767
Save CSV file | Befregy | Advanced
[Connectine: vF1a-G21A554 Target Inverter: WE
|
[Save CSV file] [Refresh] [Advanced] [Target inverter]
Allows you to save the 1/0 Update the terminal Click this button to Select the inverter you
monitor data to a CSV file. function, status, and show/hide signals and want to monitor.
values. change the display order.

Status color

Green if a normally-open terminal is open or a normally-closed terminal is closed; orange otherwise.
[Normal] [Status (Open)] [Status (Closed)]

Special value

If '3276.7' is displayed as the value for an output terminal, it means that the output terminal is not
associated with an output type expressed with a unit of measurement (voltage output [V], current
output [mA], pulse output [p/s]).

For example, when the value for Terminal Function Uit Walue

[Tt

terminal FM is displayed as FM {FMD [F-out 1] Out.. |mA 32767
shown at right, this terminal is

not associated with current
output (unit: mA).

@ e When the loader is connected to an inverter that has password protection enabled,
the functions of terminals may not be displayed (with [READ_ERR] displayed
instead). If this is the case, you should disable password protection to have the
terminal functions correctly displayed. For more information on password protection,
refer to the instruction manual or user's manual of your inverter.
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Chapter 2 Functional Description

How to show/hide signals and change the display order

Click the [Advanced] button to open the [I/O monitor display item select] window.
This window allows you to select which signals to display in the [I/O Monitor] window and
change the display order.

IO monitor display item select x|

Input Output terminal setting
Tnput terminal (Digital) Qutput terminal (Digital) Thput terminal {Analog) Output terminal {Analog)

FM (FMD)

Fi (FMF)
FM2 (FMW)
Fh2 (FMI)

Y2 1 (C1 function)
1 (W2 function)

® Titialize | Select |
T
Initialize Select Save Close
Click this button to initialize  Click this button to open a Click this button to save Click this button to close
the settings. saved setting file. the settings to a text file the window.

To hide a signal
EM2

Left-click the signal you want to hide.

REW

= Left-click it again to activate the list box.

D

REW
Fin'Dr -
Select the blank from the list.
E
i
Tnput Output terminal setting . .
S e (B Gt i (B I el Gt Cutput terminal (Analoe) Click [Save] to save the settings

. to a file.
2 G1{G1 function) FM (FMD
30Ry 1 (Y2 function) FM (FMF)
FM2 (FMW)
FM2 (FMD

Thitialize Select Save Close
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To change the display order

For example, suppose you want to move [FWD] to the position of [X1].

Hide the signal you want to move.
(Refer to "To hide a signal" above.)

[FWD] is hidden in the example at left.

Left-click the destination position.

[X1]is left-clicked in the example at left.

Left-click it again to activate the list box.

Ha

31 Ll From the list, select the signal you want to move.
(The list displays the currently selected signal and the hidden
signal.)
[FWD] is selected in the example at left.

]

Tnput Output terminal setting

Output terminal {Digital) Tnput terminal {Analog) Output terminal {Analog) Clle [Save] tO save the Settings
to afile.

Tnput terminal {Digital)

w2 G1 (G function) FM (FMD)
30Ry G1 (V2 function) FM (FMP}
FM2 (M)
FM2 (FMD

Tnitialize Select Bave Close

@ ¢ If you close the [I/O monitor display item select] window without saving the settings,
your changes will not be reflected to the [I/O Monitor] window.
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Chapter 2 Functional Description

2.3.2.2.

System Monitor
(for monitoring the internal setup information and maintenance
status of the inverter)

The system monitor allows you to check the inverter's ROM version, model, internal setup
information, and maintenance information.

~in/x]
| | Alarm monitor | Operation status monitor |
System Maintenance
Ttem Value Item Value =
Type VF1A-G21A554 Cumulative run time [h] 1168
Operation command Terminal block operation com._. DG link circuit voltage [V] 300
Frequency command Keypad Max, effective output current [.. [1.73
Motor selection Motor 1 Input watt=hour [100kWh] 0429
Control method W contral without slip compe... Ihput watt-hour data 0429
Inverter's ROM version a00 Temperature inside the inverte... |0
Inverter's ROM version (GPU 2) |0 Max. temperature inside the in.. |0
Keypad's ROM version 0 Temperature of heat sink (real.. |20
Option's ROM version 1 0 Maz. temperature of heat sink |20
Capacitance of the DG link bu.. |0.0 =
Lifetime of DG link bus capaci.. 1160
Lifetime of DC link bus capaci.. 86440
Cumulative run time of electral .| 1130
Cumulative run time of the coo..| 1160
Number of startups 176
Remaining startup times befor.. |0
Cumulative run time of motor .. |40
Remaining hours before the ne.. |87560 -
Save CSV file
[Connecting: vF1a-G21A554 Tareet Inverter:  [MNo. 10 gl INW1 |

[Save CSV file]

Click this button to save the system monitor data to a CSV file.

2-41

[Target inverter] ——

([Target keypad])

Select the inverter you want to monitor.




2.3.2.3.

Alarm Monitor (for monitoring the inverter's alarm information)

Shows the inverter's alarm status. The alarm monitor allows you to check the content of the
current alarm and the various operation information recorded when the alarm occurred.

— [Alarm Reset]
Click this button to

(clear) the current alarm.

reset

—[Initialize the alarm history]

Click this button to initialize the
connected inverter's alarm history.

[Data when alarm occurred]

This list displays the operation information
recorded at the time of the occurrence of the
alarm you selected from the list box.

™ Operation Monitor = |E|L|
/O monitor | System monitgr FRTGVEEOEIW—HI Operation status rrmitor]
/Data when alarm occurred ILatest alarm 'l \
ILL‘::”‘ LA Ttem Value Unit ]
Alarm code LY
MNumber of serial occurre.. |0
— | | Alarm Reset I
Multiple alarm 1 ==
itialize the alarm higtoty | Multiple alarm 2 —
Sub code 1
Alar
Output frequency G000 Hz
Last alarm QH2
Qutput current 009
2nd Alarm o
Output voltage 0 W
3rd Alarm —=
Torque 0 %
Set frequency 6000 Hz
Operating status (Hex) o021 K26/ X65/Z05/255
Cumulative operation time | 1168 h
Number of startups 176 o
DG link circuit voltage 0 v
Temperature inside the in_. |0 deeC
Temperature of heat sink |20 degC
Input terminal {Hex) 1801 X3SKNAZ1/261
Save CSV file | =
WO itoust borminal {Hew) a0t 29/%30/7 19 /7RI
[Connecting: vF1A-G21A554 Target Iwerter:  [No. 10 1] INV1 =l
()

[Save CSV file]
Click this button to save the data when alarm occurred to a CSV file.

[Target inverter]
([Target keypad])

Select the inverter you want to monitor.

AWARNING

o Carefully note that resetting the alarm with the operation command on causes the inverter
to start unexpectedly as soon as the alarm is cleared.
Failure to observe this could result in an accident.

@ e The [Initialize the alarm history] button may not work on an inverter that has
password protection enabled. If this is the case, you should disable password
protection so that you can use [Initialize the alarm history]. For more information on
password protection, refer to the instruction manual or user's manual of your
inverter.
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Chapter 2 Functional Description

Hexadecimal value

If an item name in the [ltem] column is followed by "(Hex)", the [Value] column shows a
hexadecimal value and the [Unit] column shows the function code information. The function
code information shows the most recent alarm, the second most recent alarm, the third most
recent alarm, and the fourth most recent alarm, respectively, from left to right.

Detailed information will be displayed by clicking [+] symbol on the "Unit" column if it is
available.

For example, when the loader is connected to VF1A and the operation status value for the most
recent alarm is '0021' (as shown below):

Item Yalue it
Operating status (Hex) nn . [+I}28/ 68 2008/ 200
a3
Detailed information
Operating status {Hex)
value : Ox0021
bit00: 1 [FWD]Forward
bit01: 0 [REV]
bit02: 0 [EXT]
bit03: 0 [INT]
bit04: 0 [BRK]
bit0%: 1 [HUv]
bit06: 0 [TL]
bt 7: 0 [vL]
bit0$: 0 [l
bit09: 0 [ACC]
bit1: 0 [DEC]
bit11: 0 [ALMI
bit12: 0 [RL]
bit15%: 0 [BUSY]
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2.3.2.4. Operation Status Monitor (for monitoring the inverter operation
status)

Allows you to check information such as the present output frequency and output voltage.

™ Operation Monitor =10] x|
Operation status
Item Value =
Frequency reference [Hz] 000

Output frequency (before slip .. |0.00
Output frequency (before slip .. |0.00

Output frequency (after slip co..|0.00

Output current [A] 000

Output voltage [V] 00

Torque value [¥] 0.00

Motor speed [r/min] 000

Load shaft speed [r/min] 000 =
line speed [m/min] 000

Surface speed monitor [Hz] 000

Flux command value [%] 0
Operation status (M14) (Hex) 0028
Operation status 2 (M70) (Hex) |2484
Running status 2 (M74) (Hex) 0000
Level of torque value & [¥] 32767

Level of torque value B [%] 32767

PID process command 0.00 -
Save GV | vanced
|Connecting: VF1A-G21A554 Target [nverter: |N$ 10 111NV =l
[Save CSV file] —[Advanced] [Target inverter]
Click this button to save the Click this button to show/hide signals ([Target keypad])
operation information to a CSV and change the display order. Select the inverter you want to
file. For more information, refer to monitor.

"2.3.2.1How to show/hide signals and
change the display order".

Special value
If the torque limit value is '32767', it means "no operation".

Hexadecimal value

If an item name in the [ltem] column is followed by "(Hex)", the [Value] column shows a
hexadecimal value. The function code is shown in the pair of parentheses immediately preceding
"(Hex)".
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Detailed information will be displayed by clicking [+] symbol on the "ltem" column if it is
available.

For example, when the loader is connected to VF1A and the operation status value is '0028' (as
shown below):

Item Yalue

Eﬂbperatiun status (M14) IIHRx]I nn2a
o}

Detailed information

[+]10peration status (M14) (Hex)
value - 0x002%

bit0l: 0 [FWD]

bit - 0 [REV]

bit02: 0 [EXT]

bit03: 1 [IMTlInverter shut down
bit04: 0 [BRK]

bit0%: 1 [NUv]

bit06: 0 [TL]

bt 7: 0 [vL]

bit08: 0 [L]

bit0y: 0 [AGC]

bit10: 0 [DEG]

bit11: 0 [ALMI

bit12: 0 [RL]

bit15%: 0 [BUSY]
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2.3.3. Customizable Logic

The customizable logic function allows you to create logic circuits using a graphical editor tool
and transfer them to the inverter.

Also, you can debug your circuits on screen.

Select [Menu] > [Customizable Logic] from the main menu or click on the main window
toolbar and click [Customizable Logic] to open the [Select customizable logic project to edit]
window.

[Customizable Logic]
iﬁ)— To open, edit or create a new
praject of Customizable Logic.

The [Select customizable logic project to edit] window allows you to select the customizable
logic you want to view/edit.
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2.3.3.1. Select Customizable Logic Project to Edit

When you start the editor, the [Select customizable logic project to edit] window (shown
below) appears first.

Select customizable logic project x|

Select editing project.

Create new project I

Read from the file... |

Cancel |

- [Create new project]

Click this button to create a new customizable logic project.

The model and version numbers affect how many steps you can use, what types of
circuits you can create, etc. So, correctly set the model and version numbers according to
the target inverter.

Model

Inverter model selection X
Select the model number of the target

inverter.
Model VF1A v

Version 900 v

Number of steps

Number of step 1200 _
- Shows the maximum number of steps.
Gancel

L— Version

Select the ROM version of the target inverter.

For VF1A ROM version 5600 or later, interpret the ROM version in accordance with the instructions in "3.2.5
Replacement of Inverter ROM Versions"

If the list of choices does not contain the same version as the inverter ROM version, select the version earlier than
and the closest to the inverter ROM version.

If the inverter ROM version is later than all the versions in the list of choices, the inverter may have been upgraded
after the release date of your loader. Access the technical support page on IDEC website and check for the latest
loader version upgrade file. If one exists, download and use it.

Tip ¢ You can identify the inverter model number you should select in the [Model] list
box from the inverter model number printed on the rating nameplate of the inverter.
Refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" for detalils.

¢ You can identify the inverter ROM version from the inverter keypad.
For more information, refer to the instruction manual of your inverter.
When The Loader is connected to an inverter, you can identify the inverter ROM
version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation
Monitor Setting] window, which you can access by selecting [Operation Monitor
Setting] from the Quick Access menu.
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Tip ¢ If the inverter ROM version is unknown when creating a new definition file, you
can change the version number later. For more information, refer to "2.3.3.12.

Project Properties".

However, changing the version number changes how many steps you can use
and what types of circuits you can create. As the result, an error may occur during
step number assignment. You are recommended to select a version number that
is as appropriate as possible when creating a new circuit.

- [Read from the file]

Click this button to load a customizable logic project file saved in your PC and open a window

for editing the file data.

open X
) [l 1DECVFD » DoesaLoader » DATA v (&3 | searchoaTA 5]
Organize v  New folder = ~ 0 Q‘
I Deskiop 2] o - |Datemodﬁed |T\|pe

& Downioads
4] Recent Places | ] CstmLogicPrL.cml 10/2/2017 7:44PM  CML File
-4 Libraries
| Documents
ﬂl'- Music
| Pictures
E Videos
) Homegroup
1 Computer |
&, Local Disk (c:)
& ﬂ | J— ﬂ
File name: [CstmchicPrjl.cml d w‘-cmﬂ =
|< Open VD Cancel l
4
File types

Filter

Select the type of files displayed

in the list.

[Open]

Opens the selected file.

VFD Doesa-Loader

Customizable logic data

*.CML
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2.3.3.2. Editor Screen

Project management window Toolbox

Allows you to manage the project files and function block  Allows you to access the symbols provided by the

properties. customizable logic function.

— lcons for customizable logic
[Select inverter] [Update] [Grid] —— Zoon in/Zoom out
([Select keypad])

Select the device you

Click this button to update
the number of steps.

Click this button to
change the grid size

Allows you to zoom in or
out to the layout area.

want to connect to.
B Docsa Loader - € Logic - CstmlogPr1 - [Ci Logic { CatmLogicPrj1] - O X
> File Menu Setup View Windew |Help -8 X
NER @R X Bo= MA =000 8kkHke BDE B | £ | B 5
Customizabie Logi et e T '\':%:ubq:wq Ditalefngog FE -
ustomizable Logic | I 1EQWP1 v Dstep 7 260 szpe @ @ LM e =
X | Progan®d | et O A
»—- - P
— FB with 1
:‘Ecﬁo rth the project) -
Branch
- = ==
Comment
[ e
— 5
: fE—ea
Clear bog)_Execution cyele: ** [mg » ND
T =
J HOCHEHT .
£ »
Nol:Unknown

[Clear log] [Execution cycle] Output window Layout area

Click this button to
clear the messages in
the output window.

Shows the approximate time
between two executions of a step.
The execution cycle is determined
by the model and the maximum
number of steps.

You cannot set the execution
cycle as you want.

Displays information
such as the results of
auto assignment of
function codes.

Allows you to place symbols
to draw a customizable logic
function circuit.

Icons for customizable logic

(1) 2 @ @ (5) (6) (7) (8) 9) (10) (1) (12) (13)
REES &8 B I el 5 -

No. Icon name Function Rela.ted
section
(1) | Toolbox Show or hide the toolbox. 264
(2) | Project management window Show or hide the project management window. 264
(3) | Output window Show or hide the output window. 26.4
(4) | Search symbol Search symppls placed on the editor screen based 2335
on the specified keyword.
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No. Icon name Function Rela.ted
section
(5) | Auto step number assignment Perform auto step number assignment and circuit 2337
check.
(6) Step number assignment Display the screen for managing step numbers. 2.3.3.7
screen
Settings for the user setting Display the I!st screen of functllon codes U121- gnd
. = | U171-, the list screen of the input/output terminal
(7) | area and the customizable logic . . . 2.3.3.6
properties, and the list screen of the function code
memory area .
settings for each step.
Write to inverter ) ] o ]
(8) Write the edited circuit to the inverter or keypad. 23.3.9
(Write to keypad)
©) | Comparison pompare the edited cnrcu_|t with a circuit in the 23.3.10
inverter, keypad, or saved file.
(10) | Monitor Monlltor the operation status of the circuit written to 23311
the inverter.
Create and save the signal information for using the
(11) | Save trace monitor information realtime trace function to monitor the operation 2.34.10
status of the circuit written to the inverter.
(12) | Start/stop customizable logic Start/stop the circuit written to the inverter. -
Simplify the series of operations from [Step number
(13) | Online batch processing assignment] to [Write to the inverter] to [Start 2.3.3.11
customizable logic] to [Start monitor].

Toolbox

Symbol selection tab

1
|
You can select the desired logic type group of i
1
1
1

e ocmEur symbols by selecting one of these tabs.
= -a - =q LI
Branch —i Symbol selection list box
L I : i You can select the desired symbol type by
| Gz i selecting from this combo box.
LA _. e —
mough .................................................................. ! Common symbols
[ @- E @- Input/output
. . These symbols represent an input/output
EE H terminal.
AND Branch

Comment

Use this symbol to add a comment.

YOR

F—THEEHEHEHET

Logic symbols

choice.
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Chapter 2 Functional Description

2.3.3.3.

Workflow of Creating a Circuit

The following is the basic workflow of creating a customizable logic circuit. The steps for creating
a circuit are described in the remainder of this section.

C o

Design a customizable logic
function circuit

D E————

Create the customizable
logic function circuit

Step number assignment

Write to the inverter or
keypad

{ (Refer to Section 2.3.3.9)

Debug
Online monitor

Realtime Trace

(Refer to Section 2.3.3.3)

Draw a logic

E(Refer to Section 2.3.3.7) function circuit

using the graphical
editor tool

| (Refer to Section 2.3.3.11)
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[1] Placing Customizable Logic Function Symbols

Select the desired symbols from the toolbox and drag & drop them in the layout area.

= -G Prj - Logic - C: - o x
T File Meru Setp  View Window Help -8 X
DZE &R /ORL FWxeRoWsse@IOa 2200003 25
Selact verter Nuambar of ua steps m’,‘ . "D"'I
[ Customizatis Logic o 00T =i | Wi | [ osipdai0sieos | o | | G| r;-_n-\ 2l IB: Il:»emlmm-mmlrﬂ | =
0 o] — E
3 Propct ‘CotmlogicPril’ =
123 Man »- -- B= =
Z) Progantd
Fg{;imm with the project) Branch
B - - - 4+
Comment
A
Theoueh
—3-0E
mp e
CHEEHT
o 13 et i =
T S —CEEEEE
e B OEED
| o

The execution order of customizable logic functions is determined by the order you placed them

in the layout area.
Refer to "2.3.3.7. Step Number Assignment" for details.

[2] Configuring Customizable Logic Function Symbols

To configure the signal selection, timer value, and other parameters of each symbol, use the
dialog you can open by selecting and double-clicking a symbol.

Alternatively, you can open this dialog by selecting and right-clicking a symbol and selecting

[Property] on the context menu.

1 Doesa Loader - G gic - i gic - CtmlogicPej1] - 0D x
L» File Merw Sep View Widm Heb - & x
DEE &R /ORI thxe@oa:se 02000003 RE
= - Salect Iwerter Number of use steps | mn? e .
[ Custamizatie Logic o e o e R LT = |&§ 4 | I:::'Lw:hln-wmlra | =
3 Frogramid | a
14 Froject CatmLogicPril 2 T
E"B"pm.w »—- -- = =
3 FE (lnchaded with the peoject) Branch
(21 FB (Common)
ol —
&l CE -— ==
Monitor select LS
Monitor Depelact A
) Theoueh
o — 5
TFHEHEHT
4 |+ Lol Jﬂ R
P e T 5 F—EHEEEEHE
— — 250
B AEEEEE,
4 | af”

The properties of the respective symbols are as follows.
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Chapter 2 Functional Description

- Properties of an Input Terminal

r Function code Signal name
The function code is displayed once| Displays the code and name of the configured signal.
the auto step number assignment
completes successfully.
x|
Fungtion code  Sienal name
Set Customizelogic Signal
(o] 4 I Cancel
+ button Signal code setting field and [SET] button
Click this button to open the list of available signals. You can specify a signal by entering its code.
2007 X1 > [ 9007 Hormal Cpen For information on what code you can enter,
x| ooz 2 ' B0t el Bler refer to the setting range for function code
4003 X3 3
o=t 4004 K4 D U02 and UO03.
0100: Nane 4005 35 N
0000 to 003001000 to 1030)  » 4010: FwD > =]
J_ 0031 to 00591031 ta 1059} » 11: REV b g’ . . .
D072 to ONAS(1072 t 1095} 0L INDI) » j . For details on signals, refer to "2.3.3.16. List
D101 to 0194110140 118 » ooy s f of Input Terminal Signal Codes".
4001 to 4033(5000 to 5033)  » 4023 13(D10Y y """
8000 to 8085 » 4024 (D10} » ﬂ-
9001 to 9007 » 4025 15(DI0)  »
=1 4026 6DI0) ) 3
3 02T IHDI0) 7
4028: 18(DIO) 3
4028: 19(DIO) » a’
4030: TIOCDIOY > 0
403100 » ﬂ- _'j
TS 1700 o R I
4033 113(DIOY 3 :

— [Set Customize Logic Signal]

This check box is enabled if you select a terminal input signal (number 40XX or 50XX).
Checking this check box allows you to write the "disable function" settings to the function codes for which you
configure the terminal function when writing to the inverter.

For example, when you are configuring an X1 terminal, you may want to write "100[NONE]" to the X1 terminal
function EO1.

@ e Once you have written the input terminal properties with the [Set Customize Logic
Signal] check box checked, you cannot restore the original terminal function by
re-writing the properties with the check box cleared. To restore the original
terminal function, use some other method such as editing the function code list in
the loader or using the keypad connected to the inverter.

@ e With the [Set Customize Logic Signal] check box checked, you cannot write the
properties to an analog input terminal (such as terminal 12). To disable the
analog input terminal function, set the related function codes (such as FO1 and
E61) by some other method such as editing the function code list in the loader or
using the keypad connected to the inverter.
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- Properties of an Output Terminal

In the [Output selection] area on the properties screen, configure the

customizable logic output signals 1 "CLO1" to 10 "CLO10" connected to the
internal step outputs.

In the [Function selection] area on the properties screen, configure the inverter signals
connected to the customizable logic output signals 1 "CLO1" to 10 "CLO10".

Hereinafter, a customizable logic output signal is referred to as a "CLO".

Output selection

CLO assignment

Displays the assigned CLO.

When you place an output terminal symbol, an
unused CLO is automatically assigned.

To change the assignment, use the '+ button.

Internal step output

Once the auto step number assignment
this
automatically populated with the step number.

completes  successfully,

— Function code

corresponding to that CLO.

Once you configure a CLO, this field is
automatically populated with the function code

field is

r + button

Select the desired CLO from the list.

You cannot select a CLO already
used by another output terminal.

To use a CLO already used by
another output terminal, temporarily
clear the selection of that CLO for that
output terminal.
Once you configure a CLO, [Fixed] is
automatically checked.

— Fixed

Output zelection:

’_Tll_r' ol

None

1:.CLo1
+ 2:CLo2
3:CLO3
4:CLO4
5:CLO5
6:CLO6
7:CLO7
8:CLO8
8:CLO9
10:CLO10

You can select whether to allow or
disallow the auto CLO assignment by
the auto step number assignment.

D . Allow the auto assignment
. Disallow the auto assignment

x|

Functiencode  Signal name.

Function selection: a1

—Digital Output

)\:;

SET

[T Set GLO signal to dieftal output terminal

-

— Analoe Output

[T Set GLO signal to andloe output terminal

-

o

Gancel |

Function selection

'— Function code

Once you configure a
CLO, this field is
automatically populated
with the corresponding
function code.

Digital output

Refer to the next page.

L Analog output

Refer to the next page.

Signal name

Displays the
and name of
inverter
connected to
CLO.

code
the
signal
the
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* button L Signal code setting field and
Select the [SET] button

desired signal You can specify a signal by
from the list. entering its code.

For information on what code you
can enter, refer to the setting
range for function code U81.
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Digital Output
[~ Set GLO zignal to digital output terminal

| I

Analog Cutput
[~ Set GLO signal to analog output terminal

| I

— Digital output

Select the digital output terminal (Y terminal) you want to connect to the CLO.
Checking this check box allows you to write the [CLO assignment] setting to the function code for which you
configure the terminal function when writing to the inverter.

Digital Cutput

. . . v Set GLO signal to digital output
(see the previous page) in the [Output selection] area and select ol = SR R e

For example, if you select CLO1 for the [CLO assignment] setting "
"E20:[Y1]" under [Digital output], you can write "111 [CLO1]" to E20

Analog output

Configure the analog output terminal connected to the CLO.

Checking this check box allows you to write the [CLO assignment] setting to the function code for which you
configure the terminal function when writing to the inverter.

For example, if you select CLO1 for the [CLO assignment] setting finalog Cutput

(see the previous page) in the [Output selection] area and select ¥ Set GLO signal to analog output t

"F31:[FM]" under [Analog output], you can write "111 [CLO1]" to F31.

e Once you have written the properties with the [Digital output] or [Analog output]
check box checked, you cannot restore the original terminal function by re-writing
the properties with the check box cleared. To restore the original terminal
function, use some other method such as editing the function code list in the
loader or using the keypad connected to the inverter.
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- Properties of a Link Terminal (output)

]

Number

Connect to: @ {1~ 2000

Comment:

0] 4 I Cancel

- Properties of a Link Terminal (input)

x|
Mumber
Connect from: {1 - 200)
Outy :
< ;1: i{
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Terminal number
Specify the number to identify the symbol.

The number must be unique to this
particular terminal.

Specifying a number already used by
another terminal would cause an error
during the auto step number assignment.
Comment

You can add a comment.

Your entered comment will be displayed
next to the symbol.

Terminal number

Specify the terminal number of the
connection source link terminal (output).

Output terminal selection

From the list, select the terminal number of
the connection source link terminal
(output).

The list displays the terminal numbers of
link terminals (output) existing in the layout
area along with comments.
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- Properties of a Function Block

a5

etc.
Step
— Step No. — Output
Once the auto step number assignment Once the auto step number assignment completes
completes successfully, this field is successfully, this field is automatically populated with the

automatically populated with the step number. | internal step outputs, such as "SO01".

The customizable logic steps will be executed
in the ascending order of step numbers.

Property x
Step Logic function
Step Mo, (1 ) ot o0 > .
&p N Lipu Function code

Once the auto step number assignment
completes successfully, this field is

Function code  Function name

Logic function: -
C_uAmn @021 AND + On Delay > | automatically populated with the function
. ! code.
Logic zelection
Trput 1: ® Mormal open () Mormal chee Function name
TPt (®) Mormal open () Normal clofe This field is populated with the block

selection code and the function block name.
For details on function blocks, refer to
Parameter:  |0.00 & Timer period(0.00 to 9990 sec) \ "2.3.3.18. List of Logic Symbols".

Parameter 1, Parameter 2
Each logic symbol represents a different
: function.
/ For example, the "AND + ON" delay logic

lets you specify the ON-delay time for
[Parameter 1].

Explanation:
[N11Dei 2Dieital [DUTIDigital
W For a Function Code logic, specify the

TOUT] = [N1] &ND [M2] function code type and the function code
number.

/ Link to the following parameter:

Set a link that the setting value of

Cancel parameter 1 or 2 refers to the user
setting/memory area (example: U121).

1] OM-delay time

Setting a link requires 1 step for each.

Description

Describes the functions of the logic symbol.

L—— Logical selection
Input 1, Input 2
These buttons are enabled for a logic symbol with digital input. Use them to specify the input terminal logic.
For example, this feature is useful when you want to input the logical inversion of an internal step output.

The following is an example of using a negative logic for input 1 in step 2.

Step 1 Stem 3 The contact symbols of - 1 ana M
ep
— —m— represent a positive logic and a negative logic,
& - I_..l t—— > | [— P i P 9 9 9
— —- ] =~ F— respectively.
AL+ 0n Delay —
OFR + On Celay
THG
TR a T/G
TP 2
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- Properties of a Comment

Property

/Qommem:

cotiment

I>_/|i

Ll_L

Gancel |

oF |
comment

Connect line

Monitar zelect

Cut
Gaopy

Monitor Deselect

Trace monitor zelect

Delete

StepMo. / Pric

ity zetting..

| Fant (M)

Property...

Caomment:

MS Sans Serif

o]

s =

Cancel |
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Comment

You can add a comment.

[Font]

To display the [Font] window, right-click
the comment symbol and select [Font] on
the context menu.

The [Font] window allows you to change
the font size for comments.

Your changes to the font size are applied
to all comments.

You can change the font size within the
range of 8 to 99.

If you specify a value smaller than 8, the
font size is set to 8; if you specify a value
greater than 99, it is set to 99.
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[3] Connecting Logics
To connect logics, select and right-click the symbol and select [Connect line] on the context menu.

B2 Doesa Loader - Customizable Logic - CstmLogicPr1 - [Customizable Logic - CstmLogicPrj1] - o x
> Fil Menu Setp View Window Help -8 x
DEd &R o XL tHxeEsDe s ENEA DD oo
T | Select Fwerter Humber of use steps : 'nnf Daial -
Customizable Logic [l T 0T =] - I o I Tawp 7 W atees T = .{.\ \_.J\ ] | |R(|e I!:ulnd Digital+Analog | FB | =
—I [ | a3ic ke -~
£ Programil |
= - Tt/ Duatput izl
- Project ‘CatmLogscFri! -
B3 Mo -»— - b= =
] Program0il " .
L) FE (inchided with the project) Branch
FB (Common}
I P (Gomme - 0 4
Comment
{l oy T
tor Deselect =
e monkr —&E—G—
o 50
Copy
Delste AND:
st/ ray saine CH—THEEHEHEHE
Froparty =5 _
4l | »f Ll L 2l on
Gl b | et oy ) o F—THEHEHEHTHE
. - EHEEHT m
HOR
ﬂ_ﬂ.. FLHS) j—l.‘l E-ILI
fl v

The connection line appears. Hover the mouse pointer on the red square at one end of the
connection line and move it to the symbol you want to connect while holding down the left
mouse button.

Pl p-————
-

Fl—E;!ﬂ -

- merrial *HE

Once the connection line is connected to the symbol, the square at one end of the connection

line changes from red to black.
F - R S S & _—
O ——— lal

When you release the left mouse button, the square at one end of the connection line changes
from a black square to a gray circle, indicating that the connection line is complete.

F""['-— & _—
”‘-—:I |i'1- L e
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[4] Creating a Function Block (FB)

To create a function block (FB), select and right-click [FB (Common)] from the tree and select
[New...] on the context menu.

The [New function block] dialog appears. Enter necessary information and click [OK].

= Project CstmLogicPil1’

‘E‘ Main
¢ beq 0 Program00
{7 FB (Included with the project)
|
New... I
Paste
FB SelectMode
FB SelectMode Stop
Import
T
New function block =f— Name

You can enter a name of your choice.

Hame: Fea
Mumber of Ihputs: Q |1 5 Number of inputs

Number f O _ Specify the number of inputs for the FB.
umber of Sutput < !] ? > Specify the exact number of signals you want

to use. You can also create a FB without input

(Explanatior:
= g J by specifying '0".
— Number of outputs
¢ Specify the number of outputs for the FB.
o Specify the exact number of signals you want
Ll _,l to use. You can also create a FB without output
S Z by specifying '0'.

8114 I Cancel |

. Description

You can enter any description you want.

Tip ¢ You can change these parameters even after you create the FB. To change them,
right-click the FB symbol or name under [FB (Common)] in the project management

window and select [Properties] on the context menu.

@ ¢ Be sure to specify the exact number of inputs/outputs you want to use.
The following example shows a FB symbol with the number of inputs set to 5 and
the number of outputs set to 2 placed in the layout area.

If the circuit that contains this FB symbol use four
inputs and one output only, and you perform the

il auto step number assignment, an error message
will appear indicating that the setting of the number
of input terminals differs from that in the actual logic
or that the setting of the number of output terminals
differs from that in the actual logic.

Tip e The input/output terminals for an FB are numbered 1, 2, ... from top to down.
In the above example, the terminals on the left side are numbered [Input1],
[Input2], ...[Input5] from top to down, and the terminals on the right side are
numbered [Outputl] and [Output2] from top to down.
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Select [FB001] (or a FB with your specified name) that appears in the tree and double-click it to
display the [FB001*FB (Common) edit*].

x Program (0

E Project ‘CstmLogicPrl1®

= Main

¢ T Program(0

] FB (Included with the project)
= FB [Comman)

B §ireo0]

W Program0G  FBOO1 °FB {Common) edt” §

= Project CTstmlLogicPr1*
EIE Main
L Program00

To edit the internal customizable logic functions of a new function block, do the following steps:
(1) Place input/output symbols in the layout area.
(2) Assign the required functions to the input/output symbols.

(3) Select the logic symbol from the toolbox, configure the logic, and connect the input/output
symbols.

An example is shown below.

To edit the input for the FB, select [Function block input] -> [Input1].

12 Doesa Loader - Customizable Logic - CstmLogicPrj1 - [Customizable Logic - CstmLogicPrj1]

- (=] X
D File Meru Setp View Window Halp -8 x
Ded 8Ro ORI P xe oo e DA D D 10333
C izable Lo, Shct varer Siscasloms ‘/ m: . “o.n:lm |fe —
Fommm o floCmwvi =] woie | vt i | [Tosien/200stens | tpiwe | e | Rk { fomws | minats e pei| =
Basic loex: ~
3 Programot FBO0I #FB (Common) edite |
Trout/Output -
-3 Project CatmbogicPrjl’ A =
843 Man B —an b= -
) Programod
(21 FB (rehuded with the project) : - Branch
23 F8 (Commen) [ = _t e
@) Feo01 2 H et —— +
Property 2 x|
Comment
Function code  Siensl name
— a B —1
i == G JJ A
t Customielogic Signal
0000 to 0030(1600 to 1630)  »
R ; 0031 to 005%1031 to 1059)  » __l Z}‘_|E"_I:‘
—] —1 0070 to 009%1070 10 1099)  »
0101 to 0194(1101 10 1194)  » |:} .
4001 to 40335000 10 5033)  »
6000 to 60077000 10 7007)  » =
1 ? =
” 1 el | 9001 to 900 » m[‘qm
Clear log | Execution cycle: 2 (ms) T Funstionblock gt .. ........ 1| I et l..... ; =
e = F—FIEEIEHEE
&
< | »
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To edit the output for the FB, select [Function block output] -> [Output1].

{2 Doesa Loader - Customizable Logic - CstmLegicPrj1 - [Customizable Logic - CstmLogicPr1)

- o x
o File M Sehp  Vew Windw Heb -8 x
DEEE&Re ORI PWxeRo@lSe BROR D200 D052
Salect Inverter Number of se steps IR s -
[ Gustomizabie Logic Fott T = _vie | oot | [omeprmmees _wowe | o | RIKQ| [r:;mll‘mmlmm-mm]m | =
L L -
: 3 Prosramid FBODI *FB (Common) eds | B
'__‘ Progect ‘CstmlogicPr) | =
523 Mam »- -- b= =
3] Programin -
(2 FB (hchuded with the joct) Jra—— H g
23 FB (Commen) ot e 1 I i::l Mﬂ: ¢
3] EEHI Property x|
Function code Fomment
Output sekction [ = [ = | )= e A

Function code  Signal name

Furction selectionr [ === | il =1 &—@—E_ﬁ

0100 Nore
Dl Ol B | 0ot waKIn0 o 103 » |E| Ijl
B 003210 BOSBI02 10 10580 » |
- 0060 1o B099(1060 to 1087) » —
. ey TR EHE
; . 4001 10 8049 » =
il | el | I~ Set GLO signal to analog output terminal j;H__HTHj.
Glear log | Execution cycle: 2 [ms] I I Function block. output » 1
|| Tiee Code |

rgpe 22 ssd I
—ot | _om | F—EHEEEEE
FHEEHSE E

Tip * You can select [Function block input] and [Function block output] on the FB edit tab
only.

When you are finished editing the FB, select and right-click [FB (Common)] from the tree and
select [Save] on the context menu.

12 Doesa Loader - Customizable Logic - CstmLogicPrj1 - [Customizable Logic - CstmLogicPrj1]

- (u] x
L Filk Meru Setp  View Window Heb - &%
Dl &@&Re ' OXS PhaedosWdyese B0 0803 005 E2F
[ Customizabee Logi Sl Hlvas 4% .q“.'m; y | m n;;vall.].mul DiitalsAnske | FE |
mi Ic ) &
Mot Mowt =] Wit | Moiter st [ 7 ; . |
Ostep / 200 steps | Update | o | C{ [Eormoes =
£ Programt FES01 «Fe(ﬁo-m)mﬂ =
3 Project TstmlogicPril’ = g e a
B Man -»— —-- - =
T Programid
{21 FB (rehuded with the praject) e - Suteut 1 Branch -
34 FB (Commen) ey ———a=g0
| — e _ _|_

Comment

A
— 3¢
— @
F—{EHIEHE
TEE |
F—FEFEEE
FEFEC
|

4| | » Ll |
chuh|imnhnmls?[m]
|| Typs Code | Message

@ [
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Chapter 2 Functional Description

Once you save an [FB (Common)], the FB symbol appears on the [FB] tab of the toolbox.

Tool box

7 x
Digital | Analoe | Digital+fnaloe
|FB =
Thput Output
- b | »—- -
Branch
1 1
T 1
Comment

FEB (Common)‘g

FEON

Tip

e Once you save an FB (Common), you can use the same FB in another project.

Return to the [Program00] sheet, select the FB symbol from the toolbox and drag & drop in the

layout area.

2 Doesa Loader - Customizable Logic - CstmLogicPr1 - [C

i1- - Legic - CstmLogicPrj1]

1]

- o x
T File Merw  Sebp  View Wndow Help -5 X
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3 Proeamll | FEON *F8 (Commen) adits |
2 Propeet 'CatmLogm:Pyj g || D
£ Main Al = —- » -
) Frogramtn
B-C)FB (rehded with theproject) | e, Brarch
34 FB (Common)
1] FBse1 O s o B _: . - +
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R+ On Culey. Comment
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L/ B SSEEEEEEEEEEEEEENEREEEmEEA~EE | | -
\ e
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Clear log | Execution cycle: 2 [ms] =3
Type Code Message
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Once you place "FB001_1" in the layout area, "FB001_1" is added to the project management
window. Select and double-click "FB001_1" to open the edit tab for "FB001_1".

% Program00 {FBO01_1 :

—Eu Main

i..Jf FBOD1

Tip

= Project CstmLogicPril’

L) Program00
== FB {Included with the project)

------ r; FB00T_1!
= FB (Commony™ ~

"FB0O01_1"is an FB that belongs to the project and therefore is handled
separately from FB (Common) "FB001". Changes made to either of the two FBs
will not be automatically reflected to the other.

You can check the circuit you edited with the auto step humber assignment.
For more information on the auto step number assignment, refer to "2.3.3.7. Step
Number Assignment”.

The function blocks (FBs) under [FB (Common)] are not checked by the auto step

number assignment. To check the function blocks (FBs) under [FB (Common)],
you should add them to the project.
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Chapter 2 Functional Description

2.3.3.4. Precautions to Take when Creating a Circuit

[1] Timer Time
A circuit that uses a timer does not operate exactly according to the timer time setting if:

The timer time setting is smaller than the execution cycle

The timer time will become equal to the execution cycle if the timer time setting is smaller than
the execution cycle.

Example: If the execution cycle is 20 ms, the timer time setting of 0.01 s is changed to 0.02 s
when the circuit operates.

The timer time setting is not equal to a multiple of the execution cycle

The timer time will be rounded up to the next multiple of the execution cycle if the timer time
setting is not equal to a multiple of the execution cycle.

Example: If the execution cycle is 20 ms, the timer time settings of 0.03 s and 0.05 s are
changed to 0.04 s and 0.06 s when the circuit operates.

[2] "CLC" and "CLTC" Functions of General-purpose Input Terminals

The "CLC" and "CLTC" of a general-purpose input signal are signals for customizable logic.
"CLC" : Allows you to stop the customizable logic circuit operation.
"CLTC" : Allows you to clear all the customizable logic timers.

However, you cannot set "CLC" or "CLTC" (E01=80, 81) in the [Function selection] area on the
editor screen.

To configure these functions, use some other method such as editing the function code list in
the loader or using the keypad connected to the inverter.

[3] Circuit Read From the Inverter
The editor screen cannot display a circuit read from the inverter.

However, you can load a circuit as a function code by selecting [Function code edit...] -> [Read
from the inverter] from the Quick Access menu (or, for some models, checking the [Open the
customizable logic setting screen] check box).

[4] Function Block 3001: conversion 1, 3002: conversion 2
To write a circuit to the keypad and then write it to the inverter using the keypad's copy function,
use [Manually set the conversion coefficient].

The [Auto calculate the conversion coefficient] setting is ignored by the keypad's copy function.
Even if you set it, you cannot write the circuit to the inverter.

When you write the circuit directly from the loader to the inverter, you can use either [Manually
set the conversion coefficient] or [Auto calculate the conversion coefficient].
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2.3.3.5.

Useful Features

[1] Undo/redo

You can select the undo or redo command from the right-click menu of the layout area.

I -
M-

Paszte

[Inda
Feda

\J

¥

sy

—

A+ 0On Delay

TG
TF 2

' 551

Undo

You can undo up to 3 previous layout changes such as

moving and deleting a symbol or connection line.
You can also use [Ctrl] + [Z].
You cannot undo changes to the properties.

[2] Copy/paste

T -

—

Conrect line

Monitor select
Monitor Deselect

Trace monitor select

Cut

Copy

Delete
StepMo. /£ Priority setting...
Fant (M}

Property ..
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Redo

You can redo the last action. You can also use [Ctrl] + [Y].

You can select the copy command from the
right-click menu of a symbol. You can also
use [Ctrl] + [C].

You can select the paste command from the
right-click menu of the layout area (rather
than a symbol). You can also use [Ctrl] + [V].
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[3] Range Selection

You can select a range by dragging the mouse pointer in the layout area while holding down the
left or right mouse button.

Once you release the mouse button, the symbol(s) in the range is selected.

FWo

BB
i}

&L= £

|- =
— -

AD + On Delay

1

T/G
TP 2

Tip e You can select all the symbols by pressing [Ctrl] + [A].
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[4] Symbol Search

The [Symbol search] feature allows you to search for a symbol in the layout area.

Click the [Symbol search] icon on the toolbar.

The [Search] dialog appears.
Search

™ \Step number (1)

x|

Gonditon e

Pres: |

Condition
Combo box

Enter the search keyword.

[ logic name (2)

[ logic number (3)

[ InA0ut terminal number (4) Check boxes

[T h/Out sienal name {5) Use these check boxes to specify the search
[ Link terminal (froms/to) (&) conditions.

[~ JGomment (T} o Itl‘eyoot:? :r;eck two or more check boxes, they will

—Search results

Mo. |

Froeram name Search result

Once you select at least one check box, the
[Next], [Prev], and [Search] buttons are enabled.

Search results
The search results are displayed.

When you double-click one of the search results,
the focus moves to the matching symbol.

The following is an example of searching for symbols that use an X terminal as an input terminal.

Conditior: |}{

[ Step number (11

" Logic name (2

[ Logic number (3

[T Ih/Out terminal number ()
V¥ In/Out zignal name (&)

[T Link terminal {from/ta) {6}
[~ Gomment {7

X

j Mext |
Frew |

Search |

Search results

R = Frogram name Search result

Programin 4001: 31

&

Out-Freql

Double-clicking one of the search results moves the

focus to the matching symbol.
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Chapter 2 Functional Description

2.3.3.6. Settings for the User Setting Area and the Memory Area

You can use function codes U121- and U171- as you want.

You can use these function codes as analog inputs by reading them with the function code read
logic.

For example, when you want to double the input of terminal 12, you can use function code U121
by setting it to the constant of 2.00 as shown below.

Step 2 434
Al-[12] H . n
PA x ] N oL
. -_— — o~ ;.
StEp 1 h"i.l|‘ti|:l|'l.l'
Read UL o100
L0

-

To use function codes U121- and U171-, click the [User parameter/Customizable logic storage
area setting] icon on the toolbar.

The [User parameter/storage area, input/output and logic] window appears.

— Logic version

Clicking the [Read from the inverter] button on the [User parameter/storage] tab displays the settings of function codes
U197 and U199 read from the inverter.

User parameter / storage area, input f output and logic

Logic “Wersion: I I
—Q_Iser parameter & storage | Thput # Ou .@

‘ Inverter setting valus You can view the list of the settings
{before initialization]
for each step.

Logic check

Function code name

Customizable logic (ser parameter 1) onn

Customizable logic (User parameter 2

t2s Customizable logic (User parameter 3) n.an

124 Custamizable logic (User parameter 4) ono

— User setting area — Input/output check

- Customizable logic storage area You can view the list of the settings of input and output terminals.

You can edit function codes U121- and U171-.
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Open the [User parameter/storage] tab.

— Inverter settings before initialization
You can configure the settings of function codes U121- and U171-.

If you open this window by clicking [User parameter/Customizable logic storage area setting] on the toolbar, '0.00'
appears.

If you click [Write] or [Write to the inverter] and have this window automatically displayed upon completion of write, the
settings read from the inverter before write appear.

User parameter / storage area. input / output and logic x|
Logic Version: I

{User parameter 7 storaee | nput / Output | Loeic |

[ I @ Ihverter setting value

L FLACTION £O02 Rate: (before initialization)
w121 Gustomizable logic (User parameter 1) 000
U122 Customizable logic (User parameter 2) 000
U123 |Customizsble logic {Llser parsmeter 3) 000
U124 |Gustomizable logic (User parameter 4) 0.00
u12s Customizable logic (User parameter §) 0.00
U126 Gustomizable logic (User parameter §) 0.00
ez Customizable logic (User parameter 7) 000
U128 |Customizable logic (User parameter ) 000
U129 |Customizsble logic {Llser parsmeter 4) 000
U130 |Gustomizable logic (User parameter 10) 0.00
Uiz Gustomizable logic (User parameter 11) 0.00
[k Customizable logic (User parameter 12) 0.00

U133 |Gustomizable logic (User paramster 13 000
oon
0o
0o
U137 |Gustomizable logic (User parameter 17) 000

U134 |Customizahls logic (User parameter 14

u13s Gustomizable logic (User parameter 15

)
)
)
)

U136 |Customizable logic (User parameter 16

U138 |Gustomizable logic (User parameter 18) 000

U138 |Gustomizable logic (User paramster 19) 000

Write to the inverter

1140 Gustomizable losic (User parameter 20) 000

(Write to the keypad)
m Wirite to the Inverter

Save param file... Load param file.

Write the settings of function codes
o | 4 U121- and U171- to the inverter or
keypad.
Save param file — Load param file — Read from the inverter (Read from the keypad)
Click this button to save Click this button to load a Click this button to read the settings from the inverter or
the settings to a CSV file.  saved setting file. keypad.

Configure necessary settings in the [Inverter setting value (before initialization)] column.
When you finish configuring the settings, save the parameters by clicking [Save param file].

@ e Once you close the [User parameter/storage area, input/output and logic] window
without saving the settings, they are lost and will not be restored the next time
you open the window. Whenever you want to save the settings, be sure to click
[Save param file].

Before writing to the inverter, check that the inverter can operate safely if function codes U121-
and U171- are written to it.

@ ¢ You can write function codes U121- and U171- while the inverter is operating and
while the customizable logic function is starting but the inverter may exhibit
unexpected behavior, which can be very dangerous.

If you cannot ensure the safety, stop the inverter and the customizable logic
function before the write.

Tip e The [User parameter/storage] tab is not available with inverters that do not have
function codes U121- and U171-.
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Chapter 2 Functional Description

2.3.3.7.

Step Number Assignment

Once you created a customizable logic function circuit, you have to assign step numbers to the
respective symbols and FBs. There are three methods of assignment.

Tip
numbers.

¢ The customizable logic functions are executed in the ascending order of step

Assignment method 1: Auto step number assignment (function check)

Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number
assignment and circuit check.

- —*

# oDoo

If no error is detected as the result of the circuit check, step numbers are assigned.

B Doesa Loader - G - CatmlogicPr1 - [C Logic - CetriogicPrj1] _ o *
D Filk Meu Setp View Wrdmw Heb . & x
DEEdSRo /OXL tWxedos@sse @023 20330
[ComrmE g Select wvertar Humber of ute staps p ‘”f D"'u'i -

a0 Lage Mo Il DNV =] Wit | Boriiior st [step /200 steps Lpste | aid | 'C!'\ = |;° LMID'M'M]FE I o
55 logic =
£ FProesmtd | =
'3 Praject CatmlogicPr T & o
B/ Mo -— —-- b= =
TT] Programd
2 FB (nchaded with the project) H Branch
2 FB {Commen) :
5] Feont T —— {8 - —_ - ==
Y —.— L
WD+ On Duiey Commant
w A
Thecueh
AND
1 12 Lad | v EEJ ||j.|
Cloar log. | Execution cycle: #* [ms] g3 OR
T e = E—EHEHEEHEHE
130 tormaton 2017-09-25 131255 Loase chack end._Eroc), Wampa
1 4 nformation | [2017-08-25 131255 The allotment of the hurction code was started | m
i 4 linformation 2017-09-75 131256 The allotment af the hunction code was fmished.
= 5
Step numbers are assigned even if a warning occurs.

12 Doesa Loader - € Logic - CstmlogicPg1 - [G Logic - CstmlogicPr1) - o x
o File Mens Sehp View Windom Hel & x
DFE SR o OXRL P xe@oPe o @HORE 280120 E
(A | Selsct bverter Hanber of use steps = uwf === —

ustomizable Logic e T 00T =] Wie | it | [ ieen /s | wane | o | LS | ]B': [ owee | it ewie | B | 5
sic logc -
E] Promsst | =
3 Froject GatmlogicPril B M
B3 Main _J -»— —-a- - =q
Z) Programil)
1 FB (i haded with the project} Branch
(24 FB (Commen)
] FeD1 — -_ +
Comemant
W, A
Treoueh
T OEEE0OE
u it oo CHEREHDE
Clear og | Exerntion oyck: 2 ) B
T Fiacsoe o E—TEHEEHEHEHE
£ 1) [Iformation 2017-09-25 131288 Logic check start
T R AT T T T "
] i) [Fformation 2017-05-25 1317:38 Logic check end. Errorl) , Warning | IS
% 4 [formation | [2017-95-25 131735 The sllstment of the furction code was staried i =
Todd b 4 0l o i3S LAAL 3% e, adion, b ol dbe Sixed e, Smiskhed - 4‘
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If any error is detected as the result of the circuit check, step numbers are not assigned.

2 Doesa Loas Logic - CatlogicPg1 - (G Logic - CstmbogicPr1] - o x
T Eie Menu St View Windw Heb -8 x
Ded&dlhe  OXRL THKedoWe s e @008 220 5 230538
AT e e i ST lﬁ&_‘d
il L Mo Il NINVI =] White | Biomitor st Totep/ t0hstaps  Updste | aid | Q| (T{| | B | | et | PR
[Basic koeic =l
£ FProesmtd | =
3 Project ‘CatmLogaPrl’ = 1
B Mam - —--
LT] Program0d - . = =
23 FB (nchuded with the project) : i Branch
2 FB (Cammon) -
gy fE —4
1] Feool o — n n — —_1 +
WD+ On Dy Commant
w A
—=3—5—=C
AND
" | Frasois oo CHEHEHT
Clear e | Execution cyche ** [ms] g R
S — S P EOEEE
L) | Informaton 2007-09-25 132139 Logs: check start
I | 0100 [The bnpuit 2 of AND + O Delay is discorrected | m
[Wernne | 0100 |The Output 1 of AND + On Delsy s disconnected. I
| The Igut 1 od Qutpt i disconnected | ﬂ"“‘ :zﬁl

If this is the case, you can double-click the warning or error message displayed in the output
window to jump to the symbol in which the error occurred.

T Doesa Loack ,. gic - CstmiogicPr1 - (G CatmlogicPn1) = o x
D Eile Meou Jetp View Window Heb -8 |
DEE &SRO /OX L tw eI @O 30D 0 0035 33 |
[ Customizatie Logic foscea SUise st i +|o””’ 3 Bi‘t"nd'liimuln’ itate Aoake | F8 | l
e > =) e
[T DT =] Wene Viontor £t [ Vetep/200st0 Update | Grid | S ‘ - oo e -
%} Programd | = =
=3 Project CatmlogicPril’ - =
23 Mo
=] -i:lmg.mao - —-a-. b= =
(21 FB (nchuded with the project) Branch
&3 7B (omad
&) Feont o———=L & [ : c = T t
[ & R~ Sl
— == s ;
%, A
—{o—G—1a
F—EEHDE
K1 | 3 Jj K S ﬂ’l EEE@
Clear g | Execution cycle =% [ms] D R
i o F—THEHEEHERE
Information |2017-89-25 132139 Logic check start
O e | 0100 [The kgut 2 of AND + On Delay_is desconnacted ] m
300 - T A O D = 4
jhd [ E—| i
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Chapter 2 Functional Description

- Rules of auto step number assignment

The rules of the auto step number assignment to customizable logic function symbols are

as follows:

(1) The step numbers are assigned in the ascending order from top to down in the layout area.

(2) If two or more symbols are at the same height in the layout area, they are assigned step
numbers in the ascending order from left to right.

= Doesa Loader - G i Logic - CstmlogicPrj1 - [Cy i Logic - CatmlogicPrj1] - (u]
L Elle Meru Sehp  View Window Heb -GK.
DEE &R /OXL ¢MxeEoWs s E0ER 0D 00033

= Select nverter Mumber of use steps - LE] - -

Customizable Logic [ 1 oo el MR e vv T | i | it | _.\_L\ '\._.J\ | ;)B:;tzll‘m:hlnuuhmmlra | =
3 Project ‘Cstmlogx:Prjl = P’“"‘"‘"” = Input/Output =
TS e Smaller step numbers I:> Larger step numbers »- -a P

(23 FE (Inchuded with the project) Branch
3 FE (Common)

] Feonl (1) (2) (3) —_ . =4

Comment
4) A
Theough
®) (6) —E——
—E=—C3
(7) AND
Larger step numbers C—CHEEHEE
oo CHEHEHT
1] | ¥ Ll | ¥
Clear kog | Exacution cycle: ** [ms) x ) _
T 0w o F—EEEEEE
FHEEHDT
Fig -
An example is shown below.
Step 1 RITLBLPIEEN
1 P Slep2i(2 Step 3
il- E (1) ....2..1....() I 3) o
- = -| I
: OR Fise Edee

x3 - OR
xd -

Step § (5) Step 6 (6)

1 S -
wE : R Q FS 4 _H_r ——— = e

SR-FF Eath Edee + Off Delay
Step 7 (7) ?(PO 9
L I'H_I -~ 5
Thmush+0$e§v
T/C
TF 0

In the above example, the XOR circuit is assigned Step 4, and the OR circuit Step 2.
As the result, the output of Step 4 is connected to the input of Step 2

In this case, the output of Step 4 is input to Step 2 in the next execution cycle.

Execution cycle | Execution order

Current cycle | (1) ->(2) -> (3) -> (4) -> (5) -> (6) -> (7)

/Output of Step 4

Next cycle | (1) -> (2) -> (3) -> (4) -> (5) -> (6) -> (7)

To input the output of the XOR circuit to the OR circuit in the same execution cycle as the
OR circuit, adjust the positions of the symbols.
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The following example shows the result of moving down (2), (3), (6), and (7) shown on the
previous page and then performing the auto step number assignment again.

Step 1

-—{ 8
X -
D
Step X (reiasnain, .
prOnTe 3 : Step 3 Step 4
3 - = '21
* - = 4 -] !
oR
Step § XOR ORUR Fize Edge
1
- 5
* - R
SR-FF
Step B
-
FS 4 [l e ——— | D
—
Both Edege + Off Delay
Step 7 ?;O 3
1 [ -— so1
- = } -
__m
Throueh + On Delay
T/C
TP 0

Now the XOR circuit and the OR circuit are assigned Step 2 and Step 3, respectively.
This means that the output of the XOR circuit is input to the OR circuit in the same
execution cycle as the OR circuit.
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Chapter 2 Functional Description

Assignment method 2: Manual step number assignment

You can opt to manually assign step numbers.

To do so, select and right-click a customizable logic function symbol and select [Step

No./Priority setting] on the context menu.

& Doesa Loader - Customizable Logic - CtmLogicPrj1 - [Customizable Logic - CstmLogicP1]

= (=] b3
o Fie Mo Setip View Windw Help . & x
DSHSRe /OXL PHxedosPdase PRG3R0 00 00325
Select Ivester Mumber of use steps :’ 100% — REHF
[Customizase Logic CEETI | fe || Moritor etart I [ Oetn /200 stepe_ Update | @ | '\'!'{ 'C( I [:'“'I“'c':: w|ee | 5
A5 -
£ Programd | e
3 Project TotmbogicPrl’ | Feut/Output
B Main »— -
) Froeranto ol —cemmmmmn L] ' =3 - ==
3 FB (Inchuded mith the projct) O~ - Brarch
23 FE (Common) T+ On Do
E FBoot e —_ -4 4
TP' " Comment
g Function Code
2 -
Connect e
Monitor select -(Lm
Maeitor Deselect
Trace monitor select
Cut
1| | ¥ L2l Copy ,r‘
Cloar kg | Execution cycle: #+ [ms] i i )
Epee| Ncos T B L AL UL S
Propesty
Specify your desired step number.
B Doesa Loader - C Legic - C i1 - [C Logic - Cats iePej1] - o x
D Fik Meu Sehp Vew Widow Heb 5 x
DR &R /OR L PwMxeRoWe s @ERES 22D 0003 3AR
00X &
Select verter Humbser of use steps —
S i Digitat+Arabog
Customizatle Logic [T Toen x| IR e e e Wz (| e :-R ;_{ [ lnrmuu;:: icitabfealoe. |[FB | 5
A -
3 Proeramdl | e
=3 Project CatmlogicPril 2| etOutet
B3 Main - - P -]
[Z) Programilil ’: - “ '
FB (inchuded with the project) IEEmmr
Vot o bl vty / Step Ho. satting = Errch
5] FBO0! —_— = =
_H,G f Stepho. sssiered automatically : [
Col
~User Acsien et
s, | GG A
M-m:; - -I i — il Code
[ e I I ERN I e e e ey
W Trctin cote ~ Prioity | :]_
I =]
T
(o] Fomwi | ]
e [y v
Glear log. | Execution cyche: 22 [ms] %]
Tyoe Code Message

Click the [Step No. automatic allotment] icon on the toolbar to check the edited circuits.

assigned a step number.

¢ You have to perform the auto step number assignment even if you have manually

Without performing the auto step number assignment, you cannot write to the

inverter.
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¢ If the inverter is one in which the execution cycle depends on the maximum step
number and you specify a larger step number, the execution cycle will follow the

specified step number even if you use one step only.

Assignment method 3: Step number priority setting

You can specify the priorities applied when automatically assigning step numbers.

To do so, select and right-click a customizable logic function symbol and select [Step
No./Priority setting] on the context menu.

1 Doesa Loader - Customizable Logic - CstmLogicPrj1 - [Customizable Logic - CatmLogicPr1]

Clear log | Execistion cycle: ** [me]
Tvpe Code

= (=] x
D Filk Mew Setp  View Window Heb -8 x
D@ &R /OXL W xeRowLse AR R0 Q20338 i
T Seloct Fwerter Nmber of us stops q._'"":_. — = ;IIM Dighaedesos |8 |
L ) — g ial
| N e e [ Osten /200 steps Update Grid NS |
- s tpaun | | o | [Fumction Code =]
L) Frguit/ Chatpust
‘= Project CaimLogicPrT" -
B3 Man - -
7) Progants ™ . . = =
3 FB (hchided with the project) LU T —— hAmS Ery
3 FE (Commen) O+ On Dy
) FBo0) ) —_ - =4
¥ o Gomment
Sup2 A
- : TEE R Furtion Gode
b R | B=
un £ H o
: I Menitor select |
HE et Manitor Desslect |
H Trace monitor select
4] 1 Ll 1 ﬁ
. &3
el

— St / iy satioe___ 2

Froperty.

Specify your desired priority by entering a number equal to or greater than 1. The smaller the
number, the higher the priority and the smaller the step number assigned.

1 Doesa Loader - Customizable Logic - CstmLogicPrj1 - [Customizable Logic - CatmLogicPr1]

= o x
o Eilb Meuw Setp  View Window Heb "o
DEE &SRO /ORL M xe@oWe 0O 250600523 .
Customiatie Logic Saloct Inverter sl ;-m:".' ST DiitalsAnalog |
e e o —
x|

‘= Project CaimLogicPrT" Al
B-53 Main
[Z) Progranid [ T

[ = =
20 FB (hnchuded with the project)

T
M n
24 FE (Gommen)

WO On owwr x|
| Feonl I
4 TG Stepho. assigned sutomatically [ T
F o0
User Assien
Step 2 [ Stepho.
(R -
o Code
e —1"]
WHIRE Snchon o gsssssssssssssns . =

um

: n...“ Trctin cote || % When sssining a step rumber, a “stepho”
: I | and “priety” can be specified

J N e ; s
4 *
Cloar kg | Execution cycle #* [ms]

%]
Type | Code Wessage
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Chapter 2 Functional Description

Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number

assignment.

§ &
EEES LE B f RHEE S =
: g 1 » ooo
1 Doesa Loadk Logic - CetmiogicPr1 - [C gic - CatmLogicPr1] - o x
L File Mo Setip Yiew Window Help - 8%
Ded ke  OXRS T yedosWle s @008 33030053
[ Customizatie Logic Bebod b of use stepe |+‘I 5 nuu;lm Digital+Analoe |FB |
[He- 1T T White Hateps / 200 Update : =
- E= L —I LI [Function Gode =]
E3  Programid |
‘3 Project ‘CstmLogicPriT Siep 3 = = =
B4 Mam -»—- --
(5] Proeramtl "‘-.—'_ -
3 FB (inchuded with the project) 5 . = Branch
A FB (Commen) RO+ On Doy
=] FROni e —_ -1 =4
TP Comment ———————————
sup2 A
M E—e———o Function Cods
e i
o - —11 =
Step 1
uin
[— -
Rewdrag hrsotion code
Ui
-
Kl I el | _'l_l
Clear log | Execution cycle #% [ms] [x]
|1 Twe | Code | Meszage -
| 4 [ntormation | 20178325 182053 Loic check end. ‘Ermor), Wornine |
| 4 itormation | |2017-83-25 182053 The allotment of the function code was started
| 3 Intcemation 2017-03-25 182053 The allotment of the hnction code was finished.

The above three step number assignment methods are prioritized as follows:
Auto assignment < priority setting < manual step number assignment

To check the step number assignment

The step number assignment screen allows you to view and

StepMo. assien setting [Gustomizable logic — CstmLoeicPrjll
tihen use the Automatic allotment function, The StepMo. will be allocated order of [Top to Bottom] and [Left to Right] by every program.

#ind you can change the Automatic allotment function's allocate order by manually as following the order of priarity
fzsign 1and 2 in window, and push [Auto Layout] button

1 Assigned stepho_by uss, dssigned stephla. by user fixed check

9. fiseigned priority by user setting

3. Display location (Top to Bottam, Left to Right)

Information : Order of line connection will not considered in automatic allotment

If backeround color is eray. which is invalid data.

change the assignment status.

=1oix|

All fized setting is tuned OFF. |

o | Tpe onte | PEE | g lemSete | Reed
ixed
3 PG Program00
2 AND + On Delay 3 r
3 iiting function code 2 = 2
4 Reading function code 1 r 1

|The used number of steps: 3 (The number of the reserved Steps:0) / The number of steps which can be used : 200

Automatic allatment

execution

Get user-defined [Order of priority, StepNo]
information from layout information

Close
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2.3.3.8.

Circuit Check

You can view the lists of the input/output terminal properties and the settings for each step.

Click the [User parameter/Customizable logic storage area setting] icon on the toolbar.

The [User parameter/storage area, input/output and logic] window appears.

Tip

¢ A limited set of functions is available with some inverter models. Refer to

"1.1.2Loader Functions by VF1A Series Inverter Model" for details.

[1] Input/output Check

To view the list of the input/output terminal properties, open the [Input/Output] tab.

User parameter / storage area. input / output and logic

_

User parameter / storaze  Iput / Qutput | Logic I

Logic Wersion:

—Ihput terminal

Output terminal

x|

Bezcription

GLO0

4010 FWD Normal Oper
4001: 1 Mormal Open

8000 Out-Freql
4003 X3 Mor pen

Allocation

| Exclusive | Terminal | Description

number

nnon Mo = ormal Open

( Save G5V file | )

Close
Gl | y

Input terminal
Allocation number

Shows the signal code of the input terminal.
Exclusive

Displays [Yes] if the [Set Customize Logic Signal]
check box is checked on the input terminal properties
window.

Terminal

Displays the function code assigned to the terminal
function if [Exclusive] is [Yes]. You can write the
"disable function" setting to this function code when
writing to the inverter.

Description

Displays the assigned number and signal name.
This signal name is the same as shown on the input

terminal properties screen.
[Save CSV file]

Click this button to save the displayed information to
a CSV file.
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Output terminal —
Name

Displays customizable logic output signals 1 "CLO1" to
10 "CLO10".

Allocation number

Displays the inverter signal codes connected to
customizable logic output signals 1 "CLO1" to 10
"CLO10".
Exclusive

Displays [Yes] if the [Output terminal digital] or [Output
terminal analog] check box is checked on the output
terminal properties window.

Terminal
Displays the function code assigned to the terminal
function if [Exclusive] is [Yes]. You can write customizable

logic output signals 1 "CLO1" to 10 "CLO10" to this
function code when writing to the inverter.

Description

Displays the assigned number and signal name. This
signal name is the same as shown on the output terminal
properties screen.



Chapter 2 Functional Description

[2] Logic Check
To view the list of the settings for each step, open the [Logic] tab.

Logic Wersion: I:I I:I

User parameter / storage  Input / Qutput

Logic

Funz Name

Wit iI'IE functic

Reading function code

hl D+ On Delay

Sawe C5Y file.. <| Convert to [Func Gode Edit]... )I
I: Cloze
— Step No. In1, In2
Displays the step number. Displays the signal code of the input terminal
connected to the logic symbol.
Func Name For information on what code you can enter,
refer to the setting range for function code U02
Displays the function block name. and U03.
Func Prm1, Prm2
Displays the block selection code. Displays the [Parameter 1] and [Parameter 2] settingg

For information on this code, refer to the setting on the logic symbol properties window (or the function
range for function code UO1 or "2.3.3.18. List of code type and the function code number).
Logic Symbols".

—— [Save CSV file] Convert to [Func Code Edit]

Click this button to save the displayed information to  Converts and displays the listed contents in the
a CSV file. "Function Code Edit" window.
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2.3.3.9. Write

Your edited circuits are assigned step numbers and converted to the inverter function code
settings when the function check completes successfully.
Once the conversion completes successfully, the [Write] button is enabled.

[1] To Write to the Inverter
To register these settings in the inverter, check that the inverter is stopped and then click the
[Write] button or the [Write to the inverter] icon on the toolbar.

FEES S8 B I HDE S =

Click [OK] to start the write operation.
Doesa Loader X
Do you initialize the function code in an inverter and stop

! customizable logic.
And write in the function code preset value of customizable logic?

Cancel |

@ ¢ The write operation fails while the inverter is running. Stop the inverter and then
perform the write operation.

e If you stop the customizable logic function while the inverter is running, an "ECL:
Customizable logic error" alarm occurs.

e The write operation may fail with an inverter that has password protection
enabled. If this is the case, you should disable password protection to perform the
write operation. For more information on password protection, refer to the
instruction manual or user's manual of your inverter.
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Chapter 2 Functional Description

Upon completion of write, you are presented with a dialog that prompts you to confirm the write
operation to the user setting and customizable logic memory area (function codes U121- and
u171-).

Doesa Loader X ‘

Is setting values of "User parameter and Customizable logic
storage area” written in the inverter?

Cancel I

At this time, the settings of function codes U121- and U171- in the inverter have been initialized
to 0.

Click [OK] if you want to restore the setting of function codes U121- and U171- in the inverter.
Click [Cancel] if you do not use function codes U121- and U171- or you accept the settings of 0.

When you want to write new settings to function codes U121- and U171-, click [Cancel] and,
upon completion of write, perform the write operation from the [User parameter/storage area,
input/output and logic] window.
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[2] To write to the Keypad

If you have selected [Data in Keypad (in VF1A-PH1)] for [USB Connection] on the
[Communication Setting] window, you can write your edited circuits to the VF1A-PH1 remote
keypad with USB. In this case, the write operation to the inverter uses the keypad's copy
function.

Use the copy DPoesa VF1A series

function Inverter
Write edited Bring the to perform
PC circuits keypad to the write
the field operation

VFD
Doesal.oader

Remote Keypad

Figure 2-1  Workflow of writing circuits to a keypad
Preparation

The write operation through the keypad's copy function writes, not only the customizable logic
related function code data, but also all other function code data (such as F codes, E codes, and
C codes) to the inverter. Therefore, you should write the function code data other than related to
the customizable logic to the keypad in advance.

To write the function code data to the keypad, use one of the following two methods:

(1) Read the function code setting data from the target inverter to the keypad using the copy
function. (As needed, read the data from the keypad to the loader and write the data back to
the keypad after editing the data in the loader.)

Doesa VF1A series
Inverter

Read the function
code settings
from the keypad.

Save the data
Doesa Loader )
to a file.

As needed, edit the data in the
[Function code edit] window
and write the F, E, and C code
and other data to the keypad.

PC

Read the data from
the target inverter
using the copy
function.

Tip e When you read data from the keypad to the loader for backup or similar purposes
and work with the inverter that has the customizable logic function codes, be sure to
save both the list of basic function codes (such as F, E, C) and the list of the
customizable logic function codes.

2-82



Chapter 2 Functional Description

(2) From the loader to the keypad,
write the function code setting data
for the target inverter you have

created from scratch or loaded VFD |:>
from a saved file. Doesa Loader

From the [Function code edit]
window, write the F, E, and C
code and other data.

Remote Keypad
PC

Tip ¢ To the inverter that has the customizable logic function codes, write the list of basic
function codes (such as F, E, C). In this case, you do not have to write the list of the
customizable logic function codes. The customizable logic function codes are written
from the customizable logic editor screen.

The workflow of the preparation is shown below:

START
[Prepare the function code data in the loader]
[Read the function code
data from the inverter]
From the target inverter to the keypad Loader
Read the function code setting data into Create the function code setting data for
the keypad, using the copy function the target inverter from scratch or load it
from a saved file
[Data backup or edit is
required] From the keypad to the loader
Read the function code setting
[Data backup or edit data into the loader
is not required]
Loader
Edit and save the function code setting
data
From the loader to the keypad
Write the function code setting data (such
L as F, E, and C codes) to the keypad
END
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Write the edited circuits to the keypad

Click the [Write] button or the [Write to the keypad] icon on the toolbar

Read the precautions displayed on the dialog box that appears.

x

l ) Maotes about write to kevpad.
N

If thiz project's voltage, capacity and verzion informations are different fram the inverter

which iz trying to write, May occurs "GPEr™ warning when write to the inverter fram the keypad.
In this case, press the " PRGARESET © key and wou can continue weiting.

In addition, pleaze check the zettingz after complete writing.

ifrite =tart I Change information.. Cancel

Click [Change information] to open the project properties window.

Correctly configure the model, regional specification, voltage, capacity, and inverter ROM
version according to the target inverter. For more information, refer to "2.3.3.12. Project
Properties".

@ ¢ If the model, regional specification, voltage, capacity, and inverter ROM version
are not correctly configured, the write operation from the keypad to the inverter
may fail with a [CPEr] warning or error displayed.

Click [Write start] to open the following dialog.
Click [OK] to start the write operation.

| Doesa Loader X

and the selected model of this project are different.

o The data in the keypad is initialized, If the model stored in the keypad
Would you write the setting values of customizable logic?

Cancel

Upon completion of write, you are presented with a dialog that prompts you to confirm the write
operation to the user setting and customizable logic memory area (function codes U121- and
u171-).
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Chapter 2 Functional Description

Doesa Loader X

Is setting values of "User parameter and Customizable logic
storage area” written in the keypad?

Cancel I

At this time, the settings of function codes U121- and U171- in the keypad have been initialized
to 0.

Click [OK] if you want to restore the setting of function codes U121- and U171- in the keypad.
Click [Cancel] if you do not use function codes U121- and U171- or you accept the settings of 0.

When you want to write new settings to function codes U121- and U171-, click [Cancel] and,
upon completion of write, perform the write operation from the [User parameter/storage area,
input/output and logic] window.
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[3] Workflow of Writing the Circuits
The workflow of writing the circuits is shown below:

Write to inverter START

Click [Write] or [Write to the inverter]

v

Are you sure to write?

Write to keypad START

4

to the keypad

Preparation: Writing the function codes

-

i

Click [Write] or [Write to the keypad]

SRRYEEY

\/

Check the model, regional
specification, voltage, capacity, and
inverter ROM version

NN

[Cancel]
[OK]
(a)User setting area/memory area R
(U121,..., U171,..)
are read
- J
4 v )
Customizable logic area (Uxx)
\_ is initialized
[Completes [Fails]

@ Cancel the write operation

Automatically performed

Automatically
* The customizable logic function stops.
* The terminal functions are not initialized.
* |f the write target is inverter, H03=12 is written.

successfully]

~

Write customizable logics (U,UA,...,UJ)
Write "disable function" settings to
input terminal functions (such as E01)
Write customizable logic output signals
1to 10to the output terminal functions
K (such as F31 and E20) j

)

User setting area/memory area
(U121,..., U171,..)
Are you sure to write to the above?

[Cancel]

@ Cancel the write operation

* Write operation fails while inverter is running

Automatically

* The "disable function" settings are written to
input terminal functions if the [Set Customize
Logic Signal] check box is checked on the
input terminal properties window.

Customize logic output signals 1 to 10 are
written to output terminal functions if the
[Output terminal digital] or [Output terminal
analog] check box is checked on the output
terminal properties window.

[OK]

[ Write the values read out in (a) j

Automatically

®

END
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Chapter 2 Functional Description

2.3.3.10. Comparison

Your edited circuits are assigned step numbers and converted to the inverter function code
settings when the customizable logic function check completes successfully.

Once the conversion completes successfully, [Compare] on the toolbar is enabled.

Click [Compare] to compare the settings of the edited circuits with those in the inverter, keypad, or
saved file.

x
—aelect destination comparizon
If the target device is a keypad, the label
| (Oompared with inver@; l 9 . yp
changes to [Compared with keypad].
Ciompated with file... |

—Comparative result dizplay

Comparative result dizplay.. |

Cloze |

The comparison results are displayed using the inverter function codes. You can save the
comparison results to a CSV file.

o]

Gamparizon start date:  2017-08-26 03:25:42
Gamparison source: GstmlogicPrjloms (E25)
Comparison destination:  FRNSSE25-2J

Comparison result: The difference of 3 affairs was detected.
"= Unuzed
“#": Locked
Function code | Saurce | Destination
u7s - 3
IS T 2o

Gloze
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Differences are displayed for symbols as well.

o] ] ] £ e e e e s S e

Number of use steps

T =

Select Inverter
No 1L TIINVI =] Weite ]Mr-w:ml 3 s1eps / 200 steps !.lnun' Grid I [Bom e
3 <
g_ Pm-uﬂl' TR =
‘3 Project CstalogxcPrjl’ Step 1 F
EHY Man - - b= =
S TR EE 5
L) FB (inchaded with the peopect) ), a 3
3 F& (Common) A0+ On Doy
2] FB001
e
A
Step 2
vt-Freal
o

Clear kog | Execution cycle 2 [ms]

Code |

) [idormation |

AT has a difference. (CstmLogicPrilca: 7100 / verter: 7200)

[The diference of 3 affars wes datected

Indormation
Idormation |

L7
i

Comparison execution time: 2131 [ms)
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Chapter 2 Functional Description

2.3.3.11. Debug Function

Using the online monitor or the trace monitor, you can check how the customizable logics written
to the inverter operate on the inverter. In addition, the online batch processing is a useful feature
that reduces the number of button clicks when you edit circuits.

Tip e You can use all of the online monitor, the trace monitor, and the online batch
processing when the loader is connected to the inverter. These features are not
available if you have selected [Data in Keypad] for [USB Connection] on the
[Communication Setting] window.

¢ A limited set of functions is available with some inverter models. Refer to "1.1.2.
Loader Functions by VF1A Series Inverter Model" for details.

[1] Online Monitor

The online monitor allows you to monitor the timer values or signals for a symbol as numeric
values.

Once you convert the customizable logic function settings you created, perform the step number
assignment, and write the settings to the inverter or you confirm that there are no differences the
result in the comparison results, you can run the online monitor on your selected symbol.

Select and right-click the symbol you want to monitor and select [Monitor select] on the context

menu.
) Doesa Loader - Customizable Logic - CatmlogicPrj1 - [Customizable Logic - CstmLogicPr1] - 0o *
O Fie Menu Setp View Window Help -8 x
D@ &Ro /0K P xedoWiseDE0E DR 0233
e | Select Iverter Humber of use steps '""f‘ - =
Customizable Logic [ T oot =] White | i st I Tstns F S0 s0en = J-\ \_..\ ; |D:Bnl | Brskoe | Duitaisnakoe | =
] Proeramdd |
Trput/Duitput
3 Project CatmlogicFryl" Swp 8 =1
EH3 Man N - Step & - - »> g
] Programil — : - —
D] - e o
=] FaO0I_I A+ 0 Culey.
3 FB {Common) —_ . -4
) FBoot e
TF 2 Comment
=] : A
feireat i Connect line FB (Commen)
Trcten b, Monitor select i
Menitor Deselact
Trace monitor select =] amg
Cut
Copy
Delete
StepMo. f Priceity setting =
1 13 Ll | |
Clear log | Execution cycle 2 [ms] - %]
Tyee Code | Property. _—
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The following example shows the result of selecting [Monitor select] for all the symbols in the
layout area shown on the previous page.

Step 3

Step 4
PO _I"'l_ | I - o
S  _ EEEE - FEO01_]
AR+ On Delay
TAC
TF 2
Step 1
Out-Fraql - i pryw
x3
- .
‘Witing function code
Step 2
Reacd

Feading function code

Start the inverter customizable logic.

Gustomizable logic startf=top x|

Select nverter: s X

Mo, 10 11 INW
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Chapter 2 Functional Description

You can check the status of the inputs/outputs, logic symbols, and function blocks (FBs)
highlighted in red in the layout area.

Step 3 T Sten 4

P FwDi [ P =P

P &L ~ po— i .._.-55‘
P Ee————— - FRo0lLl fhangend

KACTIreR % ARD + O Delay

XSE-. -
0:

R : Whiting function code

Reading function code

The display examples are shown below.
- Digital input
The logical values of OFF and ON are 0 and 1,
xl... - respectively.
10 The status of "0: Open /1: Closed" is shown under the
function name.

"l The "~" character prefixed to the function name
represents logical inversion.

For logical inversion, the status of "0: Closed /1: Open" is
shown under the function name.

- Analog input
Out-Fregl. A value is shown under the function name.
i1 00 - e For information on the meaning of this value, refer to the
page regarding "U code (customizable logic)" in the
User's Manual of your inverter.
Example: For Out-Freq1, the unit is % and "100%"

means the maximum output frequency.
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- Customizable logic function symbol

Step 3 S

“BHE

The output data is shown at the upper right.

=8— Functions (1) and (2) are shown under the symbol.

AR+ On Delay
T/G 0
TP i

List of function names

Monitor name Name Range

T.P Timer period 0.00 t0 9990 s

CNT Count 0.00 to 9990

U.L Upper Limit -9990 to 0 to 9990

L.L Lower Limit -9990 to 0 to 9990

1ST 1st Additional Value -9990 to 0 to 9990

2ND 2nd Additional Value -9990 to 0 to 9990

DEV Deviation -9990 to 0 to 9990
HYST Hysteresis Width -9990 to 0 to 9990

REF Reference Value -9990 to 0 to 9990

MAX Maximum Scale -9990 to 0 to 9990

MIN Minimum Scale -9990 to 0 to 9990

KA Factor KA -9990.0 to +9990.0

KB Factor KB -9990.0 to +9990.0
T.C(T/C) Time constant 0: No filter / 0.01 t0 5.00 s
FIX Fixed as 0

ACC ACC 0: No limit. 0.01 to 600 s
DEC DEC 0: No limit. 0.01 to 600 s
Gain Gain ratio 0 to 200%

Frq Lower frequency limit 0to 500 Hz

Val1 Set Value -9990 to 0 to 9990

Val2 Set Value2 -9990 to 0 to 9990

Step Step number 110 200

Tip e The value of the online monitor is displayed with 3 significant digits.
Minimum step in each range of value is shown in following table.

Range of value Minimum step
+0.00 —9.99 0.01
+10.0-99.9 0.1
+100 —999 1
#1000 - 9990 10

[2] Trace Monitor

The online monitor allows you to monitor the timer values or signals for a symbol as waveforms.

Refer to "2.3.4.10. Combination with the Customizable Logic Function".
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[3] Online Batch Processing

Until your desired circuits complete, you will repeat a series of tasks such as editing circuits,
performing step number assignment, wiring to the inverter, starting the customizable logic, and
starting monitors.

During such time, you can simplify the series of tasks from performing step number assignment
to starting monitors by using the online batch processing.

Prior to using the online batch processing, make sure that the inverter is stopped and that
[Monitor select] has been selected for at least one of the symbols in the layout area.

To use the online batch processing, click the [Online operation] icon on the toolbar.

The loader compares the circuits you are editing with those in the inverter and, if all the
comparison results match, automatically starts the monitors.

If the comparison results do not match each other, the [Comparison result] window appears.

=10l x| Click the [Write to Inverter and Start] button
SamzmisEncid  ARFIAD T at the lower left of the [Comparison result]
Comparison source: CstmLogicPrjlcmx (VFIA) «
Gomparison destination: VF1A-G21A584 - window to write to the inverter and
GComparison result: The difference of 2 affairs was detected.

automatically start the monitors.
“=": Unused
“*": Locked

Function code | Source | Destination

D
g2 8001 100

Write To Ihverter and Start Cancel I

4
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2.3.3.12. Project Properties

The project properties window allows you to add a version and comment to the created

project.

To open this window, right-click the project name displayed at the top of the project
management window and select [Property...] on the context menu.

E_| FE (Comma
... FBODT

The [Property] window opens.

Property

File name

Logic Version

Model
Region spec.
Yoltage
Gapacity
Version

MNumber of steps
T

Edit

Click the [Edit] button to open the [Inverter model selection]

— Logic version

Use these fields if you want to version-control your project. This is different from the
inverter ROM version.

When you write the edited circuits to the inverter or keypad, the settings are written to
function codes U197 and U199.

CstmLogicPrj1
0

VF1A

U:USA
3phase 400V
7.5HP(0012)
900

200

window shown at right.

This window allows you to change the model, regional
specification, voltage, capacity, and inverter ROM version.

Configure these settings correctly according to the target

inverter.

Which items you should configure varies depending on how
you write to the inverter. Refer to the Table on the next

page.

oK

X
(- . — Explanation
Explanation
You can add a
comment.
\_ J
Cancel
Inverter model selection X
Model VF1A ~
Region spec. LEUSA
Voltage 3phase 400V v
Capacity 75 HP (0012) v
Version 900 ~
Mumber of steps |2UEI
Gance
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Table 2-2 List of the items you should configure on the [Inverter model selection] window

. . When writing from the loader
When directly writing
o to the keypad and then
Setting item from the loader to the »
. writing from the keypad to the
inverter .
inverter
Model O O
Regional
I — (*2)
specification
voltage — O
Capacity — O
Version (*1) O O

O: Configuration required

—: Configuration not required

(*1) This is the inverter ROM version. Here, you can change the version you set when
creating a new project in "2.3.3.1. Select Customizable Logic Project to Edit".

(*2) You can change the regional specification by selecting [Setup] -> [Region spec.]
from the main menu. Once you have changed the regional specification, you have
to quit and restart the loader. Refer to "2.4.4. Region Spec." for details.

Tip ¢ You can identify the inverter model number you should select in the [Model] list
box from the inverter model number printed on the rating nameplate of the inverter.
Refer to "[1] Model, Regional Specification, Voltage, Capacity" in "2.2.1. Create a
New File" for details.

¢ You can identify the inverter ROM version from the inverter keypad.
For more information, refer to the instruction manual of your inverter.
When The Loader is connected to an inverter, you can identify the inverter ROM
version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation
Monitor] window, which you can access by selecting [Operation Monitor setting]
from the Quick Access menu.
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2.3.3.13. Lock Function

The lock function allows you to protect your created circuits from view and edit.

@ e The lock function is only available on your PC. If you write circuits with the lock
function enabled, they can be freely viewed and edited on the inverter. To
restrict the view and edit of circuits on the inverter, use the inverter's password
protection. For more information on password protection, refer to the instruction
manual or user's manual of your inverter.

[1] Locking the Project
Locking the project protects it from view and edit. (However, this feature does not protect FBs
under [FB (Common)] from view and edit.)

To lock the project,

Right-click the project name displayed at
the top of the project management window
and select [Lock...] on the context menu.

X Enter the password and click [OK].

Project iz locked.

Pleaze enter a pasaword.

(& half-width alphanumeric character,
4 - 12 characters)

Please input ohce again for a check.

|
0]:9 I Canhcel

@ e The password you use to lock the project is not within the knowledge of IDEC
CORPORATION.
Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.

Doesa Loader X Click [OK] to save the project.

o CstmlLogicPrj1 has been changed.

' Do you save data?

It cannot lock, when not saving.

The icon preceding the project name

[:T'. FE {Common) changes to a locked one [*g, meaning that

------ # FEOD the circuits in the project are protected
from view.
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To release the lock,

Project CatmLogicPril’ Right-click the project name displayed at
= FB (Con Lock... the top of the project management window
-3 B | Unlock... | and select [Unlock...] on the context menu.
Property...
x| Enter the password and click [OK].
e e ef] ol b oipezte. If your entered password is correct, the

Please enter password.
circuits are no longer protected from view.

|
614 I Cancel |

[2] Locking FBs (Common)
You can protect an FB under [FB (Common)] from view and edit. (However, this feature does not
protect the project itself from view and edit.)

To lock an FB under [FB (Common)],

E Project CstmLogicPhl’ Right-click an FB name under the [FB
E‘E' Main (Common)] in the project management
¢ I Program00 .
E1E5) FB (included with the project) window and select [Lock...] on the context
“JF FBOO1_1 menu.
= FB {Common)
g ﬁm
Open
Save
Cut
Copy
Delete
Lock... %J
Unlock...
Export
Property... |
Clear In perty m=1

X Enter the password and click [OK].

FB (CGomman) is locked and saved.

Pleaze enter a pazzword.

(& half-width alphanumeric character,
4 - 12 characters)

Pleaze input once again for a check.

|
(0]:4 I Cancel

The FB protected with the password is
then automatically saved.
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@ e The password you use to lock an FB is not within the knowledge of IDEC
CORPORATION.
Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.

= Project TstmLogicPri1’ The icon preceding the FB changes to a
—E' Main locked one B, meaning that the FB is

I Program00 protected from view.
== FB (Included with the project)

If you place a locked FB from the FB tab of the toolbox to the layout area, a locked mark appears
onit.

+ *
Comment
» ko B (Comman)
eaqsssgesshancasagennqasapansnaagannganas’ "\‘\‘
- i FBOO
N

Eu Project CstmLogicPril” In addition, an FB with a locked icon is
‘E" Main added under [FB (Included with project)] in
; D Program00 the project management window.
=-F5 FB (included with the project) ProJ 9 '

tF FBOO1_1 D . , -

i ouble-clicking an FB with a locked icon

. En FE001 2 u icking Wi i

does not display the circuits.

To release the lock,
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E FB {Common)
L ﬁn

Open
Save
Cut

Copy
Delete

Lock...
Unlock... . |

Export

Property... —

Ll [N [P =1

FB {Common) Unlock x|

The lock of FB (Common) iz removed.
Please enter password.

.

Cancel |

Right-click an FB name under the [FB
(Common)] in the project management

window and select [Unlock...] on the

context menu.

Enter the password and click [OK].

If your entered password is correct, the
icon becomes an unlocked one and the
circuits are no longer protected from view.

[3] Locking an FB under [FB (Included with project)]
You can protect an FB under [FB (Included with project)] from view and edit. (However, this
feature does not protect the project itself from view and edit.)

To lock an FB under [FB (Included with project)],

= Project ‘CetmLogicPr1’
== Main
LD Program00
- FB (Included with the project)

E:u FE (Comm Open
------ ¥ FEOM
Copy
| Lock... .
Unlock... .
Property...

FB ({Included with the project) x|

FB (Ihcluded with the project) is locked.

Pleaze enter a paszward.

(& half-width alphanumeric character,
4 - 12 characters

Pleaze input once again for a check.

|
o]

Cancel
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Right-click an FB name under the [FB
(Included with project)] in the project
management window and select [Lock...]
on the context menu.

Enter the password and click [OK].



CORPORATION.

e The password you use to lock an FB is not within the knowledge of IDEC

Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.

= Project ‘CstmLogicPr1’
== Main
¢ LD Program00
- FB (Included with the project)

E_' FB {Commoan)

To release the lock,

= Project ‘CetmLogicPr1’
== Main
LD Program00
- FB (Included with the project)

L

E_| FB (Commag Open
L3 FBOO1
Copy
Lock...
| Unlock... [
Property...

FB ({Included with the project)

The lock of FB {Included with the project)
is removed.
Please enter passward.

[ox |

Cancel
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The icon preceding the FB changes to a
locked one 1%, meaning that the FB is
protected from view.

In addition, a locked icon appears on the
FB when you place it in the layout area.

Right-click an FB name under the [FB
(Included with project)] in the project
management and  select
[Unlock...] on the context menu.

window

Enter the password and click [OK].

If your entered password is correct, the
icon becomes an unlocked one and the
circuits are no longer protected from view.



Chapter 2 Functional Description

2.3.3.14. Importing/exporting an FB under [FB (Common)]

The import/export function allows you to use your created FB in the VFD Doesa-Loader software
installed on another PC.

[1] Exporting an FB
You can save the desired FB(s) to a file.

[ Project CstmLogicPr1* Right-click [FB (Common)] in the project
= Main management window and select [FB Select
L T Program(0 Mod th text
£ FB (Included with the project) ode] on the context menu.

...JF FBOOT_T
E?ﬂ Mew...
Paste
| FBSelectMode
FE SelectMode Stof
Import
I

L= Project CstmLogicPq1" Check boxes appear on the left side of the
BEE' Main icons in the project management window.
¢ [ _H» Program00
=3 FB (Included with the project)

L. ]{}F FBOD1_1

DE| FB (Common)
... |4 FBOD1

LIS Project CstmLogicPi1’ From among the FBs under [FB (Common)],
=L Main select the FB(s) you want to save to a file by
¢ W] Ho Program0O0 . .

: hecking th heck b .
£+ 3 FB (Included with the project) checking Tneir check boxes
E"'E{EmtnBﬂ?J Right-click the FB name and select [Export]
LR FROD1 on the context menu.
Open
SERE @ e [Export] does not appear on
Cut the context menu of an FB
other than under [FB
Copy (Common)].
Delete e You cannot export any FBs
other than under [FB
Lock... (Common)].
Unlock... e You can also export a locked
FB.
Export v
Property... B
Clear log e EI._r,t:‘r_r,._. prel s |
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OO b = IDECVFD » Doesslosder » DATA 83 [ searchData

Organize v Mew folder
W mecentpiaces 2| pame - | Date modied

x|
a8
)

| e

|| FB0OLextb 10/2/2017 2:11PM EXFEL Fie

% Homegroup

18 Computer
&L ocal Dk ()
- 4 |

File game: [ FE002

Save as type: [F8 exportFie (*exfbl)

- e rte

Cancel

|l

[2] Importing an FB

You can import FBs saved in a file to the project.

Project CstmLogicPril”
- Main
-y FB (Included with the project)

[ [l

- Mew...
Paste

FE SelectMode
FE SelectMode Stop

Import [

+ Documents.
o tuse

= Pictures
H veeos

o} Homegoup

18 Computer
& Localek (1)

=4l |

File games: [FB001 el =] [F8 exportFie ("t

Cancel

|

|

P
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Select [Save to ...] and enter the file name
under which the data is saved in [File
Name]. Then click [Save] to save the file.

File types

- FB export file: "*.exfbl"

Click [OK].

Right-click [FB (Common)] in the project
management window and select [Import] on
the context menu.

Select an FB file.



Chapter 2 Functional Description

Doesa Loader X

0 Do you want to import FB?

= Project CstmLogicPr1’
&3 Main
-4 FB (Included with the project)

E FB ({Comman)

FB (Common)

FBOO1 FEOO_1
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Click [OK].

The imported FB(s) is added under [FB
(Common)] in the project management
window.

The imported FB(s) are added to the [FB]
tab of the toolbox.



2.3.3.15. Printing the Customizable Logic

When the [Customizable logic] window is active, you can print the content of the layout area by

selecting [File] from the main menu.

File | Merw  Setup  Wiew  ifindow
] Hew.
[ Open.
Ciloze
[ml Save
Save bz
= (Print..

_,:} Print Preview

Print selected Swmbol
Print Preview selected Swmbol

Page Setup..

Fecent File

Exit

The following is an example printout.

[Print]

When the [Customizable logic] window is active, select this
command to print the content of the layout area.

For more information on the [Print] dialog, refer to "2.2.6. Print".

[Print Preview]

When the [Customizable logic] window is active, select this
command to view the print preview of the layout area.

For more information on the [Preview] window, refer to "2.2.7. Print
Preview".
[Print selected Symbol]

This command is available when the [Customizable logic] window is
active. Select it to print only the symbol selected in the layout area.

[Print Preview selected Symbol]

This command is available when the [Customizable logic] window is
active. Select this command to view the print preview of only the
symbol selected in the layout area.

[Page Setup] is not available. The content of the layout

area is automatically adjusted to fit in one A4 landscape page.

Project Name : CstmLogicPril
Program Mame : Program{{
Explanation :

L]

Y —— n E
0+ On Dol

T

L
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Chapter 2 Functional Description

2.3.3.16. List of Input Terminal Signal Codes

This section describes the signal codes specified in input terminal properties. Reference
this section when creating circuits. The numbers up to 60XX represent logical value
(ON/OFF) input signals. Numbers 80XX and greater represent numeric value input signals.

For information on the input terminal properties, refer to "Properties of an Input Terminal” in
"2.3.3.3. Workflow of Creating a Circuit".

Restrictions

The signal codes described below are only available when supported by the inverter. For
information on the available signal codes, refer to the description of function code U02 and
U03 in the User's Manual of your inverter. Alternatively, you can refer to the description of
function code U02 and UQ3 in [Function code information] on the [Function code edit]
window (also with selecting the "Create the customizable logic function code window",
depending on the applied inverter models).

Numbers from 0000 to 12XX
Almost the same as general-purpose output signals (i.e., signals selectable for E20).
(Some signals are excluded from the signals selectable for E20.)

For information on these signals, refer to the description of function code E20 in the User's
Manual of your inverter.

Numbers 4000 to 50XX
These numbers represent the digital terminal input signals to the inverter.

Refer to the function codes U02 and UO3 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.

Allocation number

Active Active Signal name Details
ON OFF
4001 - 5001 - X1, X2,... Represent the ON/OFF status of the inverter terminal blocks if
4010 5010 FWD the remote operation command is disabled.

Represent the ON/OFF status of each bit of function code

401 5011 REV S06 when the remote operation command is enabled.

4021 - 5021 - 1,12, ... Represent the ON/OFF status of input signals for option cards
with digital terminal input signals.

4041 - 5041 - CLI1, CLIZ, ... These are digital input signals dedicated to customizable logic
that can be reassigned to any X terminal.

4081 - 5081 - KP-RUN/FWD, | Represent the ON/OFF status of the keypad button.

KP-REV, ...
4101 - 5101 - X1-TERM, Represent always the ON/OFF status of the physical inverter
X2-TERM, ... terminal blocks even if the remote operation command is

enabled.
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@ e When you configure input terminals for these signals, be aware that other functions
that use the configured signals can operate. For example, if you set the X1 terminal
function selection (function code EO01) to '0' ([SS1] multi-step frequency selection)
and then turn the X1 terminal from OFF to ON, the multi-step frequency selection is
enabled from disabled state in parallel with the change of the input terminal logical
value. Care must be taken especially for the X terminal, the FWD terminal, and the
REV terminal, whose functions are configured with the factory-set values.

Tip e To use a signal exclusively as the customizable logic input, you must check the [Set
Customize Logic Signal] check box on [Properties of an Input Terminal] or explicitly
set the signal function selection to "100[NONE]".

Numbers 6000 to 70XX
These signals cannot be selected for general-purpose output signals (i.e., signals
selectable for E20).

Refer to the function codes U02 and U03 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.
Each function is described assuming the active ON logical (positive logic).

Allocation number

Signal -
Active Active 9 Description

name
ON OFF

Final operation command RUN. Turns ON when the operation

6000 7000 FL_RUN .
command is issued.

Final operation command FWD. Turns ON when the forward

6001 7001 FL_FWD . . .
- rotation operation command is issued.

Final operation command REV. Turns ON when the reverse

6002 7002 FL_REV . . .
- rotation operation command is issued.

6003 7003 DACC Turns ON when acceleration starts.
6004 7004 DDEC Turns ON when deceleration starts.
6005 7005 REGA Turns ON when regeneration avoidance starts.

6006 7006 DR_REF Turns ON when the dancer is in the reference position.

Turns ON when an alarm occurs and the alarm can be reset

6007 7007 | ALM_ACT
- (with no alarm cause identified).

6100 - TRUE Always ON (TRUE).
6101 - FALSE Always OFF (FALSE).

Numbers 80XX

Almost the same as inverter analog general-purpose output signals (i.e., signals selectable
for F31). These assigned numbers are codes created by adding 8000 to F31 signal codes.
(Some signals are excluded from the signals selectable for F31.)

Numeric values are expressed in the unit of %.

Refer to the function code F31 in the user's manual of each inverter model for the
assignment number, function, and the definition of 100% of each signal.

2-106
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An example of signal name is shown below.

Signal name
ourq | St eauercy - (et sip compensaton)
Out-Freq2 oOrug?’iur;;rreyqfl:zgﬁgnZC§,after slip compensation),
Out-I QOutput current
Out-V Output voltage
Torque Qutput torque
Load Load factor
In-Power Consumed power
PID-PV PID feedback value
Speed Detected speed value/estimated speed value
DC-Link-V DC intermediate circuit voltage
M-out Motor output
PID-SV PID command
PID-MV PID output
Deviation Position deviation during synchronous operation
H-sink-tmp Cooling fin temperature
Internal-tmp Internal air temperature
F-ref Set frequency
PG-fb PG feedback value
Torque-| Torque current reference
PID-ERR PID deviation
Line-ref Reference line speed

RollDiameter

Roll diameter ratio

F-ref (Final) Frequency set point (Final)
PID-PV 1 PID feedback value 1

PID-SV 1 PID command 1

PID-PV 2 PID feedback value 2

PID-SV 2 PID command 1

EPID1-PV External PID feedback value 1
EPID1-SV External PID command 1
EPID1-Out External PID final output 1
EPID2-PV External PID feedback value 2
EPID2-SV External PID command 2
EPID2-Out External PID final output 2
EPID3-PV External PID feedback value 3
EPID3-SV External PID command 3
EPID3-Out External PID final output 3
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Numbers 90XX

These numbers represent the analog terminal input signals to the inverter.

Refer to the function codes U02 and UQ3 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.

Allocation ) .
Name Details Numeric value
number
9001 Al-[12] Analog terminal 12 input signal
Analog C1 terminal input signal
9002 | AI[C1] or
Analog C1 terminal input signal (C1
function)
- . Scale-transformed physical
Analog V2 terminal input signal quantity obtained by
9003 | AI-[V2] or applying gain/bias to the
Analog C1 terminal input signal (V2 input signal
function)
9004 Al-[32] Analog termllnal 32 |nput signal .(|nput
signal for option card with analog input)
9005 AI-[C2] Analog termllnal Cc2 |nput signal .(|nput
signal for option card with analog input)
Temperature detection Pt channel 1 Filtered temperature
9006 PtCh1 (|nput Signal for Option card with a (From the function code
temperature measuring resistor) setting field, you can select
Temperature detection Pt channel 2 | one of the following units:
9007 | PtCh2 (Input signal for option card with a | [K], [°C], and [°F].)
temperature measuring resistor)
Scale-transformed physical
9008 AL[V3] Analgg C1 terminal input signal (V3 quantllty thglned by
function) applying gain/bias to the
input signal
9010 UP/DOWN | Set point value by UP / DOWN control | 0~100%

To help understand the numeric values for an input terminal for which one of the numbers
from 9001 to 9005 is selected, the following example shows the results of applying a gain
and bias to each of the [12] and [C1] terminals:

If the gain = 100% and the bias = 0% | If the gain = 200% and the bias = 0%
Input terminal
Input value After application Input value After application
(2] Oto+10V 0 to 100% 0 to +5V 0 to 100%
-10 to OV -100 to 0% -5 to OV -100 to 0%
1] 4 to 20 mA 0 to 100% 4 to 12mA 0 to 100%
0to 20 mA 0 to 100% 0 to 10mA 0 to 100%
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The numeric value for an input terminal
will be the value created by
transforming the scale after the gain | Maximum scale
and bias application from "0 to 100%"
to "minimum to maximum".

Input terminal value

Minimum scale 100% Analog input value

(After bias and gain application)

@ e When you configure input terminals for these signals, be aware that other
functions that use the configured signals can operate. For example, if you set the
frequency setting 1 (function code FO1) to '1' (terminal 12) and then change the
input voltage for terminal 12, the step frequency setting changes in parallel with
the change of the input terminal numeric value.

Tip e To use a signal exclusively as the customizable logic input, you must explicitly
configure the FO1, C30, E61, E62, E63, and other related function codes not to
use the signal configured for the input terminal.

e By factory default, the FO1, C30, and other related function codes are configured
not to use such a signal.
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2.3.3.17. List of Output Terminal Signal Codes

This section describes the signal codes specified in output terminal properties. Reference
this section when creating circuits. The numbers up to 12XX represent logical (ON/OFF)
signal value output signals. Numbers 80XX and greater represent numeric value output
signals.

For information on the output terminal properties, refer to "Properties of an Output Terminal"
in "2.3.3.3. Workflow of Creating a Circuit".

Restrictions

The signal codes described below are only available when supported by the inverter. For
information on the available signal codes, refer to the description of function code U81 in
the User's Manual of your inverter. Alternatively, you can refer to the description of function
code U81 in [Function code information] on the [Function code edit] window (also with
selecting the "Create the customizable logic function code window", depending on the
applied inverter models).

Numbers from 0000 to 12XX

Almost the same as general-purpose input signals (i.e., signals selectable for E01).
(Some signals are excluded from the signals selectable for EO1 and 98[FWD] and 99[REV]
are added.)

For information on these signals, refer to the description of function code E01 in the User's
Manual of your inverter.

Numbers 80XX
Almost the same as inverter analog general-purpose input signals (signals selectable for
E61). These assigned numbers are codes created by adding 8000 to E61 signal codes.
(Some signals are excluded from the signals selectable for E61.)

Except for some signals, numeric values are expressed in the unit of percentage.

Refer to the function code E61 in the user's manual of each inverter model for the definition
of the assignment number, function, and numerical value of each signal.

An example of signal names is shown below.

Signal name
Aux-freq1 Frequency auxiliary setting 1
Aux-freq2 Frequency auxiliary setting 2
Aux-freq3 Frequency auxiliary setting 3
Aux-freq4 Frequency auxiliary setting 4

Speed command (Not reversible operation

N-Ref Unipolar by polarity)

Speed command (Reversible operation by

N-Ref Bipolar polarity)
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Signal name
PID-SV1 PID command 1
PID-SV2 PID command 2
PID-PV1 PID feedback value
Ratio set Ratio setting
Trg-lim.A Analog torque limit value A
Trg-lim.B Analog torque limit value B
Trg-bias Torque bias
Trg-cmd Torque command
Trqg-curr Torque current command
LampRatio Acceleration/deceleration time ratio setting
Freq-lim.H Upper limit frequency
Freqg-lim.L Lower limit frequency
Spd-lim.F Forward rotation (FWD) speed limit value
Spd-lim.R Reverse rotation (REV) speed limit value
Ai-mon Analog input monitor
PID-PV2 PID feedback value 2
Aux-SV1 PID process command auxiliary setting 1
Aux-SV2 PID process command auxiliary setting 2
FlowRate Flow sensor
EPID1-SV External PID process command 1
EPID1-PV External PID feedback value 1
EPID1-MU External PID manual command 1
EPID2-SV External PID process command 2
EPID2-PV External PID feedback value 2
EPID2-MU External PID manual command 2
EPID3-SV External PID process command 3
EPID3-PV External PID feedback value 3
EPID3-MU External PID manual command 3
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2.3.3.18. List of Logic Symbols

This section describes the respective function blocks. Reference this section when creating

circuits.

Restrictions

The function blocks described below are only available and displayed on the toolbox when
supported by the inverter. Additionally even if the function blocks are displayed on the toolbox,
some blocks might be not available depending on the version of the inverter.

For information on the available function blocks, refer to the description of function code U01 in
the User's Manual of your inverter. Alternatively, you can refer to the description of function code
U01 in [Function code information] on the [Function code edit] window (also with selecting the
"Create the customizable logic function code window", depending on the applied inverter

models).

2.3.3.18.1.

To select a basic logic symbol, choose [Basic
logic] from the [Digital] tab.

10 to 15: Through

[Digital] - Basic Logic

Tool box

Digital | Analog | Digital+Analog | FE |

I Basic logic

Flip—Flop
Edee detection
Digital Other

Block Symbol Function block Description
selection
Input Output Through output without a logical circuit
Logical Logical « »
10 [Logicall [Logical Through output Use “2005: Analog.through for the through
output an analog signal.
Input OQutput . . .
- N Turning ON the input starts the ON-delay timer.
11 Logical [Logical] | Through output When the timer time has elapsed, the output
i _|—-|_ + ON-delay timer turns ON. Turning OFF the input turns OFF the
I output.
Input Output
Logical Logical| | Through output Turning OFF the input starts the OFF-delay
12 - + OFF-delay timer timer. When the timer time has elapsed, the
— output turns OFF.
.
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Block Symbol Function block Description
selection
Turning ON the input starts the timer. The
output remains ON until reaching the timer time.
While the output is ON, the timer operation
Inout Outout continues without regard of the input status.
npu utpu . . .
Logical Logical] | Through output Setting the timer time to 0 turns OFF the output.
13 i _|"'|_ + Pulse (1 shot)
_— Input OFF [ OoN  Jorf[ | [] OFF
Output OFF ON OFF ON OFF
Timer time
Turning ON the input starts the timer. The
output remains ON until reaching the timer time.
If an OFF to ON edge at the input occurs while
the output is ON, however, the output remains
Input Output ON from that time until reaching the timer time.
A i Setting the timer time to 0 causes the output to
14 togical Logica Th“’“gh output . turn OgN when the input turns ON. i
—_ H_H"'l + Retriggerable timer
— OFF [ ON  |OFF [ on ]
Input
Output OFF ON OFF | ON | OFF
Timer time
Outputs a pulse signal with a period twice the
timer time and a duty of 50%. Useful for flashing
a light emitting device.
Turning ON the input turns ON the output and
starts the timer. When reaching the timer time,
| o the output turns OFF and the timer restarts.
nput I UFDUIt When reaching the timer time again, the output
15 [Logicall [Logicall | Through output turns ON and the timer restarts.
—_—| | + Pulse train output Setting the timer time to 0 turns OFF the output.
EINNIT

OFF | ON ON
Input
OFF ON OFF ON
Output
Timer time
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20 to 25: AND

Block
selection

Symbol

Function block

Description

Input 1

Output

[Logical|

[Logical|

20 |& r—

Logical product (AND)

This is an AND circuit with 2 inputs/1 output.

Input 2
Logical
Input 1 Output
|Logical| |Logical| . i s
This is a combination of an AND circuit with 2
) inputs/1 output and an ON-delay timer.
& —— Logical product (AND) . L
21 4 delay i Turning ON the AND circuit output starts the
- + ON-delay timer ON-delay timer. When the timer time has
elapsed, the output turns ON. Turning OFF the
Input 2 AND circuit output turns OFF the output.
Logical
Input 1 Qutput
[Logicall [Logicall This is a combination of an AND circuit with 2
inputs/1 output and an OFF-delay timer.
& - Logical product (AND) Turning ON the AND circuit output turns ON the
22 _I_-l_ + OFF-delay timer output.
Turning OFF the AND circuit output starts the
OFF-delay timer. When the timer time has
Input 2 elapsed, the output turns OFF.
Logical
Input 1 Qutput
|Logical| |Logical|
This is a combination of an AND circuit with 2
& —— Logical product (AND) inpu_ts/l output and a pulse (; shot) output.
23 - |--| = + Pulse (1 shot) For information on the operation of a pulse (1
— shot), refer to Block selection 13 "Through
Inout 2 output + Pulse (1 shot)".
Logical
Input 1 Qutput
[Logical [Logical This is a combination of an AND circuit with 2
& T Logical product (AND) inpu}s/l output and a retrigge_rable timer.
24 . H—-| ™ | + Retriguerable timer For information on the operation of a
— 99 retriggerable timer, refer to Block selection 14
Inout 2 "Through output + Retriggerable timer".
Logical
Input 1 Output
[Logicall [Logicall This is a combination of an AND circuit with 2
& — Logical product (AND) inpu_ts/l output and a pulse trgin output. _
25 ™ | | = + Pulse train outout For information on the operation of a pulse train
S P output, refer to Block selection 15 "Through
Input 2 output + Pulse train output”.
Logical
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30 to 35: OR
se[?éc::(t;ilén Symbol Function block Description
Input 1 Output
[Logical| [Logical|
<=1 . - R
30 = p— Logical sum (OR) This is an OR circuit with 2 inputs/1 output.
Input 2
Logical
Input 1 Qutput
|Logical| |Logical| . I Lo
This is a combination of an OR circuit with 2
. inputs/1 output and an ON-delay timer.
31 1211, _I"'|_ || Logical sum (OR) Turning ON the OR circuit output starts the
- - + ON-delay timer ON-delay timer. When the timer time has
elapsed, the output turns ON. Turning OFF the
Input 2 OR circuit output turns OFF the output.
Logical
Input 1 Output o o S
[Logicall [Logicall This is a combination of an OR circuit with 2
inputs/1 output and an OFF-delay timer.
411 [=— Logical sum (OR) Turning ON the OR circuit output turns ON the
32 - HE + OFF-delay timer output.
= ] Y Turning OFF the OR circuit output starts the
Inout 2 OFF-delay timer. When the timer time has
’ﬁ%‘ elapsed, the output turns OFF.
Input 1 Qutput
|Logical| |Logical|
This is a combination of an OR circuit with 2
-1 =1 | Logical sum (OR) inputs/1 output and a pulse (1 shot) output.
33 = |--| = + Pulse (1 shot) For information on the operation of a pulse (1
= — shot), refer to Block selection 13 "Through
Inout 2 output + Pulse (1 shot)".
npu
Logical
Input 1 Output
Logical Logical
[Logical [Logical This is a combination of an OR circuit with 2
- 21 T Logical sum (OR) inputs/1 output and a retriggerable timer.
34 =™ H—'-| ™ | + Retriguerable timer For information on the operation of a
= — 99 retriggerable timer, refer to Block selection 14
Input 2 "Through output + Retriggerable timer".
Input 1 Output
[Logical| [Logical] o o L
This is a combination of an OR circuit with 2
-1 >1 Logical sum (OR) inputs/1 output and a pulse train output.
35 = ™ | | ™ | + Pulse train outout For information on the operation of a pulse train
= — P output, refer to Block selection 15 "Through
Input 2 output + Pulse train output”.
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40 to 45: XOR

Block

. Symbol Function block Description
selection
Input 1 Output
[Logical| [Logical|
40 =1 —— | Exclusive OR (XOR) This is an XOR circuit with 2 inputs/1 output.
Input 2
Logical
Input 1 Qutput
[Logicall [Logical This is a combination of an XOR circuit with 2
. inputs/1 output and an ON-delay timer.
-1 =1 —— Exclusive OR (XOR) . L
41 - |—-| - N-delay i Turning ON the XOR circuit output starts the
= — + ON-delay timer ON-delay timer. When the timer time has
Inout 2 elapsed, the output turns ON. Turning OFF the
npu XOR circuit output turns OFF the output.
i i
Input 1 Qutput . o S
[Logical| [Logical| This is a combination of an XOR circuit with 2
inputs/1 output and an OFF-delay timer.
-1 =1 -I_T Exclusive OR (XOR) Turning ON the XOR circuit output turns ON the
42 - — + OFF-delay timer output.
Turning OFF the XOR circuit output starts the
Input 2 OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Qutput
|Logicall |Logicall o o o
This is a combination of an XOR circuit with 2
- =1] [ Exclusive OR (XOR) inputs/1 output and a pulse (1 shot) output.
43 - ] H_ B + Pulse (1 shot) output | For information on the operation of a pulse (1
shot), refer to Block selection 13 "Through
Input 2 output + Pulse (1 shot)".
Input 1 Output
[Logical| [Logical| o o o
This is a combination of an XOR circuit with 2
- =1 mm Exclusive OR (XOR) inputs/1 output and a retriggerable timer.
44 - B m B + Retriggerable timer For information on the operation of a
retriggerable timer, refer to Block selection 14
Input 2 "Through output + Retriggerable timer".
Logical
Input 1 Output
|Logical| |Logical| . I s
This is a combination of an XOR circuit with 2
- =1 _— Exclusive OR (XOR) inputs/1 output and a pulse train output.
45 _ 1 IF + Pulse train output For information on the operation of a pulse train

Input 2
Logical

output, refer to Block selection 15 "Through
output + Pulse train output”.
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2.3.3.18.2. [Digital] - Flip-flop

To select a flip-flop symbol, choose [Flip-Flop]
from the [Digital] tab.

50 to 55: SR-FF

Tool box o X
Digital IHnaIDg I Digital+fnaloe I FE |
Bazic logic LI
Bazic logic

Edee detection
Digital Other

Block

selection Symbol Function block Description
This is a set priority flip-flop.
When Input 1 (SET) turns ON, the output turns
Input 1 Output ON, and when Input 2 (RESET) turns ON, the
[Logical| [Logical] output turns OFF. If there is no input, the
o previous state is maintained.
50 R () [ S_et priority When both inputs are ON, Input 1 (SET) has
flip-flop priority.
Input 2 . .
Logical For supported inverter, you can specify the
ogica initial state (OFF (0) or ON (1)) of the flip-flop
immediately after starting the customizable
logic with Parameter 2. For non-supported
models, the initial state is OFF (0).
Input 1 Qutput o o o
[Logicall [Logicall This is a combination of a set priority flip-flop

Set priority
—
51 | Q- |—-| = | flip-flop
R —

+ ON-delay timer

and an ON-delay timer.

Turning ON the flip-flop output starts the
ON-delay timer. When the timer time has

- Set priority
52 R M2 F | fip-fop

+ OFF-delay timer

Input 2 elapsed, the output turns ON. Turning OFF the
Logical flip-flop output turns OFF the output.

Inpu_t 1 OUFPUt This is a combination of a set priority flip-flop
|Logical| |Logical|

and an OFF-delay timer.

Turning ON the flip-flop output turns ON the
output.

Turning OFF the flip-flop output starts the

Set priority
. .
54 |5 Qf- H—-| = | flip-flop
R B

+ Retriggerable timer

IE:;E; OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Output
[Logicall [Logical] Set priofi This is a combination of a set priority flip-flop
—_— .et priority and a pulse (1 shot) output.
53 jR QM _ﬂ_ = | flip-flop For information on the operation of a pulse (1
+ Pulse (1 shot) shot), refer to Block selection 13 "Through
Input 2 output + Pulse (1 shot)".
Logical
Input 1 OQutput
[Logical] [Logical] This is a combination of a set priority flip-flop

and a retriggerable timer.

For information on the operation of a
retriggerable timer, refer to Block selection 14
"Through output + Retriggerable timer".

Input 1 Output
|Logical| |Logical|

Set priority
B .
55 |5 Q| | | flip-flop
R LR

+ Pulse train output

This is a combination of a set priority flip-flop
and a pulse train output.

For information on the operation of a pulse train
output, refer to Block selection 15 "Through
output + Pulse train output”.
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60 to 65: RS-FF

Bloc]( Symbol Function block Description
selection
This is a reset priority flip-flop.
When Input 1 (SET) turns ON, the output turns
Inout 1 Outout ON, and when Input 2 (RESET) turns ON, the
pu P output turns OFF. If there is no input, the
[Logicall [Logicall previous state is maintained.
-1S I— Reset priority When both inputs are ON, Input 2 (RESET) has
60 Q )
-R flip-flop priority.
Input 2 For supported inverter, you can specify the
initial state (OFF (0) or ON (1)) of the flip-flop
immediately after starting the customizable
logic with Parameter 2. For non-supported
models, the initial state is OFF (0).
Input 1 Qutput . o -
[Logical] [Logical o Thisis a comblnatl_on of a reset priority flip-flop
S Reset priority and an ON-delay timer.
61 Qf- |_..| - flip-flop Turning ON the flip-flop output starts the
il = + ON-delay timer ON-delay timer. When the timer time has
Input 2 elapsed, the output turns ON. Turning OFF the
Logical flip-flop output turns OFF the output.
Input 1 Output This is a combination of a reset priority flip-flop
[Logicall [Logicall and an OFF-delay timer.
- Reset priorit . .
S QH -I_T - .ese priority Turning ON the flip-flop output turns ON the
62 —R — flip-flop _ output.
+ OFF-delay timer Turning OFF the flip-flop output starts the
OFF-delay timer. When the timer time has
L - I = .
elapsed, the output turns OFF.
Input 1 Output
|Logical |Logicall Reset briofit This is a combination of a reset priority flip-flop
= _— .ese prionty and a pulse (1 shot) output.
63 - QM H_ B flip-flop For information on the operation of a pulse (1
| 2 + Pulse (1 shot) shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".
Input 1 Output
[Logical] [Logical] Reset briofit This is a combination of a reset priority flip-flop
e T .ese priority and a retriggerable timer.
64 =R QP }_H B ﬂlp-ﬂop _ For information on the operation of a
| > + Retriggerable timer retriggerable timer, refer to Block selection 14
’ﬂ% "Through output + Retriggerable timer".
Logical
Input 1 Output
|Logicall [Logicall Reset briorit This is a combination of a reset priority flip-flop
-5 — .ese priority and a pulse train output.
65 -R Q| |f | flie-flop _ For information on the operation of a pulse train
Input 2 + Pulse train output output, refer to Block selection 15 "Through

Logical

output + Pulse train output”.
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Chapter 2 Functional Description

140 to 145: D-FF

Bloc]( Symbol Function block Description
selection
Inout 1 Outout This is a delay flip-flop.
npu utpu
|L:gical| |LogiEaI| The rising edge of Input 2 (CK) reflects the
S b (delav) i state of Input 1 (D) to the output.
140 Q) pr— (delay) flip-flop For supported inverter, you can specify the
:ECK initial state (OFF (0) or ON (1)) of the flip-flop
Input 2 immediately after starting the customizable
logic with Parameter 2.
Input 1 Output
|L:gical| |LogiEaI| This is a co_mbination of a delay flip-flop and an
ON-delay timer.
I in-
141 D aH = F E’ g’ﬁ'g‘é)lgpnfr'%pr Turning ON the flip-flop output starts the
CK —- ON-delay timer. When the timer time has
Input 2 elapsed, the output turns ON. Turning OFF the
Logical flip-flop output turns OFF the output.
Input 1 Output This is a combination of a delay flip-flop and an
[Logicall [Logicall OFF-delay timer.
D Qk |_,,| - D (delay) flip-flop Turning ON the flip-flop output turns ON the
142 CK —5 + OFF-delay timer output.
Input 2 Turning OFF the flip-flop output starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Output
|Logicall [Logicall This is a combination of a delay flip-flop and a
D —— D (delay) flip-flop pulse (1 shot) output.
143 CK QM H_ - | +Pulse (1 shot) For information on the operation of a pulse (1
| > shot), refer to Block selection 13 "Through
’—p—‘:o;zal output + Pulse (1 shot)".
Input 1 Output
[Logicall [Logicall This is a combination of a delay flip-flop and a
D T D (delay) flip-flop retriggerable timer.
144 CK QH m B + Retriggerable timer For information on the operation of a
Input 2 retriggerable timer, refer to Block selection 14
- "Through output + Retriggerable timer".
Logical
Input 1 Output
|Logicall [Logicall This is a combination of a delay flip-flop and a
D — D (delay) flip-flop pulse train output.
145 CK Qp |"""| B + Pulse train output For information on the operation of a pulse train
| > output, refer to Block selection 15 "Through
’ﬁ%‘ output + Pulse train output”.
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150 to 155: T-FF

se[?éc::(t;ilén Symbol Function block Description
This is a toggle flip-flop.
Input Output . .
[Logical [Logical The output status is inverted by the rising edge
of Input 1 (T).
150 T (toggle) flip-flop

-T q-_

For supported inverter, you can specify the
initial state (OFF (0) or ON (1)) of the flip-flop
immediately after starting the customizable
logic with Parameter 2.

|I|?:;i::al| ||2:E5:It| This is a combination of a delay flip-flop and an
ON-delay timer.
151 =T Qf |_..| - Ig?\ﬁ%lgl)aglz;ggf Turning ON the flip-flop output starts the
___mm ON-delay timer. When the timer time has
elapsed, the output turns ON. Turning OFF the
flip-flop output turns OFF the output.
Input Output This is a combination of a delay flip-flop and an
[Logicall [Logicall OFF-delay timer.
150 =T Q- |_,,| - T (toggle) flip-flop Turning ON the flip-flop output turns ON the
— + OFF-delay timer output.
Turning OFF the flip-flop output starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input Output
|ch)gical| |LogiEaI| Thliseis(f cr?g:)b(i)netltiotn of a delay flip-flop and a
T (toggle) flip-flop puls S utput.
—
153 =T Q= |-| o + Pulse (1 shot) For information on the operation of a pulse (1
=_= shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".
Input Output
|L:gical| |LogiEaI| Thti§ is a ct?lm?ination of a delay flip-flop and a
T (togg|e) f||p_f|0p retriggeraple umer.
.
154 =T Q- H_..| - + Retriggerable timer For information on the operation of a
S— retriggerable timer, refer to Block selection 14
"Through output + Retriggerable timer".
Input Output
|L:gical| |LogiEaI| Thlis is; a_com?in?tion of a delay flip-flop and a
T (toggle) flip-flop puise train output.
B
155 =T Q= | | o + Pulse train output For information on the operation of a pulse train
LLLLLL output, refer to Block selection 15 "Through

output + Pulse train output”.
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Chapter 2 Functional Description

2.3.3.18.3.

To select an edge detection symbol, choose

[Digital] - Edge Detection

[Edge detection] from the [Digital] tab.

70, 72, 73: Rise Edge

Tool box o X
Digital IHnaIDg I Digital+fnaloe I FE |
Bazic logic LI
Bazic logic

Flip—Flo

Digital Other

Block

selection Symbol Function block Description
Input Output . . . . .
o - This is a rise detection with 1 input/1 output.
Logical Logical
70 — Rise edge detection Once a rise of an input signal is detected, the
a — ON signal is output until the end of one
— execution cycle time.
This is a combination of a rise detection with 1
Input Output input/1 output and an OFF-delay timer.
[Logical] [Logical| | pise edge detection + | When a rise edge is detected, the output turns
2 I -I_T OFF-delay timer ON.
1l Turning OFF the rise edge detection starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input tput This is a combination of a rise detection with 1
Logical ical| | Rise edge detection + input/1 output and a pulse (1 shot) output.
73

Pulse (1 shot)

For information on the operation of a pulse (1
shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".

80, 82, 83: Fall Edge

Block

. Symbol Function block Description
selection
Input Output - . ) .
Logical Logical This is a fall detection with 1 input/1 output.
80 — Fall edge detection Once a fall of an input signal is detected, the
- |e— ON signal is output until the end of one
b execution cycle time.
This is a combination of a fall detection with 1
Input Output input/1 output and a general-purpose timer.
Logical Logical| | £5) edge detection + When a fall edge is detected, the output turns
82 -I'T OFF-delay timer ON.
—— Turning OFF the rise edge detection starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input OQutput This is a combination of a fall detection with 1
Logical Logical Fall edge detection + input/1 output and a pulse (1 shot) output.
83 —— Pulse (1 shot) For information on the operation of a pulse (1
|"'| shot), refer to Block selection 13 "Through

output + Pulse (1 shot)".
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90, 92, 93: Both Edges

Bloc]( Symbol Function block Description
selection
Input Output This is a rise and fall detection with 1 input/1
Logical Logical Rise and fall edge output.
90 detection Once a rise or fall of an input signal is detected,
T71r the ON signal is output until the end of one
execution cycle time.
Input Output ) This is a combination of a rise and fall detection
Logical Logical g'ste ?nd fall edge with 1 input/1 output and an OFF-delay timer.
etection
92 -— OFF-delav i Turning OFF the rise and fall edge detection
l"'| + -Gelay timer starts the OFF-delay timer. When the timer time
has elapsed, the output turns OFF.
Input Output | Rise and fall edge This is a combination of a rise and fall detection
Logical Logical| | detection with 1 input/1 output and a pulse (1 shot) output.
93 —j— + Pulse For information on the operation of a pulse (1
ndel= (1 shot) shot), refer to Block selection 13 "Through

output + Pulse (1 shot)".
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Chapter 2 Functional Description

2.3.3.18.4.

To select a "digital other" symbol, choose [Digital
Other] from the [Digital] tab.

100 to 105: Hold

[Digital] - Digital Other

Tool box o X
Digital IHnaIDg I Digital+fnaloe I FE |
Bazic logic LI

Bazic logic
Flip=Flop
Edee detection

Block

. Symbol Function block Description
selection
Inpu_t L Oufput This is a "hold previous value" function with 2
[Logical [Logicall inputs/1 output.
100 (T — Hold Input 2 is the hold control signal.

= Turning OFF Input 2 outputs Input 1.

Input 2 Turning ON Input 2 holds the previous output

Logical value.

Input 1| Ou’fpult This is a combination of a "hold previous value"

[Logicall |Logical function with 2 inputs/1 output and an ON-delay
- HOLD _I"'l_ N Hold timer.

101 - __mm + ON-delay timer Turning ON the hold output starts the ON-delay
| 2 timer. When the timer time has elapsed, the
nput I output turns ON. Turning OFF the hold output
turns OFF the output.

Input 1 Qutput
Logical Logical
[Logical [Logical This is a combination of a "hold previous value"
102 o -I_T || Hold function with 2 inputs/1 output and an
- — + OFF-delay timer OFF-delay timer.
Input 2 Turning ON the hold output turns ON the output.
Input 1 Output
|L:gical| |LogiEaI| This is a combination of a "hold previous value"
function with 2 inputs/1 output and a pulse (1
= _— Hold

103 HOLD = |_1 - shot) output.

- =_= + Pulse (1 shot) For information on the operation of a pulse (1
Input 2 shot), refer to Block selection 13 "Through
Logical output + Pulse (1 shot)".

Input 1 Output
|Lopgical| |LogiEaI| This is a combination of a "hold previous value"
function with 2 inputs/1 output and a

= = Hold retriggerable timer

104 HOLDJ |-+ |- : , 99 :

- — + Retriggerable timer For information on the operation of a
Input 2 retriggerable timer, refer to Block selection 14
Logical "Through output + Retriggerable timer".

Input 1 Output
|L:gical| |LogiEaI| This is a combination of a "hold previous value"
function with 2 inputs/1 output and a pulse train
= e Hold output
105 HooH | || -
EIINIne

Input 2
Logical

+ Pulse train output

For information on the operation of a pulse train
output, refer to Block selection 15 "Through
output + Pulse train output".
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110, 120, 130: Counter/Timer

Bloc.k Item Details
selection
Category | Counter/Timer
Function block | Up counter
Parameter 1: Target value
-m Input 1 -
Symbol P /:l_l' s Output
Input2 =
This is an up counter output with a reset input.
Parameter 1 sets the target value.
Input 2 is a reset signal. Turning ON Input 2 sets the counter value to 0.
110 Description | If the counter value is less than Parameter 1, +0.01 is added to the counter value
at the rise of Input 1.
When the counter value is equal to or more than Parameter 1, the output turns
ON. When the output is ON, nothing is added to the counter value.
Stopping the customizable logic sets the counter value to 0.
Inout 1 Logical value: When the count signal changes from OFF to ON, +0.01 is added to
P the counter value.
Input 2 | Logical value: Turning ON the input signal sets the counter value to 0.
Outout Logical value: ON when the counter value is equal to or more than the target
P value
Property settings | Parameter 1: Target value: 0.00 to 9990 (significant digits: 3 digits)
Category | Counter/Timer
Function block | Down counter
Parameter 1: Counter initial value
Input 1 -
Symbol E\ s Output
Input2 =
This is an down counter output with a reset input.
Parameter 1 sets the initial value.
Input 2 is a reset signal. Turning ON Input 2 sets the counter value to Parameter
120 1.
Description If the counter value is more than 0, +0.01 is subtracted from the counter value at
the rise of Input 1.
When the counter value is equal to or less than 0, the output turns ON. When the
output is ON, nothing is subtracted from the counter value.
Stopping the customizable logic sets the counter value to Parameter 1.
Inout 1 Logical value: When the count signal changes from OFF to ON, +0.01 is
P subtracted from the counter value.
Input 2 | Logical value: Turning ON the reset signal sets the counter value to Parameter 1.
Output | Logical value: ON when the counter value is equal to or less than the 0.
Property settings | Parameter 1: Target value: 0.00 to 9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

Block
selection

ltem

Details

130

Category

Counter/Timer

Function block

Timer with a reset input

Symbol

Parameter 1: Target time
Input 1 - {
Input2 = O

Output

Description

This is an OFF-delay timer output with a reset function.
Parameter 1 sets the target time.
Input 2 is a reset signal. Turning ON Input 2 sets the timer current value to 0.

Turning ON Input 1 turns ON the output and starts the timer. While the timer is
operating, the output remains ON without regard of the status of Input 1.

When the timer current value is equal to or more than the target time, the output
turns OFF without regard of the status of Input 1. Also, the timer stops and the
timer current value becomes 0.

If both Input 1 and Input 2 are turned ON, Input 2 takes precedence.

Stopping the customizable logic sets the timer current value to 0.

Input 1

Logical value: When the signal changes from OFF to ON, the timer is started.

Input 2

Logical value: Turning ON the reset signal sets the timer current value to O.

Output

Logical value: ON during the period from when Input 2 turns OFF and Input 1
turns ON to when the timer current value becomes less than the target time.

Property settings

Parameter 1: Target time: 0.00 to 9990 [s] (significant digits: 3 digits)
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2.3.3.18.5. [Analog] - Basic Operator
Calculator
2001: Addition
Bloc'k ltem Details
selection
Category | Calculator
Function block | Addition

2001

Parameter 1: Upper limit value

‘w Input 1 -

\Ll"
Symbol —|— m br—] Output w
@ED nput2 - ok
Parameter 2: Lower limit value
This is a combination of an addition circuit with 2 inputs/1 output and an output
limiter.
This function block performs an addition between Input 1 and Input 2 and outputs
Description | the result.
The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output=Inputi+Iinput2
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits
Property settings PP (sig 9 gits)

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2002: Subtraction

Bloc.k Item Details
selection
Category | Calculator
Function block | Subtraction
Parameter 1: Upper limit value
(NumericT T R |
Symbol n ——] Output w
@EED nput 2 L
Parameter 2: Lower limit value
This is a combination of an subtraction circuit with 2 inputs/1 output and an output
limiter.
This function block performs a subtraction between Input 1 and Input 2 and
2002 Description | outputs the result.
The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output=Inputi-Input2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits

Property settings PP (sig 9 gits)

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2003: Multiplication

Bloc.k ltem Details
selection
Category | Calculator
Function block | Multiplication
Parameter 1: Upper limit value
m Input 1 - ¥
Symbol X pH=—F Output (IED
@EED nput2 - i
Parameter 2: Lower limit value
This is a combination of a multiplication circuit with 2 inputs/1 output and an
output limiter.
This function block performs a multiplication between Input 1 and Input 2 and
2003 Description | outputs the result.
The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation Output=Inputlx Input?2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits

Property settings PP (sig 9 gits)

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2004: Division

Block

. Item Details
selection
Category | Calculator
Function block | Division
Parameter 1: Upper limit value
Q@EED nput1 L) [
Symbol — —r Output @
@EED nput2 - i
Parameter 2: Lower limit value
This is a combination of a division circuit with 2 inputs/1 output and an output
limiter.
This function block performs a division between Input 1 and Input 2 and outputs
2004 Description | the result.
The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation Output=Inputl+Input2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990

. Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2006: Absolute value

Bloc.k ltem Details
selection
Category | Calculator
Function block | Absolute value
Parameter 1: Upper limit value
Symbol umeric R \/H == W Numeric
L]
Parameter 2: Lower limit value
This function block determines the absolute value of the input and outputs the
2006 result.
Description | The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2007: Inverse addition

Bloc.k Item Details
selection
Category | Calculator
Function block | Inverse addition
Parameter 1: Offset
Symbol @@ED input - Inv. Output (D
Add
Parameter 2: Bias
This is an inverting circuit with 1 input/1 output.
It corrects the sign inversion value of the input based on Parameter 1 (offset) and
Parameter 2 (bias) and outputs it.
2007 Description | The output is limited by +9990.
This is similar to the function block "inverse addition switchover (4002)". For
information on the inverse addition switchover, refer to "4002: Inverse addition
switchover" in "[Digital + Analog] - Basic operator".
Calculation | output=- (Input - Function 1) + Function 2
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
Parameter 1: Offset: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Bias: -9990 to +9990 (significant digits: 3 digits)
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2010: Modulo

Bloc.k ltem Details
selection
Category | Calculator
Function block | Modulo
Parameter 1: Upper limit value
m Input 1 - vt
Symbol % —L  output (IED
@EED nput2 = e
Parameter 2: Lower limit value
Outputs the result of modulo operation of Input 1 and Input 2. Divides input 1 by
input 2 and outputs the remainder.
2103 Description | The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | Output = Input 1 mod Input 2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)

Property settings o o o o

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2103: Average

BIoc.k Item Details
selection
Category | Calculator
Function block | Average calculation
Parameter 1: Upper limit value
m Input 1 - ot
Symbol AveH—} output (EED
@ED nput2 = T
Parameter 2: Lower limit value
Outputs the addition average value of Input 1 and Input 2.
. The output is limited by the upper and lower limit values assigned to Parameter 1
2103 Description
and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | Output = W

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)

Property settings o o o o

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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Limiter

2005: Limiter

Bloc.k Item Details
selection
Category | Limiter
Function block | Limiter
Parameter 1: Upper limit value
Symbol @ ot ————d==l output QD
JT';
Parameter 2: Lower limit value
This is an upper/lower limiter circuit with 1 input/1 output.
This function block determines the limited value of Input 1 and outputs the result.
2005 The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.

Description If the upper limit value is equal to the lower limit value, the upper limit value is
interpreted as +9990 and the lower limit value as -9990. In this case, "Through"
appears under the symbol.

If the upper limit value is less than the lower limit value, the upper limit value is
output.
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2008: Variable limiter

Block
selection

ltem

Details

2008

Category

Limiter

Function block

Variable limiter

Symbol

Parameter 1: Input 3 (step number)

@EED input 1

T L
@D oz | == oupu QD
m Input 3: Function - \j

block output

Description

You can apply variable upper and lower limits to Input 3.

The output is limited by the upper and lower limit values assigned to Input 1 and
Input 2.

If Input 1 (upper limit value) is less than Input 2 (lower limit value), Input 1 is
output.

Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.

If you do not connect Input 3, the variable upper and lower limit values are applied
to the output (SOxx) with step number xx specified in Parameter 1.

If you connect Input 3, performing the auto step number assignment overwrites
Parameter 1 with the step number specified by Input 3.

Calculation

The lower limit is applied first and
Input 1 then the upper limit is applied.

~_Output If you do not connect Input. 3, replace
Input 3 Input 3 shown to the left with the
SN

Input 2 ) output of the step number specified
in Parameter 1.

Input 1

Numeric value: -9990 to +9990

Input 2

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990

Property settings

Parameter 1: Step number: 1 to maximum step number
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Selector
2101: Maximum selection

seBkIac(’:(t;iI:)n Item Details
Category | Selector
Function block | Maximum selection
Parameter 1: Upper limit value
Symbol w nput 1 Max = E - Output @
w Input 2 Sel. 5
Parameter 2: Lower limit value
Compares Input 1 and Input 2 and outputs the larger of the two.
2101

The output is limited by the upper and lower limit values assigned to Parameter 1

Description and Parameter 2.

For more information on the limit operation, refer to "2005: Limiter".

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990

Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2102: Minimum selection

seBIIec;(t;iI:)n Item Details
Category | Selector
Function block | Minimum selection
Parameter 1: Upper limit value
Symbol QED novt ' AWin] (o] output (D
QED input 2 =13Sel.j | ™
Parameter 2: Lower limit value
Compares Input 1 and Input 2 and outputs the smaller of the two.
2102

The output is limited by the upper and lower limit values assigned to Parameter 1

Description and Parameter 2.

For more information on the limit operation, refer to "2005: Limiter".

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

OQutput | Numeric value: -9990 to +9990

Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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Analog through
2005: Analog through

Bloc.k Item Details
selection
Category | Analog through
Function block | Analog through
Symbol @EED Input Output (TEED
2005 This is a through output of analog values without arithmetic processing.
Use “10 to 15: Through” for the through output a digital signal.
Description
Tip e Since this function is internally the same as "2005: Limiter", it has
the same number.
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990

Constant value
2009: Constant value

Bloc.k Item Details
selection
Category | Constant value
Function block | Constant value
Symbol Const. |-  Output (THED
Parameter 2: Constant value
2009 The value set for Parameter 2 is always output as a constant.
Description : ) ) o )
Tip e Since this function is internally the same as "2009: Linear
function", it has the same number.
Calculation | Output = Parameter 2
OQutput | Numeric value: -9990 to +9990
Property settings | Parameter 2: Constant value: -9990 to +9990 (significant digits: 3 digits)
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2.3.3.18.6. [Analog] - Comparator

Analog comparator

2051: Comparison 1
BIoc.k Item Details
selection
Category | Analog comparator
Function block | Comparison 1
Parameter 1: Deviation judgment value
m Input 1 -
Symbol @ Output
@EED nput2
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the two input deviations (including any
I sign).
Description equal sign) . .
If both the output ON and OFF conditions are true, the ON condition takes
2051 precedence.
. Output ON condition: Input 1 - Input 2 > Parameter 1 + |Parameter 2|
Calculation
Output OFF condition: Input 1 - Input 2 = Parameter 1 - |Parameter 2|
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Logical value: ON when the output ON condition is true; OFF when the output
OQutput e
OFF condition is true.
Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)
Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
2052: Comparison 2
Bloc.k Item Details
selection
Category | Analog comparator
Function block | Comparison 2
Parameter 1: Deviation judgment value
w Input 1 -
Symbol b Output
@EED nput2 2
Parameter 2: Hysteresis width
Description Dlgltally outputs the comparison result of the two input deviations (not including
equal signs).
2052
. Output ON condition: Input 1 - Input 2 > Parameter 1 + |Parameter 2|
Calculation

Output OFF condition: Input 1 - Input 2 < Parameter 1 - |Parameter 2|

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Logical value: ON when the output ON condition is true; OFF when the output

Output
YUY OFF condition is true.

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)
Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2053: Comparison 3

Bloc.k Item Details
selection
Category | Analog comparator
Function block | Comparison 3
Parameter 1: Deviation judgment value
m Input 1 - BS|
Symbol % Output
@EED nput2 3
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the two input deviations (absolute
o values) (including any equal sign).
Description " "
If both the output ON and OFF conditions are true, the ON condition takes
2053 precedence.
I i S
Calculation Output ON condition: [Input 1 - Input 2| = Parameter 1 + |Parameter 2|
Output OFF condition: |Input 1 - Input 2| = Parameter 1 - |Parameter 2|
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2054: Comparison 4

Block

. Item Details
selection
Category | Analog comparator
Function block | Comparison 4
Parameter 1: Deviation judgment value
m Input 1 - B
Symbol @ Output
w Input 2 - 4
Parameter 2: Hysteresis width
- Digitally outputs the comparison result of the two input deviations (absolute
Description . . .
values) (not including equal signs).
2054 I
. Output ON condition: |Input 1 - Input 2| > Parameter 1 + |Parameter 2|
Calculation
Output OFF condition: |Input 1 - Input 2| < Parameter 1 - |Parameter 2|
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
PU | OFF condition is true.
Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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2055: Comparison 5

Bloc.k Item Details
selection
Category | Analog comparator
Function block | Comparison 5
Parameter 1: Judgment value
Symbol @D nput - h Output
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the input and the judgment value.
2055 Description | The hysteresis width is configurable but takes effect only if the OFF condition is
true.
T S
Calculation Output ON condition: Input = Parameter 1
Output OFF condition: Input 1 < Parameter 1 - |Parameter 2|
Input | Numeric value: -9990 to +9990
Logical value: ON when the output ON condition is true; OFF when the output
OQutput e
OFF condition is true.
Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2056: Comparison 6

Block

. Item Details
selection
Category | Analog comparator
Function block | Comparison 6
Parameter 1: Judgment value
Symbol @EED nput - m Output
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the input and the judgment value.
2056 Description | The hysteresis width is configurable but takes effect only if the OFF condition is
true.
Calculation Output ON condition: Input = Parameter 1
Output OFF condition: Input 1 < Parameter 1 + |Parameter 2|
Input | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
PU | OFF condition is true.
Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2057: Comparison 7

Bloc.k ltem Details
selection
Category | Analog comparator
Function block | Comparison 7
Parameter 1: Deviation judgment value
m Input 1 -
Symbol @ Output
@EED nput2 2
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the two input deviations.
Description | The ON condition does not include the equal sign, and the OFF condition
2057 includes the equal sign.
. Output ON condition: Input 1 - Input 2 > Parameter 1 + |Parameter 2|
Calculation

Output OFF condition: Input 1 - Input 2 < Parameter 1 - |Parameter 2|

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Outout Logical value: ON when the output ON condition is true; OFF when the output

P OFF condition is true.
Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2058: Comparison 8

BIoc.k Item Details
selection
Category | Analog comparator
Function block | Comparison 8
Parameter 1: Deviation judgment value
m Input 1 - B
Symbol E} Output -Logical
w Input 2 - 8
Parameter 2: Hysteresis width
Digitally outputs the comparison result of the two input deviations (absolute
o values).
Description . . . »
The ON condition does not include the equal sign, and the OFF condition
2058 includes the equal sign.
Calculation Output ON condition: |Input 1 - Input 2| > Parameter 1 + |Parameter 2|
Output OFF condition: |Input 1 - Input 2| = Parameter 1 - [Parameter 2|
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3
Property settings | digits)

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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Equal

2071: Equal comparison 1

Bloc.k Item Details
selection
Category | Equal
Function block | Equal comparison 1
Parameter 1: Judgment value
Symbol @ED input = % Output
Digitally outputs the comparison result of Input 1 and the judgment value.
If Input 1 and the judgment value are equal, ON (true) is output.
2071 Description
Tip e Since this function is internally the same as "2071: Window
comparison 1", it has the same number.
) Output ON condition: Input = Parameter 1
Calculation N
Output OFF condition: Input # Parameter 1
Input | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
Property settings | Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits)

2059: Equal Comparison 2

Block

. Item Details
selection
Category | Equal
Function block | Equal comparison 2
@EED nput1 = :
Symbol @ Output
‘m Input 2 - 2
Parameter 2: Hysteresis width
Digitally outputs the comparison result of Input 1 and the judgment value.
Description )
2059 If Input 1 and Input 2 are equal, ON (true) is output.
ition: - =
Calculation Output ON condition: |Input 1 - Input 2| = |Parameter 2|
Output OFF condition: |Input 1 - Input 2| < |Parameter 2|
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
PU | OFF condition is true.
Property settings | Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

Window comparator
2071: Window comparison 1

Bloc.k Item Details
selection
Category | Window comparator
Function block | Window comparison 1
Parameter 1: Upper threshold
Symbol @ED input = % Output
Parameter 2: Lower threshold
Digitally outputs the comparison result of Input 1 and the upper/lower thresholds.
2071 Description | |f Input 1 is within the range between the upper threshold and the lower threshold
(including equal signs), ON (true) is output.
) Output ON condition: Parameter 1 = Input = Parameter 2
Calculation N
Output OFF condition: (Input > Parameter 1) or (Parameter 2 > Input)
Input | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
Parameter 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits)

2072: Window comparison 2

Bloc.k Item Details
selection
Category | Window comparator
Function block | Window comparison 2
Parameter 1: Upper threshold
Symbol @ED input = @i’ Output
Parameter 2: Lower threshold
Digitally outputs the comparison result of Input 1 and the upper/lower thresholds.
2072 Description | If Input 1 is within the range between the upper threshold and the lower threshold
(not including equal signs), ON (true) is output.
Output ON condition: Parameter 1 > Input > Parameter 2
Calculation
Output OFF condition: (Input = Parameter 1) or (Parameter 2 = Input)
Input | Numeric value: -9990 to +9990
Logical value: ON when the output ON condition is true; OFF when the output
Output .
OFF condition is true.
Parameter 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits)
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2.3.3.18.7. [Analog] - Converter
Converter
2009: Linear function
Bloc'k Item Details
selection
Category | Converter
Function block | Linear function
Parameter 1: Coefficient KA
Symbol @ED input - k - output (CHIED
Parameter 2: Coefficient K B
This function block calculates the linear function passed as input.
It calculates the output value based on the predefined linear function (one
2009 indicated in the "Calculation” field below). The coefficients of the linear function
Description | are given by Parameter 1 and Parameter 2.
The output is limited by the internal limiter.
When Parameter 1 is set to 0.00, no error occurs even if the input is not
connected.
Calculation | Output = K 4 xInput + K
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
Parameter 1: Coefficient K A’ -9990 to +9990 (significant digits: 3 digits)
Property settings

Parameter 2: Coefficient K B: -9990 to +9990 (significant digits: 3 digits)

2151: S$13 function code input
Block .
OC. Item Details
selection
Category | Converter
Function block | S13 function code input
Parameter 1: Value output when S13 is 20000
Symbol s{n::? = = Output w
Parameter 2: Value output when S13is 0
Converts the settings "0 to 20000/0 to
o 100%" of function code S13 (PID command Output
2151 Description | value) so that the values specified in
Parameter 2 and Parameter 1 are output Function 1
when S13 is 0 and 20000, respectively.
Calculation | Output = (Functuor;ég)ggncnon 2) x $13 + Function 2 Function 2 =——— > S13
(0%) (100%)
Output | Numeric value: -9990 to +9990 (limit value: £9990)
Parameter 1: Value output when S13 is 20000: -9990 to +9990 (significant digits: 3
Property digits)
settings

Parameter 2: Value output when S13 is 0: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2201: Inverse scale transformation

Bloc.k Item Details
selection
Category | Converter
Function block | Inverse scale transformation
Parameter 1: Value input when the output is 100
Symbol EED input  — = output (TIED
Parameter 2: Value input when the output is 0
Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%".
Use this function block for the connection to an analog output terminal.
Description | The maximum number of steps that can be
2201 used is two. Output
If you set both Parameter 1 and Parameter 100
2 to the same value, the output is 0.
. _ Input - Function 2 0 - Input
Calculation OUtpl‘It =100 x Function 1- Function 2 Function 2 Function 1
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: +£9990)
Parameter 1: Value input when the output is 100: -9990 to +9990 (significant digits: 3
Property settings | digits)
Parameter 2: Value input when the output is 0: -9990 to +9990 (significant digits: 3 digits)
2202: Scale transformation
Bloc.k ltem Details
selection
Category | Converter
Function block | Scale transformation
Parameter 1: Value output when the input is 100
Symbol TEED Input  — = Output (TIED
Parameter 2: Value output when the input is 0
Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%".
Description For input selection, you can only use a setting from 8000 to 8085
The maximum number of steps that can be used is
2202 two. Output
Function 1
Calculation | Output = (Function 1- Function 2) x Input + Function 2
100 )
Function 20 Input]
Input | Numeric value: -9990 to +9990
OQutput | Numeric value: -9990 to +9990 (limit value: +9990)
Parameter 1: Value output when the input is 100: -9990 to +9990 (significant digits: 3
Property settings | digits)

Parameter 2: Value output when the input is 0: -9990 to +9990 (significant digits: 3 digits)
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3001: Conversion 1

Block
selection

ltem

Details

3001

Category

Converter

Function block

Conversion 1

Symbol

Parameter 1: Upper limit value

@ED input = Q == Outut Q=D

Parameter 2: Lower limit value

Description

This function block calculates the quadratic function passed as input.

It calculates the output value based on the predefined quadratic function (one
indicated in the "Calculation” field below).

The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.

For more information on the limit operation, refer to "2005: Limiter".

You can select whether to manually set or automatically calculate coefficients
Ka, Kg, Kc.

To manually set the conversion coefficients

You can set each coefficient using an exponent. For example, you can specify
a mantissa and an exponent part to define Kaas follows:

K p = (Mantissa) x 10(ExPonent pary

The same appliesto Kg and K.

To automatically calculate the
conversion coefficients

Output

Specify the input-output
relationship using three points: Y3
(X1, Y1), (Xz, Yz), and (X3, Y3)
Then each coefficient is set to
an automatically calculated
value.

N(Sperating
point 3
(X3,Y3)

The maximum number of steps Y,
that can be used is one for both T Operating
Conversion 1 (3001) and i point2
Conversion 2 (3002). 7] E— - .operaﬁngf (X2,Y2)
When you use both Conversion 1 [ point1

(3001) and Conversion 2 (3002), 0 X X X
Conversion 1 (3001) takes 1 2 3 Input
precedence.

If you use two or more instances of Conversion 1 (3001), the one with the
smallest step number takes precedence.

Do not select Auto Calculation when you want to write to the keypad. Refer to
"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details.

Calculation

Output = KA X (Input )2 +Kpg X Input + Kc

Input

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990 (limit value: £9990)

Property settings

To manually set the conversion coefficients:

Mantissas of K5, Kg,and Kc:-9.999to 9.999

Exponent parts of K,, Kg,and K¢:-5t05
To automatically calculate the conversion coefficients:

X1, Y1, X5, Yo, X3, Y3:-9990 to +9990 (significant digits: 3 digits)
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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3002: Conversion 2

Block
selection

ltem

Details

3002

Category

Converter

Function block

Conversion 2

Symbol

Parameter 1: Upper limit value

@D nput - 4--%- Output (IEED

Parameter 2: Lower limit value

Description

This function block calculates the output value based on the predefined function
(one indicated in the "Calculation" field below).

The output is limited by the upper and lower limit values assigned to Parameter 1
and Parameter 2.

For more information on the limit operation, refer to "2005: Limiter".

You can select whether to manually set or automatically calculate coefficients
Ka, Kg, Kg-

To manually set the conversion coefficients

You can set each coefficient using an exponent. For example, you can specify a
mantissa and an exponent part to define K, as follows:

K= (Mantissa) x 1O(Exp0nent part)

The same appliesto Kg and K.

To automatically calculate the

conversion coefficients Y Operating
. . int 3
Specify the input-output ?;Rz)

relationship using three points:
(X1, Y1), (X2, Y2), and (X3, Y3).
Then each coefficient is set to .

. Operating
an automatically calculated point 2
value. (Xz,Yz).

The maximum number of steps Operating
that can be used is one for both point 1
Conversion 1 (3001) and XYe)
Conversion 2 (3002). | e P-
When you use both Conversion 1 !
(3001) and Conversion 2 (3002), i i
Conversion 1 (3001) takes 0 X Xo X3 X
precedence.

If you use two or more instances of Conversion 2 (3001), the one with the
smallest step number takes precedence.

If the calculation result inside | is a negative value, '0' is output.

Do not select Auto Calculation when you want to write to the keypad. Refer to
"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details.

Calculation

Input +
Output = TP T KA xKc
KB

Input

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990 (limit value: £9990)

Property settings

To manually set the conversion coefficients:

Mantissas of <A, Ke and Kc:-9.999t0 9.999

Exponent parts of KA, Ks ,and KC: -5t05
To automatically calculate the conversion coefficients:

Xl, Y , XZ, Y2 , x3, Y3 :-9990 to +9990 (significant digits: 3 digits)
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2.3.3.18.8. [Digital + Analog] - Basic operator

Basic operator
4001: Hold

BIoc.k Item Details
selection
Category | Basic operator
Function block | Hold
Parameter 1: Upper limit value
@ED nput1 o s
Symbol HOLDp=—} Output (TEED
Input2 = =
Parameter 2: Lower limit value
Turning OFF Input 2 (logical value) outputs Input 1 as-is.
Turning ON Input 2 (logical value) holds the output value.
4001 Description | The output is limited by the upper and lower limit values assigned to Parameter 1

and Parameter 2.
For more information on the limit operation, refer to "2005: Limiter".

Input 1 | Numeric value: -9990 to +9990
Logical value: OFF: Input 1 is output.

Input 2 . .

ON: The previous output value is output.
Output | Numeric value: -9990 to +9990
. Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings . N . .

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

4002: Inverse addition switchover

BIoc.k Item Details
selection
Category | Basic operator
Function block | Inverse addition switchover
Parameter 1: Offset
@EED nput1 0
Symbol 0/0- = Output m
y nput2 = LvAddO
Parameter 2: Bias
Turning OFF Input 2 (logical value) outputs Input 1 as-is.
Turning ON Input 2 (logical value) outputs the calculation result of the expression
- indicated in the "Calculation" field below.
Description
This is similar to the function block "inverse addition (2007)". For information on
4002 the inverse addition, refer to "2007: Inverse addition" in "[Analog] - Basic
Operator".
Calculation | Output when Input 2 is ON = -(Input 1 - Parameter 1) + Parameter 2
Input 1 | Numeric value: -9990 to +9990
Logical value: OFF: Input 1 is output.
Input 2 ON: Outputs the calculation result of the expression indicated in
the "Calculation” field above.
Output | Numeric value: -9990 to +9990 (limit value: £9990)
. Parameter 1: Offset: -9990 to +9990 (significant digits: 3 digits)
Property settings : N - .
Parameter 2: Bias: -9990 to +9990 (significant digits: 3 digits)
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4005: Low pass filter

Bloc.k Item Details
selection
Category | Basic operator
Function block | Low pass filter
Parameter 1: Time constant [s]
@ED nput1 LPF
Symbol Output
y itz LWL put (ED)
Turning OFF Input 2 outputs Input 1 as-is.
Turning ON Input 2 outputs Input 1 after applying a low pass filter to it.
Description | The low pass filter calculation uses the previous output value. When Input 2
4005 changes from OFF to ON, the previous output value is the output value before the
low pass filter is applied. The previous output value is '0' when the customizable
logic is started or the CLC terminal is turned ON.
Input 1 | Numeric value: -9990 to +9990
Input 2 Logical value: OFF: Input 1 is output.
ON: Outputs Input 1 after applying a low pass filter to it.
Output | Numeric value: -9990 to +9990
Property settings | Parameter 1: Time constant: 0.01 to 5.00 [s] (A value of 0.00 disables the filter.)
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4006: Change rate limit

Bloc.k Item Details
selection
Category | Basic operator
Function block | Change rate limit
Parameter 1: Rise time [s]
m lnPUt1 Ram
- p
Symbol - Output m
y nput2 LN\ P

Parameter 2: Fall time [s]

The change rate limit function block limits the change amount per unit time of

Input 1.

You can also set the limit value by specifying the time for Input 1 to change from 0

to 100. You can specify the limit values separately for the rise amount and the fall

amount.

Explanation | Turning OFF Input 2 outputs Input 1 as-is.

Turning ON Input 2 outputs Input 1 after applying the change rate limit to it.

4006 The change rate limit calculation uses the previous output value. When Input 2
changes from OFF to ON, the previous output value is the output value before the
change rate limit is applied. The previous output value is '0' when the
customizable logic is started or the CLC terminal is turned ON.

Input 1 | Numeric value: -9990 to +9990
Input 2 Logical value: OFF: Input 1 is output.

ON: Outputs Input 1 after applying the change rate limit to it.
Output | Numeric value: -9990 to +9990

Property settings

Parameter 1: Rise time: Time for Input 1 to change from 0 to 100
0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, no limit is
applied.)

Parameter 2: Fall time: Time for Input 1 to change from 0 to 100
0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, the same
time as Parameter 1 is used.)
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Chapter 2 Functional Description

6101: PID dancer output gain frequency

Block
selection

ltem

Details

6101

Category

Basic operator

Function block

PID dancer output gain frequency

Symbol

Parameter 1: Gain ratio [%]

@ED input 1
= Dancer PID output (D
Input2 =MV mode sw P

Parameter 2: Frequency lower limit value [Hz]

Description

This function block is used in the dancer control PID.

You can select whether to calculate the frequency correction amount by assuming
that the 100% of the PID output is equivalent to the maximum output frequency or
the commanded frequency (by the line speed command).

Setting Input 1 to 0 outputs 0.

Setting Input 1 to a non-zero value outputs the value calculated using the
expression indicated in the "Calculation" field.

The output is intended for use in monitoring.

If the dancer control is enabled (i.e., function code JO1 is set to 3), the function
block calculates the frequency correction amount using the expression indicated
in the "Calculation" field below and reflects it to the output frequency.

The maximum number of steps that can be used is one. If you use two or more
instances of PID dancer output gain frequency (6101), the one with the smallest
step number takes precedence.

Function 1

Maximum output
frequency | == 20

(fel ~o—¥Q Output

—_d | g »
—_——1 = d

0o Turns ON when dancer

|contro| is enabled

Set frequency

[Hz] 0

PID output

frequency
[Hz]

Input 1

Input 2

Calculation

Qutput

Input 1 Input 2 Para:neter

0 OFF/ON Not used 0

OFF Not used If set frequency is equal to or more than
Parameter 2, the set frequency is
output.

Non-zero If the set frequency is less than
ON Parameter 2, Parameter 2 is output.

Output

Function 1
100

PID output [%]
100
Output frequency - Set frequency -+ Frequency correction amount

Non-zero x Maximum output frequency

Frequency correctionamount = x Output

2-147



Block

. ltem Details
selection
Input 1 Numeric value: If setto 0, O is output.
If set to a non-zero value, the calculation is performed.
Logical value: OFF: Calculates the frequency correction amount from the set
frequency.
Input 2 ON: If Parameter 1 is 0, same as OFF.

6101 If Parameter 1 is non-zero, the function block calculates the
frequency correction amount from the maximum output
frequency.

Output | Numeric value: -9990 to +9990
Parameter 1: Gain ratio: 0 to 200 [%]
Property settings

Parameter 2: Frequency lower limit value: 0 to 500 [HZz]
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2.3.3.18.9.

Selector

4003: Selection 1

[Digital + Analog] - Selector

Block
selection

ltem

Details

4003

Category

Selector

Function block

Selection 1

Symbol

Parameter 1: Value output when the Input 2 is ON

@ED nput1 0 output (D
[Cogiaal] input 2 =1

Description

Turning OFF Input 2 outputs Input 1 as-is.
Turning ON Input 2 outputs Parameter 1.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Input 1 is output.

ON: Parameter 1 is output.

Output

Numeric value: -9990 to +9990

Property settings

Parameter 1: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3
digits)

4004: Selection 2

BI
oc.k Item Details
selection
Category | Selector
Function block | Selection 2
Parameter 1: Value output when the Input 2 is OFF
- @ro
Symbol Input = @_g‘o— L Output (TRED
Parameter 2: Value output when the Input 2 is ON
4004 ) Turning OFF Input 2 (logical value) outputs Parameter 1.
Explanation
Turning ON Input 2 (logical value) outputs Parameter 2.
Input Logical value: OFF: Parameter 1 is output.
ON: Parameter 2 is output.
Output | Numeric value: -9990 to +9990
Parameter 1: Value output when Input 2 is OFF: -9990 to +9990 (significant digits: 3 digits
Property settings

Parameter 2: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3 digits)
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5001 to 5014: Selection 3-1 to 3-14

Block
selection

ltem

Details

5001
to
5014

Category

Selector

Function block

Selection 3-1 to 3-14

Symbol

[Example in 5001]

@BD nput 1 f=5
@D vtz =0 5007

Output (TEXED

Description

Turning OFF the output (SOxx) with step number xx (where xxis 1, 2,..., 14)
outputs Input 1.

Turning ON the output (SOxx) outputs Input 2.
The output (SOxx) must be a logical value.
SO01 to SO14

Logical value: OFF: Input 1 is output.
ON:

Input 2 is output.

Input 1

Numeric value: -9990 to +9990

Input 2

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990

Property settings

Not used

5101 to 5114: Selection 4-1 to 4-14

Block
selection

ltem

Details

5101
to
5114

Category

Selector

Function block

Selection 4-1 to 4-14

Symbol

[Example in 5001]

@BD nput1 f——o
nput2 = S22FOT

Output (XD

Description

Turning OFF Input 2 outputs Input 1.

Turning ON Input 2 outputs the output (SOxx) with step number xx (where xx is 1,
2,...,14).

The output (SOxx) must be a numeric value.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Input 1 is output.

ON: The output (SOxX) is output.

Output

Numeric value: -9990 to +9990

Property settings

Not used

2-150




Chapter 2 Functional Description

5000: Selection 3

Bloc.k Item Details
selection
Category | Selector
Function block | Selection 3
Parameter 1: Step number
Input 1
@D nput 1
Symbol @ED mevt2 otk oupu @I
Input 3: Function _|
block output
Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.
Turning OFF Input 3 outputs Input 1.
5000 o Turning ON Input 3 outputs Input 2.
Description

Input 3 must be a logical value.
If Input 3 is not connected, the function block uses the output (SOxx) with step
number xx specified in Parameter 1 instead of Input 3.
If you connect Input 3, performing the auto step number assignment overwrites
Parameter 1 with the step number specified by Input 3.

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Input 3 Logical value: OFF:InputlfsoummL

ON: Input 2 is output.
Output | Numeric value: -9990 to +9990
Property settings | Parameter 1: Step number: 1 to maximum step number
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5100: Selection 4

Bloc.k Item Details
selection
Category | Selector
Function block | Selection 4
Parameter 1: Step number
Q@D nput 1 _——=
Symbol nput2 4 L output (TIED
@D input 3: Function  _ _A
block output
Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.
Turning OFF Input 2 outputs Input 1.
5100 o Turning ON Input 2 outputs Input 3.
Description

Input 3 must be a numeric value.
If Input 3 is not connected, the function block uses the output (SOxx) with step
number xx specified in Parameter 1 instead of Input 3.
If you connect Input 3, performing the auto step number assignment overwrites
Parameter 1 with the step number specified by Input 3.

Input 1 | Numeric value: -9990 to +9990

Input 2 Logical value: OFF: Inputl fs output.

ON: Input 3 is output.
Input 3 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Property settings | Parameter 1: Step number: 1 to maximum step number
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2.3.3.18.10. [Digital + Analog] - Function Code

Function Code
6001: Function code read

BIoc.k Item Details
selection
Category | Function Code
Function block | Function code read
Parameter 1: Function code group
Parameter 2: Function code number
This function block outputs the function code data specified by Parameter 1 and
Parameter 2.
It can correctly read out the following data formats:
[11, [21, [3], [4], [S], [6], [7], [8], [9], [10],
[12], [22], [24], [29], [39], [37], [45], [61],
67], [68], [74], [92], [93
6001 [67], [68], [74], [92], [93]

However, the value is limited within the range of -9990 to 9990. In addition, for
Description [29], the function block displays 20000 as 100%.

Do not use any other data format than above because the function block cannot
correctly read other formats.

If an attempt is made to read out a non-existent function code, the output will be 0.

For more information on the data formats, refer to Chapter 5 of the Appendix "
RS-485 Communication User's Manual".

Alternatively, you can refer to the data format for each function code on the
[Function code edit] window accessible from the [Function Code List] window. For
more information on [Function code edit], refer to "2.3.1.1. Function Code Edit".

Input | None

Output | Numeric value: -9990 to +9990 (limit value: +£9990)

Parameter 1: Function code group
Property settings

Parameter 2: Function code number: 00 to 99
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6002: Function code write

Bloc.k Item Details
selection
Category | Function Code
Function block | Function code write
Parameter 1: Fixed to function code group U1
@D nput 1
Symbol 55 Write
Input2 =
Parameter 2: Function code number
Select the function code you want to write to, using Parameter 1 and Parameter 2.
You can select function codes U171-. The written value is retained even if the
power is turned off.
Turning ON Input 2 writes Input 1 to the selected function code.
If Input 2 is OFF, nothing is written.
The values written to function codes U171- are stored in the volatile memory
Description (RAM) and, once the inverter detects low voltage, stored in the non-volatile
6002 memory (EEPROM).

The maximum number of steps that can be used is one per function code.
If you use two or more instances of function code write (6002), the one with the
smallest step number takes precedence.
When you perform the auto step number assignment, a warning that states
"Output 1 for function code write is not connected" appears but you can ignore it
safely.

Input 1 | Numeric value: -9990 to +9990
Logical value: OFF: Nothing is written.

Input 2 ON: Input 1 is written to the function code selected by

Parameter 1 and Parameter 2.
Output | None

Property settings

Parameter 1: Function code group: U1

Parameter 2: Function code number: 71 to 75
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6003: function code change

Block
selection

ltem

Details

6003

Category

Function Code

Function block

Function code change

Symbol

Parameter 1: Function code group

@ED nput1 4
Input 2

_;gcmm'de

Parameter 2: Function code number

Description

Select the function code whose setting you want to change, using Parameter 1
and Parameter 2.

Turning ON Input 2 changes the setting of the selected function code to Input 1.

However, this does not change the setting stored in the non-volatile memory
(EEPROM).

Turning OFF Input 2 restores the original setting of the selected function code.
The maximum number of steps that can be used is one per function code.

If you use two or more instances of function code change (6003) for the same
function code, the one with the smallest step number takes precedence.

Before reading and writing function codes from the loader or copying them to the
keypad, be sure to restore the original setting of the selected function code by
turning OFF Input 2.

If you use the function code change (6003) function block to change the setting of
a function code and then load the setting into the loader or copy it to the keypad,
the data that is being changed is read, rather than the data stored in the
non-volatile memory. Moreover, if you select [Write 2 to y97] and write the data
from the loader, the data that is being changed by the function code change
(6003) function block is stored in the non-volatile memory.

Before stopping the customizable logic, you are recommended to turn OFF Input
2,

Stopping the customizable logic with Input 2 still ON retains the data that is being
changed by the function code change (6003) function block. To restore the
original setting from this state, you must (1) start the customizable logic and turn
OFF Input 2, (2) turn off the power to the inverter, or (3) restore the original setting
using a keypad, etc.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Nothing is written.

ON: Input 1 is written to the function code specified by
Parameter 1 and Parameter 2.

Output

None

Property settings

Parameter 1: Function code group

Parameter 2: Function code number
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Bit Extraction
6011: Bit extraction [S]

Block
selection

ltem

Details

6011

Category

Bit Extraction

Function block

Bit extraction [S]

Symbol

Parameter 1: Function code number

= Bit

= Output
E W) Read

Parameter 2: Bit position

Description

This function block outputs the bit information of the communication function code
(S code) specified by Parameter 1 and 2.

It can correctly read out the following data formats:
[14], [15], [16], [43], [44], [77], [78], [91]

Do not use any other data format than above because the function block cannot
correctly read other formats.

If an attempt is made to read out a non-existent function code, the output will be 0.

For more information on the data formats, refer to Chapter 5 of the Appendix "
RS-485 Communication User's Manual".

Alternatively, you can refer to the data format for each function code on the
[Function code edit] window accessible from the [Function Code List] window. For
more information on [Function code edit], refer to "2.3.1.1. Function Code Edit".

Input

None

Output

Logical value

Property settings

Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point)

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point)

6012: Bit extraction [M]

seBIIec;(t;iI:)n Item Details
Category | Bit Extraction
Function block | Bit extraction [M]
Parameter 1: Function code number
Symbol &bﬂzgd = Output
6012 Parameter 2: Bit position
This function block outputs the bit information of the communication function code
Description | (M code) specified by Parameter 1 and 2.
See “6011: Bit extraction [S]” for other operations.
Input | None

Output | Logical value

Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point)
Property settings

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point)
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6013: Bit extraction [W]

Bloc.k Item Details
selection
Category | Bit Extraction
Function block | Bit extraction [W]
Parameter 1: Function code number
Symbol = Bit | Output
g @M Read
6013 Parameter 2: Bit position
This function block outputs the bit information of the communication function code
Description | (W code) specified by Parameter 1 and 2.
See “6011: Bit extraction [S]” for other operations.
Input | None
Output | Logical value
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point)
Property settings

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point)

6014: Bit extraction [X]

Block

. ltem Details
selection
Category | Bit Extraction
Function block | Bit extraction [X]
Parameter 1: Function code number
Symbol B Bit L output
(X Read
6014 Parameter 2: Bit position
This function block outputs the bit information of the communication function code
Description | (X code) specified by Parameter 1 and 2.
See “6011: Bit extraction [S]” for other operations.
Input | None
Output | Logical value
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point)
Property settings

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point)
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6015: Bit extraction [M]

Bloc.k Item Details
selection
Category | Bit Extraction
Function block | Bit extraction [Z]
Parameter 1: Function code number
Symbol G- Bit | Output
g Z M Read
6015 Parameter 2: Bit position
This function block outputs the bit information of the communication function code
Description | (Z code) specified by Parameter 1 and 2.
See “6011: Bit extraction [S]” for other operations.
Input | None
Output | Logical value
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point)
Property settings

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point)
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2.3.4. Trace

Trace function
You can observe the inverter operation status as continuous waveform information.

The loader provides the following three types of the trace function:
Reads the sequential waveform data from the inverter and displays it

(1) Realtime trace:
in a graph. This is suitable for long-time monitoring.

Reads the waveform data of the inverter operation status based on an
arbitrary trigger saved in the inverter's memory and displays it in a
graph. This is suitable for monitoring with small sampling times.

(2) Historical trace:

Tip e The Realtime trace and Historical trace can be used when communication with the

inverter is possible.

Offline setting function
When the loader cannot communicate with the inverter to be traced, you cannot use the trace

function but you can configure the advanced waveform settings. This is useful when you want to

prepare the trace settings in advance.
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2.3.4.1. Trace Function

Select [Menu] > [Trace] from the main menu or click on the main window toolbar and
then click [Real-Time Trace], [Historical Trace], or [Trace back] to open the corresponding

trace function window.

[Real-time Trace]

/\/ To graphically view the running
R

status of the inverter in realtime.

[Select Online/Offline] window is displayed first.

Real-time Trace Ed

Tateet Iverter: IN.:, 10 11 INW1 LI

O Offline

oK I Cancel

[Historical Trace]

/\/ To graphically view the historical
H

tracing data.

Select [Online], then select [Target Inverter]
in the dropdown list.

Click [OK].

Then the trace window (see “2.3.4.2.Realtime Trace”, “2.3.4.3.Historical Trace”) is displayed.

Tip e Forthe [Target Inverter], the model registered in [Connection Settings] (see
“1.5.5.2.Connection Setting”) is displayed.
e Select an inverter that can communicate with the loader in the [Target Inverter]. If
communication is not established, an error is displayed and the trace window is not

displayed.
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2.3.4.2. Realtime Trace

The following is the description of the [Realtime Trace] window.

— Subwindow — Click this button to save the trace data
- [Monitor], [Graph position adjustment], and (Refer to "2.3.4.4. Saving the Trace Data")
[File information] tabs
(Refer to "2.3.4.7. Subwindow") —— Click this button to copy the waveform monitor

The trace operation status is displayed — (Refer to "2.3.4.5. Copying the Trace Data Screen")

Click this button to start/stop the trace operation

Display time frame and sampling time

Cursor setting and position display

The position is displayed only when "vertical"
is selected.
(Refer to "2.3.4.7. [1] Cursor")

Cursor position

Trace type is displayed

Show/hide the
subwindow

Scrollbar for moving the vertical cursor
-lofx|

¢ Real-time trace.RT2

|
/Mnmtur [ Graph pesition adjustment | File information\aes h &
Gursar @ Vertical & Gusar A Cursor B Cursor AF
Gursor & Cursor B Cursor AB _‘ O Manmar € Horizontal l—
- = 5000 13000 2000
A-CHI Ouput frequency (oeore 5.2 || T - 5150 ( SIRASUE? C OFF
—e [e50 [T [F= ampline hierval ms /. 4 |

A-CH2 Output voltzge v 1=

E E T8
[ I [
[ I [

D-GH1 FWD terminal A-CHI 0 :
JoN Jor I Output frequency N
D—C;;EN—W tglag:mal I =t 30[Hz/div]
[ I [ A-CH2 u
P Output voliage
1000w/div]
[ [ [
I I I D-CH1 [I:
A FWD terminal L
@ External signal jnpart | Advanced., o | | D-cHs n:
Settine J 1 terminal [ : : : | : | : | : ; : ; :
160ms 2165 4l16s | Bibs  Bi6s  I0i6s  1206s| 14ibs  1606s  1G16s 20165 22065 2416s  26iibs 41
_ I L i
T
[Setting] — Waveform screen Cursor A Cursor B Waveform —
Click this button to : . screen vertical
) rollbar for moving the horizontal cursor
import/export the Scrollbar for moving the horizontal curso scrollbar
settings. L Ad d f ti
(Refer 0"2.3.4.9 vanced waverorm settings Waveform screen
Setting Export/Setting Advanceq‘ settings for each channel. horizontal scrollbar
Import") (Refer to "2.3.4.8. Advanced Waveform
Settings")

— External signal import

Click this button to import the customizable logic trace data. This button appears once you save the trace monitor
information.
(Refer to "2.3.4.10. Combination with the Customizable Logic Function")

Tip e The realtime trace works even if without a trigger setting.
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2.3.4.3. Historical Trace

The following is the description of the [Historical Trace] window.

— Subwindow

Click this button to save the trace data

- [Monitor], [Graph position adjustment], and (Refer to "2.3.4.4. Saving the Trace Data")
[File information] tabs

(Refer to "2.3.4.7. Subwindow")

The trace operation status is displayed —

Display time frame and sampling time —

Cursor position

Trace type is displayed

Show/hide the
subwindow

* Historical trace

— Click this button to copy the waveform monitor
(Refer to "2.3.4.5. Copying the Trace Data Screen")

[~ Click this button to start/stop the trace operation

Cursor setting and position display

The position is displayed only when "vertical"
is selected.
(Refer to "2.3.4.7. [1] Cursor")

Scrollbar for moving the vertical cursor
-1l

(Wonier | raph position adjustment | Fils |r\format\on| Historical tjace | | $toe e oy (E“;j“’t('”ls) P
~Cursor . Veieal & s & " GusorB € Qurser
Gursor £ Cursor B Cursor AB - 1250 man ~, | " Horizontal l— ,— l_
i Output frequency (befors s sz Trs - G50s m C OFF = _ -
[ia7 {EED 1827 rmpling Interval S0ms @ 4] | !
A-GH2 Output valtage % - i " : .
[i7m 7w [0 F : : L
L
| | [ (0 !
J— I
I I =il !
D-CH1 FWD terminal A-GHT 0 :
JoN N [ Output frequency r
befare sli
D'CFJEN i ‘m‘”a‘ | f il 30[H2/div]
[ [ [ A-GH2 n
R Qutput voltage
1000w/div]
[ [ [
I I I D-GH1 0 :
=) FWO terminal r
Aganced. o | oz ok
B ¥1 terming| L : : : : : : : : : : : :
J Ums  B00ms 1M0s | 150s  200s  250s  800s | 850s  4D0s  #50s 500 550s B0l 650s 9
\ o il ] »1]
[Setting] Waveform screen Cursor A Cursor B Waveform —
Click this button to screen vertical
import/export the Scrollbar for moving the horizontal cursor scrollbar
(Ssz;';?‘?é 349 Advanced waveform settings Waveform screen horizontal
Setting Export/Setting Advanced settings for each channel. scrollbar
Import") (Refer to "2.3.4.8. Advanced Waveform
Settings")

@ e To use the historical trace, you must configure the trigger settings. For
information on trigger settings, refer to "2.3.4.8. [2] A-Ch1 to A-Ch4 (analog
settings)" and "2.3.4.8. [3] D-Ch1 to D-Ch8 (digital settings)".
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2.3.4.4. Saving the Trace Data

To save the trace data, click the [Save] button around the top center of the trace or select [File]
-> [Save As...].

Save |

When selecting [Save] for the data for the first time, the following dialog will open in the same
manner as when selecting [Save As ...]. Select [Save to ...] and [Save as type] and enter the file
name under which the data is saved in [File Name]. Then click [Save] to save the file.

[Zooveas x|
\i_\}\H) [ = 1DECVFD > Doesa Loader » DATA v &3 [ searchDaTA (L)

Organize v  New folder = @

1=, Recent Places ;I Name - | Date modified I Type

4 Libraries
¢| Documents
g' Music
b= Pictures

B videos

*Q Homegroup

"M Computer
£, Local Disk (C2)

~ 4 [T |

File name: [Rea!-time trace

Save as type: |Real-h'me trace waveform data File (*.RT2)
Real-time trace waveform data File (*.RT2)

Ll o

Real-time trace waveform data File (*.CSV)
~ Real-time trace graph image(*. JPG)
Hide Folders Real-time tracegam |m§2e;",sl\-'m

- Realtime trace waveform information: *.RT2, *.CSV (comma separated format)
- Historical trace waveform information: *.HT2, *.CSV (comma separated format)
- Each trace graph image: *JPG, *.BMP

@ e Once you save a *.CSV, *.JPG, or *.BMP file, you cannot reload it into The
Loader.

@ ¢ Opening a saved *.RT2, *.HT2, trace data file in Doesa-Loader makes the
[START/STOP] button unavailable.

If you plan to run the trace with the same settings as the saved trace data, save
the settings by selecting [Setting] -> [Setting Export]. For more information on
[Setting Export], refer to "2.3.4.9. Setting Export/Setting Import".
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2.3.4.5. Copying the Trace Data Screen

To copy the content of the trace data screen, click the [Copy] button around the top center of the
trace screen. The data is copied to the clipboard, from which you can paste the data to a
document or elsewhere.

Capy. |

WP b —ARTI

=lalx
E2p SINMIRE | v 008 | Feai-tima trace | WER (A ,‘”};”‘“ﬁ‘"i - -
" T Om=UA n=ue N-YRAE
T F Chilt 1 =T cm
=5 START/STORT) T
e TN 150 = - 160ms - M.16s T
_ @ 2OV Phrs o -
g | PP 2 " ﬂ
wex [ = -
A=A
Er r
Cel, ) oo B
RSO BARNLCT) Coci2 P
wcHl b
etk B LSRN CRIE)
r 00dre]
0MRTILRE r 1 H
el
e ACH2 D
sk PR = 7 e
CaEm @ m r
BOUREIE)
boH S S S S
 rvomr
e T — L
BEe | o Vins 2 UG Bls ik Wl R0 Wi Tl WG i 20 i % j

2.3.4.6. Printing the Trace Data

To print the trace data, select [File] -> [Print] with the trace screen active. The following is an
example printout of trace data:

[tracs tipsl

[F116 nass]

[inwerter mas1]
[Printing tiss]

[Trace start tims]
[rriggsr gneration &ats]
[samiing intsral]
[Mestrams por 1 0(V]

Faal-tims wrac
Faal-tims wracs f2
007/0/T 004204
WMW/N 19003
1ms

oy

[(anst] [Fiiter]  [Trigger conitions] [Ra0] [curser 4] [urscr 8] [Curccr 28]  [WW N2 ]
B Ipf-100m  Clsabl e *® 2.00 0. ° '
a2 Ipf-100m  Dlsable: * ee 0.0 1
(=1 Clsaties * FF o 1
-2 Olsatled = FF o 1
[comant]
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2.3.4.7. Subwindow

[1] Cursor

The boxes on the cursor subwindow display the measurement value or status of each channel at
the respective cursor positions.

— Cursor value monitoring area Cursor settings
Analog: 4 channels Vertical: 2 (either cursor A or cursor B or both)
Digital: 8 channels Horizontal: 2 (either cursor A or cursor B or both)
Channels not visible in the monitoring area can be Hide

displayed using the vertical slides bar at the cursor
value monitoring area.

Analog channel — Show/hide the Slides bar for moving
cursor value subwindow the vertical cursor
e — = 3}
(Manitor | Graph position adjustment | File infarmatich D) | Real-time trace Stop Save Gopy || Cursor tms)
_Cu,swl . /S—I—I @ Vertcal @ Gusor A Cursor B O Cursor AB
Cuwsor A Cursor B Gursor AR 5000 et o ioing " Horizontal
= = BO00 1anon 2000
= S ey (Hmos. B e IV swarreTor || orr
2 [Eem [% | Samplig Tterval 20me K| i |
A-GH2 Output valtage | : '

ok

L@ 340 200.0 166

| | I ;
\_ | I y, R / - I f
i ]
GOHW D terminal A ACHI OF A - ! ‘
[on [on I Output freauency r : i i : i o i : : : :
before sli - H h h " h h H h h H \ h
DioE)ZN_W tfgg‘"a‘ | ¢ » 30[Hz/Adivl [ . : ! : ]I : : N
- 1 .
[ — [ [ A-CH2 n: // rrrrrr - - : e
[ Output voltage [ I i
10004dliv] i
| | L IR B N oo
1
I I ! 9 D-CH1 0 : E lI
N L | WD ermiva r A B I
External sienal ingort | Advarced. | | ooz ok T - B ! o
Settine J 1 terminal : : : : : : : : : : : :
LI 1fillms 21‘63 dlés ﬁlés HTIﬁs TD{ES l?T‘ﬁs lﬂlﬁs 16{53 IET‘ES QEITIES 22{53 Zt{ﬁs 251‘63 ;I
| T L]
] |
— Digital channel Cursor value Cursor A Cursor B Waveform screen
cursor value monitoring area horizontal scrollbar

vertical slides bar

Use the scroll bar to move to the waveform screen to be analyzed and click the point to be
observed in the graph. The cursor will move to that position. The cursor movement position is
the sampling point (time point) closest to the clicked point. The trace data of all channels on the
cursor appears on the [Monitor] tab at left.

Alternatively, you can move the cursor using the cursor movement scrollbar or by dragging the
mouse.

The cursor keys on the keyboard are also available.

However, while tracing, neither waveform screen nor cursor can be moved.
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[2] Adjust Graph Position
The graph position adjustment subwindow allows you to adjust the graph position for each

channel.

Monitor Graph position adjustment | File information |=l

Scale

ISEI E OIS

Feszet positioning |

Cptimize v-axiz |

Peak detection |

—Pozitioning
r-axis I 150 E
K-axis IIJ E

Aimplitude |1.DIJ E

Timeframe per 1 DY

|28 vl ADIY

Mumber of auxiliary lines
T

]

Stvle line.. |

—Select Channel

Wizible
~ ACHI
C A-GH?

r
-
C D-CH1 ™
 D-GH2?
r
-
-
r
r
-

Graph position reset

Select Channel

Select the channel for which you want to adjust the
graph position and color.

Display
Display only the channels you have marked with .

Y axis display position

Set the Y axis display position of the selected channel.
The upper edge is position 0.

X axis display position
Set the X axis display position of the selected channel.
The left edge is position 0.

Amplitude

Set the amplitude of the selected channel by
magnification.

Change the magnification using point O for reference.
As you change the amplitude, the [Scale] value
changes accordingly and the graph display also
changes according to the [Scale] value.

Scale

Set the scale of the selected channel.

Enter the numeric value per DIV for the Y axis.
This setting applies to the analog setting channels
only.

Reset the display position and amplitude setting of the selected channel to the initial values.
Ch1l = 50 and the value increments by +50 for the subsequent channels.

- Y axis display position:
- X axis display position:
- Amplitude: 1.00

Optimize Y axis graph

Each Channel = 0

Arrange the Y axis display position and scale of the displayed channels without overlapping by channel.
Reset the amplitude setting to the initial value.

-'Y axis display position:

- Scale:

Detect waveform peak

Ch1 =100 and the value increments by +100 (analog) or +50 (digital) for subsequent

channels.

Set the scale value based on the multiple of 50 so that the maximum value can be within

two grids.

For example, 50Hz/DIV if the maximum value is 1Hz or 100Hz/DIV if the maximum value

is 53Hz.

Move Cursor A to the maximum value of the selected channel automatically. If there are two or more peaks, the cursor

moves to the earliest one.

This setting applies to the analog setting channels only.

Display range in one DIV

Set the time to be displayed in one DIV for the X axis on the waveform screen.

Historical trace and Trace back: 1 ms to 10 min
Realtime trace: 20 ms to 60 min

You cannot specify a time smaller than the sampling time.

Number of grid auxiliary lines

Set the number of grid auxiliary lines for the Y axis.
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Color setting

The color setting data is held. Once you obtain the waveform, you can change the color setting.

Line property

% Channel
 Cursor A
" Gursor B
= Trieger

' Girid

' Backeround

Select tem to chanee the line property.

o]

Cancel

X

Channel line

Cursor line A

Cursor line B

Trigger line

Grid line

The line color, type, and thickness settings are as follows:

Select the line color, type, thickness for the selected channel.

Select the line color, type, thickness for Cursor A.

Select the line color, type, thickness for Cursor B.

Select the line color, type, and thickness of the trigger line.

Select the line color, type, and thickness of the grid line.

Graph background color setting

Select the waveform monitor background color.

- Color
Style line (=) Color =]
Basic colors:
A =
o (N . o
N |
Type of line —_— N u
HEEE |
N r
Thickness —
Custom colors:
Caution : Dashed line is a thin line. o rrrrr
rrrrrrir
OK ] [ Cancel [ Define Custom Colors »3> ]
0K Cancel
- Line type - Line thickness
Style line [===a) Style line (E3a)
Type of ine _ i Type of line _
Thickness - - Thickness

Caution : Dashed | -.

OK Cancel
|

—0

Caution : Dashed I_

Co ] —
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[3] File Information

The file information subwindow displays the date/time information for the trace. Also, you can

add a comment.

The date/time information uses the clock managed by the operating system of the PC. Even if
you trace an inverter model that has a realtime clock (RTC), the loader uses the clock managed

by the operating system of the PC.

The content of the file information subwindow is saved to trace data files (RT2 and HT2 files).
When you open a saved file, the information contained in it is displayed. The content of this
subwindow is not contained in a file saved by selecting [Setting] -> [Setting Export] (i.e., an

EXRTM or EXHIM file).

The content of the file information subwindow is included in the printout of a waveform.

Monitar I Graph position adjustment

Refresh |

Trace start date 2017509527

Trace start time 09:33:18

Trigeer generation date 201770927

Trigeer generation time  08:33:27

Camments

]
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Refresh

Click this button to update the time information (such
as the trace start date) displayed in the file
information subwindow.

When you start the trace with the file information
subwindow open, its display content will not be
automatically updated. It will be updated when you
click the [Refresh] button or open a different
subwindow.

Trace start date

The date when the trace was started.

Trace start time

The time when the trace was started.

Trigger detection date

The date when a trigger was detected.

Trigger detection time

The time when a trigger was detected.

Comment

You can add a comment.
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[4] Data selection

The data selection subwindow allows you to select, read, and erase the trace back data.

Monitor Graph position adjustment Data selection

Select Trace-back Data

No.1

Item

Type

S/N
Date/Time
Runtime
Trigger type
Alarm (Main)
Subcode
Sample time

Points before trig.

Points after trie.
A-Ch1
A-Ch2
A-Ch3
A-Chd
D-Chi
D-Ch2

Nl 9

Read waveform

v Reload

Data ~

VF1A-G21A554.
124222B3333AA
148

Alarm

oc3

2

Sms

400

100

Qutput frequency¥n...
Output current¥n(In__
DC link circuit volt...
Y1 terminal

Y2 terminal
WD deveaieal

Erase data
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Select Trace-back Data

Select the trace back data number to be checked.

Reload

Click this button to get the list of traceback data
stored on the connected keypad. After received data
list properly, the trace back data drop-down list will
be updated.

Trace back information

Displays additional information such as inverter
status and trace conditions related to the traceback
data selected in the drop-down list.

Read waveform

Click this button to read the waveform of the
traceback data selected in the drop-down list and
display it on the waveform screen.

Erase data

Click this button to erase the trace back data
selected in the drop-down list from the connected
keypad.



2.3.4.8. Advanced Waveform Settings

[1] Channel Configuration
You can set the configuration of analog channels and digital channels to be traced. For more
information on the settings for each channel, refer to [2] to [5].

The loader stores in memory the settings for each inverter model. One you open the [Realtime
Trace] or [Historical Trace] window, the [Advanced settings] window displays the previous
settings for the inverter model you want to trace this time.

In the [Traceback] window, the [Advance settings] window displays the settings of the currently
connected inverter. If the target inverter is not connected, the previous settings will be displayed.

Ch configuration settings

Select the number of channels you want to use.
The number of analog channels can be up top 4, and the total number of analog and digital channels can be up to 8.
However, if you select 4 analog channels, then you cannot select digital channels.

Advanced setting
Gonfieuration | Analee Gh | Digital Ch | Analog Gh check | Digital Gh check | Other |
(Th canfiguration settings
—Analog —Digital
Lo} Mot available
—fnalog —Digital
0 2 oy Ll
3 ! Disabled
L5
—#nalog —Digital
(ol | (Ol 3 (o'}
o  Di
2 Disabled 5 B
—Analog —Digital
1 oy Wy Lol
(ol | € Dizabled
B ol r6 (ol
—fnalog —Digital
o oy oy (ol
o o
Dizabled Dizatiled 5 5 o s
Select Inverter INY Selection
[Mo. 1L 1IN LM,
[ ]

[Select inverter]
Displays the inverter selected in the [Select Online/Offline] window (see [2.3.4.1.Trace Function]).

You can trace only the inverter displayed here.
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[2] A-Ch1 to A-Ch4 (analog settings)
You can configure analog channel settings.

zl

'Gonfieuration Analoe Ch | Digital Gh | Analee Ch check | Digital Gh check | Giher |
A=Ch1 | A-Gh2 | A-Cha | A-Chd |

Sienal —Filter —Trigget —————————————————
Select Signal —Filter setting —Trigeer setting
IOutput frequency (before slip) LI * OFF ¥ Dizabled

 Manual filter  Enabled
[~ Alternate name " Peak filter
I  Buto filter Trigeer level

555 35
Time constant
e

Set the filter time constant to Walue [000 E [Hel

twice or more the sampling time

Trigeer edee
C g ) Dawn

Gancel |

Signal

From the list box, select the signal you want to trace. You can select, for example, the output

frequency, the output current, or the output voltage. (Available signals differ depending on the
inverter model.)

Alternative name

You can assign an alternative name to the signal.

Once you assign an alternative name, that name appears in the waveform screen and
subwindow.

You cannot use single-byte @, #, and \ characters.
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Filter

The filter settings for each channel are as follows:

—Filter OFF
—Filter zetting ——— Select this if you do not want to use a filter.
" OFF
. Manual filter

& Manual filter €
Traces the data after a low pass filter is applied.

" Peak filter N .
Select the filter time constant from the list box below.

 Buto filter
Peak filter

Time constant Traces the maximum value within the sampling time.

|1[I[I "I [ms]

Auto filter

Traces the data after a low pass filter is applied.

Set the filter time constant to

twice or more the zampling time.

Note

H

Tip

The filter time constant is given by the following expression:

Filter time constant = Sampling time x 3.2

Filter time constant

Select the filter time constant when you use the manual filter.
The valid range is 1 [ms] to 100 [ms].

The filter time constant should be at least twice the sampling time.

To use a filter for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in"1.1.2. Loader Functions by VF1A Series Inverter Model".
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Chapter 2 Functional Description

Trigger

The trigger settings for each channel are as follows:

—Trigeer Trigger setting
—Trigger setting —————————— Select the channel for which you want to configure a trigger.
"~ Dizahled An analog channel accepts only one trigger.
* Enabled

Trigger level

Trigger level Select the appropriate trigger level depending on the data quantity handled
for the monitor item selected for each channel.
55 35
‘ | Trigger edge
Select the trigger rise or fall edge.

alue |n_nn =] [Hl

Trigger edee
o« Up " Down

Tip e To use a trigger for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in "1.1.2. Loader Functions by VF1A Series Inverter Model".
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[3] D-Ch1 to D-Ch8 (digital settings)

You can configure digital channel settings.

zl

Gonfieuration | Analoz Ch  Digital Gh | Analeg Ch check | Digital Gh check | Giher |

D-Ch1 | D-h2 | D-Cha | D-Ché | D-Chs | D-Ché | D-Gh7 | D-ché |

Signal

Select sienal block

I]nput terminal LI
Select signal
IFWD terminal LI

™ ARernate name

—Trigger setting

& Disabled

 Law level

" High level

" Up edee

" Down edee

Gancel |

Select signal

From the list box, select the signal you want to trace. You can select, for example, the X or Y
terminal. (Available signals differ depending on the inverter model.)

Alternative name

You can assign an alternative name to the signal.
Once you assign an alternative name, that name appears in the waveform screen and

subwindow.

You cannot use single-byte @, #, and \ characters.

Trigger setting

The trigger settings for each channel are as follows:

— Trigger setting

' Dizabled

 Low level

= High level

" Up edee

" Down edee

Trigger setting

Select one of the following: Low (L) level, Hi (H) level, Up edge, Down edge.

A digital channel accepts one or more trigger settings.

You can specify triggers with the "OR" or "AND" condition.

* Refer to "Trigger_detection conditions” in “[5] Other Settings".
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Tip e To use a trigger for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in "1.1.2. Loader Functions by VF1A Series Inverter Model".

[4] Ch Setting Check (analog/digital)
The data configured for each channel is listed. To save the settings, click the [OK] button. To
cancel the settings, click the [Cancel] button.

x|
Gonfiguration | Analoz Ch | Digital Gh £ # |9§__9h_§h§§!<___§| Digital Gh check | Other |
Waveform name Wisible Filter Trigger INW Ho.
| A-Gh1  Output frequency (hefore slip) ON Ipt-100m= Dizabled 1 |
| A-Gh?  Ouput voltae oN Ipt-100ms Disabled | |
oarel_|
x|

Configuration | Analoe Ch | Digital Gh | Analos Gh check | other |

Waveform name Wisible Trigger INW Mo.
| D-Gh1  FWD terminal ON Up edee i |
| D-chi 1 terminal oN Disabled I |
weol_|
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[5] Other Settings (including sampling time setting)
Configure the advanced settings for the waveform monitor.

Advanced setting

.Cnnflguratlon I Analog Ch | Digital Ch I Analog Ch check I Digital Ch check  Other I

—Sampling Time

—5et frace start time and date

[~ Start at specified time and date

—Detection conditions of frigeer
(* Detects on OR conditions.
" Detects on AND conditions.

File name

Time |5Ums vl .
Time 21:20:41 =
Date 201940913 -
—Pre-Trigger Position
L
) - t
I 100 ffearits —Auto Save

[~ Save data automatically after detecting the trigeer.

|Rea|—t|me Trace RT2

Erowee.. |

Mote : This setting does not take effect if trace window is not apen.

—File size of saving
¥ Divide savine file

—Trace command Sampling counte of one file I ?5005 counts
¥ | Enable bufferine trace command Total file size I IUE MB
wesl_|

Sampling time setting

The following sampling time settings are

Sampling Time

available.
Time Im
Realtime
Sampling | When using the dedicated communication command (*) | Wwhen not using the | Historical
Sg?iﬁg If the pgrt §pecifieq in . If the pgrt §pecifieq in . cor?wi(wjlijcnei‘(t:(;?ion Trace/ back
[Communication Setting] is | [Communication Setting] is
RS-485 connected USB connected command
0.5ms X X X A
1 ms X X X @)
2ms A (note) A (note) X O
5ms A (note) A (note) X O
10 ms O (note) O (note) X O
20 ms O (note) O (note) X O
50 ms O (note) O (note) X O
100 ms ©) O X @)
200 ms O (@) O O
O: Selectable A Selectable depending on the inverter model X: Not selectable

(*) You can only use the dedicated communication command with an inverter model that
supports it.

@ e When using the realtime trace with a small sampling time, the graph display may
be incomplete if the communication speed is insufficient.
Please increase the communication speed as much as possible.
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Pre-trigger position

Set the number of sampling points of data preceding the trigger position.

Pre-Trigger Position

p—

1
A | 100 == counts

The setting can be up to 999 counts for the realtime trace or up to 499 counts for the historical
trace.

Trigger detection conditions

Configure two or more trigger detection conditions for digital channels with the "OR" or "AND"
condition.

Analog: 1 channel only
Digital: 1 to 8 channels

Detection conditions of trigeer

* Detects on OF conditions.

{" Detects on AND conditions.

@ ¢ To configure the sampling time setting, pre-trigger position, and trigger detection
conditions for the realtime trace, you have to check the [Enable buffering trace
command] check box on the [Advanced waveform settings] -> [Other settings]
window.

Enable buffering trace command

Check this check box to have the realtime trace use the data buffered in the inverter's memory.

Trace command

[« Enable buiferine trace command

Tip e This setting is not available for the historical trace and the trace back.
e The dedicated communication command must be supported by the inverter
model. For more information, refer to "Table 1-1" in "1.1.2. Loader Functions by
VF1A Series Inverter Model".
¢ If the dedicated communication command is supported by the inverter model
connected, this check box is enabled automatically, and cannot be unchecked.
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Trace start time and date

Set the date/time when to start the trace.

—aet trace start time and date

W Start at zpecified time and date.

Tirne [o0:00:00 =
Date f01/0172017 =]
Auto Save

Use this setting if you want to have the trace data automatically saved.

—Auto Save
[V Save data automatically after detecting the trigeer.

File name [C:¥Program Files¥ DEC VFD¥Doesa

Note : This setting does not take effect if trace window is not open.

The data is automatically saved:
o When you stop the realtime trace by clicking [START/STOP].

« When the accumulated trace data becomes more than can be written to the specified
number of split files during the realtime trace.

« When the size of all split files exceeds the total file size during the realtime trace.

« After the historical trace waveform has been drawn.

File size of saving (available for the realtime trace only)

This setting is available if the trace auto save check box is checked.

Divide saving file

—File =ize of saying

== - - Currently this check box is
W [Divide zavine file
always checked.
WDHE file | 7500 = count Split files are always saved.
Jotalflesce [ 10=o M
’\

Sampling count of one file

This represents approximate data counts per channel saved in one file. This setting is fixed to 7500 counts.
For example, if the sampling time is 20 ms, one file contains the data from 0 ms to approximately 150,000 ms
(= 7500 x 20 ms).

— Total file size

Specify the total file size in MB. If the size of all saved files exceeds this size, the realtime trace is stopped and
no more files are saved

2-178



Chapter 2 Functional Description

The file name of a split file is the file name specified under [Auto Save] suffixed by a serial
number suchas 1, 2, 3 before the file name extension.

For example, if the file name specified under [Auto Save] is "Realtime_Trace.RT2", the names of
the split files will be

"Realtime_Trace-1.RT2", m X

"Realtime_Trace-2.RT2",

" . " Exceeded the total file size.
Realtime_Trace-3.RT2", b Evit to zave the file,

and so on.

When the size of all split files exceeds the total file
size, the dialog at right appears and the realtime
trace is stopped.
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2.3.4.9. Setting Export/Setting Import

With VFD Doesa-Loader, you cannot open saved trace data files with an extension of *.RT2,
*.HT2 and run the trace.

To run the trace with the same settings as the saved trace data, you should follow these steps:

Step 1: When you save the trace data, save the settings separately from the trace data by
using the [Setting Export] function.

Step 2: When you run the trace, first open the same trace screen as step 1 with the loader
connected to the inverter you want to trace.

Step 3: Load the settings by using the [Setting Import] function.

[
I
Advanced... |

To use [Setting Export] and [Setting Import], click the -
[Setting] button under the [Advanced Waveform Settings]
button.

The [Settings] window appears.

Setting Export

m x| Saves the advanced waveform settings to a file.

Click this button to open the [Save As...] dialog.

| Setting Export e I

Setting Import 0—|—— Setting Import

Loads the advanced waveform settings from a file.
Click this button to open the [Open] dialog.

Cancel 0—|—— Cancel

Click this button to close the [Settings] dialog.

File types

*EXRTM: Realtime trace format. You can import these files only when working with the
[Realtime Trace] window.

* EXHIM:  Historical trace format. You can import these files only when working with the
[Historical Trace] window.

*EXTBM: Trace back format. You can import these files only when working with the [Trace
back] window.

The inverter model must match the currently selected one on the trace window. If it does not
match, a warning dialog displays, then it blocks to import settings.
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2.3.4.10. Combination with the Customizable Logic Function

After writing your created settings for the customizable logic function to the inverter or if the

comparison result shows no difference, you can monitor your selected symbol using the
realtime trace.

@ ¢ Alimited set of functions is available with some inverter models. Refer to "1.1.2.
Loader Functions by VF1A Series Inverter Model" for details.

[1] How to Monitor a Customizable Logic Signal Using the Realtime Trace

The following is the basic procedure for monitoring a customizable logic signal using the
realtime trace:

Write the circuits to the (Refer to Section

inverter 2.3.3.9)

Select the trace monitor (Described in
this section)
[

Save trace monitor file (Described in
this section)

Use the customizable logic
editor screen

(Described in

External signal import i )
this section)

(Described in this

Advanced waveform settings section. Also refer to | Use the [Realtime Trace]
Section 2.3.4.8.) window
Start the realtime trace (Refer to Section
2.3.4.2)

Start the customizable logic

function

v
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- Selecting the Trace Monitor

On the customizable logic editor screen, right-click the symbol whose waveform you want to
monitor.
Select [Trace monitor select] on the context menu.

B Doesa Loader - Customizable Logic - CstmogicPrj1 - [Customizable Logic - CstmLogicPr1] - B x
> File Merw  Setup  View Window Help - 8 X
DEE &SRO /ORL W xR ¢ @EEEs 32 0300A 25 |
. . Seloct Iverter Humber of use steps L e —
Customizable Logic [ 1T TorvT ] I et I | | 4_.\ f:& De:fullmlwl DigitabAnalog | FB |
3 Promamtl | fBace ke d
A Project "CstmlogicPril’ — i e D- |
B Man iy Step 4 -»—- --
2] Programd ) ':’ - g =3 SRR
s e e ‘ ; ~
3 FE (Commen)
e & | 4
- [
L Monitor select L +
~Franl Step 2 . Mocdos Deselact, | . Comment
. : E i [ ] Trace monitce salect ] i A
Wiefnctol | O Treouh
L Copy | B
StepNo. / Friosity setting —E]-—E-—ﬂ-
A AND
Propest |
Al 12 lel s | | E_E'E'Eﬂ |
Gnw b e EEE0T
| Type Code Message
B
T —
Tip e [Trace monitor select] is applicable to a function block only. It is not applicable to

an input or output terminal or function block (FB).

- Save Trace Monitor File

Click [Trace monitor file] on the toolbar to save the information of the symbol for which you
selected the trace monitor.

<

- External Signal Import

Select on the main window toolbar and click [Realtime Trace] to open the [Realtime Trace]
window.

[Realtime Trace]

/\/ To graphically view the running
R status of the inverter in realtime.

Alternatively, you can open the [Realtime Trace] window without using the Quick Access
menu by selecting [Menu] -> [Trace] -> [Realtime Trace] from the main menu.
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¢ Real-time trace

Giraph position adjustment I File infor mation |A
|

—Cursar
Cursor A Curzor B Cursor 8B
A-GHI Output frequency (before s.. Hz j
| | |
A-GH2 Output voltage W
| | |
| | |
| | |
D-CGH1 FWD terminal
| | |
D-GH2 —— 1 terminal
| | |
Click the [External signal import] button at the
! ! ! lower left of the [Realtime Trace] window.
! ! ! (Using the customizable logic editor screen,
| | [ load the information saved by clicking [Save
| trace monitor file].)

———
@rnal signal imm Advanced.. |
Setting |

Tip e The [External signal import] button appears once you click [Save trace monitor
file].

- Advanced Waveform Settings

- Next, click the [Advanced...] button at the right

Gonfiguration Analog Ch | Digital Gh | Analog Ch ch of the [External signal import] button and
A-Ch1 | a-ch2 | A-Ch3 | A-Chd | configure the channel settings.
Signal
Select Sienal
Step 3 Timer x| To select a signal within the customizable logic
Ay AP onitor =l function, use the [Analog Ch] tabs for both

FID eommand analog and digital signals.
PID output

FID command 1

FID feedback 1

Terminal [12] input voltage

Terminal [C1] input current (G function]

'[germinal EIOI] input voltaze (W2 functiond) /| The customizable logic signals are added at
e Epee
Qutput frequency (pu) the bottom of the [Select Signal] list.

Rotation speed (r/min)
Torgue command
Ctput torque

Torgue current commangd
Torgue current

Magnetic—flux command : . .
DG link circuit voltage For information on other settings, refer to
e ekl "2.3.4.8. Advanced Waveform Settings".

Temperature inzide the jrverter

Temperature of heat =i

Cutput current

Motor output power (%)
e =—deviation gnele

Step & Timer
Step 3001
Step 3012
Step 3 DD

4]
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- Graph Position Adjustment

Manitor  Graph position adjustment | File informatio

—Pozitiohing
-axiz
H-axis
fmplitude

Scale
2

200 :
I[I E
|1.I]|] E

DI

—aelect Channel ——

" A-GHI
+ A-GH2
" A-CH3
 A-GHY

Yizible
v

<1 ® A

To monitor a digital signal, set [Scale] to '2' on

the [Graph position adjustment] tab.

To start the trace, click the [START/STOP] button at the top of the trace screen.
Refer to "2.3.4.1 Trace Function" for details.

[2] Saving the Customizable Logic Signal Trace Data
You can save the customizable logic signal trace data in the same way as other trace data.
Refer to "2.3.4.4. Saving the Trace Data" for details.

At this time, however, you should save the customizable logic project data as well.

The same applies when you perform [Setting Export] from [Settings] under the [Advanced
waveform settings] button. Be sure to save the customizable logic project data as well.
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[3] Opening the Saved Customizable Logic Signal Trace Data

Before you open a file that contains the customizable logic signal trace data (i.e., an RT2 or
RT1 file), you should click [External signal import] to load the same signal information as when
the trace data was collected.

@ o |If the signal information you load by clicking [External signal import] is not
appropriate, the loader will not correctly display the signal names, units, and
data step sizes.

Therefore, you should follow these steps to open the trace data:
First, open the customizable logic project data used when the trace data was collected.

Next, select [Trace monitor select] -> [Save trace monitor file] -> [External signal import],
similarly to when you collected the trace data.

For more information on [Trace monitor select] and [Save trace monitor file], refer to
"2.3.4.10. [1] How to Monitor a Customizable Logic Signal Using the Realtime Trace".

Finally, open the trace data.

()

Open the customizable logic

project file

|

Trace monitor select

Use the customizable logic

| editor screen

Save trace monitor file

|

External signal import

|

Open the trace data

Use the [Realtime Trace]
window

The same applies when you perform [Setting Import] from [Settings] under the [Advanced
waveform settings] button.

Before you use [Setting Import] to load the customizable logic signal settings saved using
[Setting Export], you should use [External signal import] to load the same signal information as
when you performed [Setting Export].
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2.3.4.11. Offline setting function

You can make setting up the trace function without communication to any inverter. It is useful in
case you want to prepare setting in offline situation in advance.

Select [Menu] > [Trace] from the main menu or click on the main window toolbar and then
click [Real-Time Trace], [Historical Trace], or [Trace back] to open the corresponding trace
function window.

[Real-time Trace] [Histarical Trace]

/\/ To graphically view the running /\/ To graphically view the historical
R status of the inverter in real-time. H tracing data.

[Select Online/Offline] window is displayed first.

Real-time Trace | ] Select [Offline].
' Online Click [OK].
Tareet Inverter: INn_ 1L 1] INY1 ;I

0]1¢ I Cancel

Then [Offline Settings] window is displayed.

Otfline Settine Select the inverter model to be configured.

9 Select the Model Click [OK].

o]'8 | Caticel |

The trace window (see “2.3.4.2. Realtime Trace” or “2.3.4.3.Historical Trace”.) is displayed.

Tip e The model list shows only the inverter models that support the tracing function (see
“1.1.2.Loader Functions by VF1A Series Inverter Model”).
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The Trace window displayed as offline cannot perform the trace function, as the START/STOP
buttons disabled.

In order to make setting up the Trace function, open [Detailed Waveform Settings] (see
[2.3.4.8.Advanced Waveform Settings]).

To save or restore your settings, use Export/Import function. (see [2.3.4.9.Setting Export/Setting
Import]).
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2.3.5. Test Run

Select [Menu] -> [Test run] -> [Drive operation] from the main menu or select on the main
window toolbar and click [Test run] to open the [Drive operation] menu under the toolbar.

Tip

the

appears depressed during rotation.)

REV : Click this button to rotate the motor in
reverse direction. (The button — Frequency command/operation command change (update)

appears depressed during rotation.)

[Test Run]

To controlrun the inverter through
loader.

You cannot perform operations if you have selected [Data in Keypad] for [USB
Connection] on the [Communication Setting] window. If you cannot perform
operations for another reason, refer to "2.3.5.3. If You Cannot Use the [Drive
operation] Menu".

You should use [Test run] only while connected to the inverter.

Depending on the communication link condition, it may take a long time to detect
the communication target. The loader does not respond until the communication
target is detected. To avoid the inability to operate the loader for a long time, you
should use the loader in an environment with as good communication conditions
as possible.

Do not attempt operations with an inverter that has password protection enabled.
If the loader does not respond or is forcibly terminated, the means to stop the
inverter may be limited, which can be very dangerous.

— Drive operation buttons —— Test Run
FWD: Click this button to rotate the motor in Click this button to open the [Drive operation] menu under the
the forward direction. (The button toolbar. Click it again to close the [Drive operation] menu.

Sends the frequency/operation command source to the

STP : Click this button to stop the inverter. inverter.
RST : Click this button to reset the alarm.

Dl

& Doesa Loader - Quick Access Menu

File Menu Setup View Window Help

= (@b Sl 2 BEE alfcilele RS
ﬂ 3me No.1[ TIEQUPT

Frequency command (update) j Target

Sends the frequency command [Hz] to Select the device you want to test-run.
the inverter.

Update

Click this button to synchronize the display of the drive operation buttons,
the frequency command, and the frequency command/operation
command change with the inverter.

To close the [Drive operation] menu, click the [Test run] button on the toolbar (see above).
Alternatively, you can close it by selecting [Menu] -> [Test run] -> [Drive operation] from the main

menu.
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In addition, you can display the terminal operation buttons under the [Drive operation] menu by
selecting [Menu] -> [Test run] -> [Terminal operation] from the main menu.

Menu | Setup View Window Help

Function code edit... . = = aya|l G“;—j ,
Test Run 4 | %I Drive Operation
Operation Menitor... v

[£]

Terminal Operation

Customizable Logic

i OB

Schedule Operation

Trace 3

Cluick Access Menu...

&2 Doesa Loader - Quick Access Menu

File Menu Setup View Window Help

)= XB5= W= =0@0 8Kk : I HEA S
| RST | 0.0012

X1 X2 x3 x4 X5 X6 X7 X8

Terminal operation buttons 41

3 : Freq. = Loader, Ope. = Loader

v Mo EQUPT v G

X1, X2, ...,X9: These buttons allow you to turn ON X1 to X9 terminals. The number of terminals you can operate
varies depending on the inverter model.

XF: Click this button to turn ON the FWD terminal.

XR: Click this button to turn ON the REV terminal.

To hide the terminal operation buttons, select [Menu] -> [Test run] -> [Terminal operation] from the
main menu, similarly to when you display them.

@ ¢ When you use the terminal operation buttons to operate a terminal, the logical
inversion settings of the terminal function are ignored.

The following example shows what occurs when the free run command "BX" is
selected with EO1.

Function ) ) Loader's terminal operation
Physical terminal
code data button
. Free run when the X1 terminal is ON
(normally open) Free run when the [X1] button is
1007 Free run when the X1 terminal is OFF ON (normally open)
(normally closed)

You should be careful, especially when you configure the forced stop ("STOP")
using a logical inversion (E01=1030). If the physical terminal is enabled, you can
run the inverter by turning OFF the X1 terminal. However, if the operation

command from the loader is enabled, you cannot run the inverter unless you turn
ON the [X1] button.

Once you open the [Drive operation] menu, the [Frequency command/operation command
change] field shows "0: Freq = Inverter, Ope = Inverter", which means that you cannot use the
loader to change the frequency command or start/stop the inverter. Hence, you cannot click the
operation buttons [STOP], [FWD], and [REV] on the loader screen.

Similarly, once you display the terminal operation buttons, you cannot click the [X1], [X2], [X3],
[X4], [X5], [X6], [X7], [X8], [X9], [XF], and [XR] buttons.

The drive operation and terminal operation buttons are enabled only when "Ope = Loader" is
shown in the [Frequency command/operation command change] field.

Also, the frequency command is enabled only when "Freq = Loader" is shown.

However, the [RST] button is always enabled.
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2.3.5.1.

Operating the Inverter from the Loader

Click ™ next to the [Frequency command/operation command change] field and select

"1: Freq = Loader, Ope = Inverter", "2: Freq = Inverter, Ope = Loader", or "3: Freq = Loader,
Ope = Loader" from the pull-down list depending on the command you want issue from the
loader. See the table below.

IE: Freq. = Loader, Cpe. = Loader

=]

0 : Freq. = Inverter, Ope. = Inverter
1: Freq. = Loader, Ope= Inverter
2 : Freq. = Inwverter, Ope. = Loader
3: Freq. = Loader, Ope. = Loader

Command vou want [Frequency Frequenc Drive operation | Terminal operation
issue from :,he loader command/operation corﬂmang buttons [FWD], buttons [X1] to
command change] [REV], [STOP] [X9], [FWD], [REV]
0: Freq = Inverter, Disabled Disabled Disabled
None Ope = Inverter (Not operable) (Not operable) (Not operable)
(default)
Frequency command 1: Freq = Loader, Enabled Disabled Disabled
q y Ope = Inverter (Operable) (Not operable) (Not operable)
Overation command 2: Freq = Inverter, Disabled Enabled Enabled
P Ope = Loader (Not operable) (Operable) (Operable)
Frequency command |3: Freq = Loader, Enabled Enabled Enabled
Operation command Ope = Loader (Operable) (Operable) (Operable)

To issue both the frequency command and the operation command from the loader, follow these

steps:

1) From the [Frequency command/operation command change] field, select "3: Freq = Loader,
Ope = Loader" and click [Apply].

2) This enables the frequency command field as well as the drive operation buttons [STOP],
[FWD], and [REV], the terminal operation buttons [X1], [X2], ... (hnumber of terminals you can
operate varies depending on the inverter model), and the [FWD] and [REV] buttons.

3) Enter a frequency in the frequency command field and click [Apply]. To rotate the motor in the
forward direction, click the [FWD] button. To rotate the motor in the reverse direction, click
the [REV] button. To stop it, click the [STOP] button.

=

Tip e When you close the [Drive operation] menu, the loader automatically writes "0:

Freqg = Inverter, Ope = Inverter".

2.3.5.2.

Monitoring the Inverter Operation Status from the Loader

You can monitor the inverter operation status using the operation monitor and the realtime trace.

Refer to "2.3.2. Operation Monitor" and "2.3.4.2. Realtime Trace.
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2.3.5.3. If You Cannot Use the [Drive operation] Menu

You may be unable to use the [Drive operation] menu in the following cases:

[1] A communication Error Has Occurred
If a communication error has occurred between the loader and the inverter and you attempt to
use the [Drive operation] menu or a terminal operation button, the following dialog appears:

X

Doesa Loader

[ , Communication is impossible with an inverter.
! Does it retry?

If you respond by clicking [Cancel], the drive operation buttons, the frequency command field,
the [Frequency command/operation command change] field, and the terminal operation buttons
will be disabled. Even if the communication is restored, the loader will not automatically resume
the communication with the inverter with which a communication error occurred.

If this is the case, check the communication status by clicking [Browse] on the [Connection
Setting] window.

If "Connected" is shown in the [Status] column, it means that the communication between the
loader and the inverter has been resumed and you can enable the [Drive operation] menu and
the terminal operation buttons by clicking C at the right of the [Drive operation] menu.

x
Advance.. | Delete |
| Ma. Status Mode| Equipment Address -
T [Unknavn Unkriown to . (TN 1
v 2 Linknawn Unknown Mo [INW2 2
- 3
- 4
- ]
- i
- 7
- g
- q
o Click [Browse].
- 11
|l 12 hd
]
Browse | (0]4 | Gancel |
x
Advance.. | fete— Check if "Connected" is shown.
| No. | Sta | Model | Equipment Address -
i @D VF1A INV1 1

v 2 |Disconnected Unknown Mo, [INW2 2
r 3

If "Connected" is shown after you click [Browse] but the [Cannot communicate with inverter]
dialog appears when you attempt to use the [Frequency command/operation command change]
field, the inverter may have password protection enabled. If this is the case, you must disable
the password protection of the inverter. For more information on password protection, refer to
the instruction manual or user's manual of your inverter.
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[2] "LE" Enable Communications Link Is Assigned

If "LE" Enable communications link is assigned to the general-purpose input signal (X terminal)
and "LE" is OFF, you cannot use the drive operation buttons and the frequency command field
even after you change the [Frequency command/operation command change] field to a

non-zero setting.

The drive operation buttons and the frequency
command field are disabled.

nnn= Gpply |3: Freq. = Loader, Ope. = Loader ;I Bpply I

In this case, you can enable the [Drive operation] menu and the terminal operation buttons by
clicking C at the right of the [Drive operation] menu after enabling "LE" or unassigning "LE".

You can check the assignment and ON/OFF status of "LE" Enable communications link, using
the [Operation Monitor] > [I/O Monitor] window. The following example shows what is displayed
when "LE" Enable communications link (E01=24) is assigned to the X1 terminal and "LE" is OFF
(i.e., the X1 terminal is OFF).

M Operation Monitor

/0 monitor |5ystem manitar I flarm monitor I Cperation status monil

Ihput terminal

Terminal | Function name Hormal | Status

=1 [LE] Enable communications link... |Open -

To assign "LE" Enable communications link, use function codes E01, E02, and so on. For more
information, refer to the User's Manual of your inverter.

[3] The Inverter Has a Realtime Clock (RTC)

If the loader is connected to an inverter model that has a realtime clock (RTC) and the realtime
clock (RTC) is not configured (or it is initialized), you cannot operate the inverter with the
schedule operation function enabled. To operate the inverter, you should configure the inverter's
date and time or disable the timer operation function.
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AWARNING

e Carefully note that resetting the alarm with the operation command on causes the inverter
to start unexpectedly as soon as the alarm is cleared.

Failure to observe this could result in an accident.

o If the loader goes down or is forcibly terminated during the operation with the test run
screen open, it will be impossible to stop the inverter operation with the loader. If this is the
case, stop the inverter by doing one of the following:

Failure to observe this could result in an accident.
<How to stop the inverter when the loader goes down or is forcibly terminated>
1) If an emergency stop switch is available, use the switch to stop the inverter.
2) Turn off the inverter power.
3) Turn off the inverter operation command and switch the inverter from "remote command
mode" to "local command mode".
More specifically, do one of the following:
- Turn off the terminal to which the "LE" command is assigned.
- Zero the data for the link function for support (function code: y99).
- Zero the data for the link function (function code H30).

¢ Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test

run screen open. Doing so would be dangerous because it would be impossible to stop the
inverter operation with the loader.

Failure to observe this could result in an accident.

Even after you have stopped the inverter by doing one of the above, the settings of the inverter's
frequency command via internal communication (communication dedicated function code S05),
operation command (communication dedicated function code S06), and link function for support
(function code y99) will be retained. If you attempt to operate the motor in this state, the motor
may suddenly start. For safety, reset the data of the above function codes (S05, S06, and y99)
to 0 by following these steps:

1) Turn off the power to the inverter. Wait for the inverter to completely stop. Then turn back
on the power.

2) Zero the data of the link function for support (function code y99) using a keypad. Then start
the loader and zero the data of the frequency command via communication (communication
dedicated function code S05) and the operation command (communication dedicated
function code S06) on the [Function code edit] window.
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2.4. Setup

The [Setup] menu provides the following submenus:

Setup | Wiew  Window  Help

Communication Setup...
Browze

Language 3
Fegion spec. 3
Date time

This section describes the main functions available under the [Setup] menu.

2.4.1. Communication Settings

Refer to "1.5.5.1. Communication Settings".

2.4.2. Browse

Not available.
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2.4.3. Language

You can configure the language settings of the loader. From the main menu, click [Setup] ->
[Language] to select the desired language and then exit from the loader.

&2 Doesa Loader - Quick Access Menu
File Menu | Setup | View Window Help
Dl Communication Setup.. P (X @I
Browse
[ Laneusee VL] darese ]
Region spec. > English
Date time

Restart the loader and the selected language will be displayed.

* The selected language will not be displayed until you restart the loader.

&8 Doesa Loader - B # A=~
I AZa=(M) | £2h792%S)
DER &a #EREo

HEEARFR(S)

FT(V)

|
UMD AITH)
2w X W

()

|

ftret
B1T-85%1

»

Tip o Depending on the language supported by the operating system, you may not be
able to select Japanese language.
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2.4.4. Region Spec.
You should configure [Region spec.] correctly according to your inverter.

Tip ¢ You can identify the inverter region spec. from the inverter model number printed
on the rating nameplate of the inverter. For more information, refer to "2.2.1. [1]
Model, Regional Specification, Voltage, Capacity" or the instruction manual of
your inverter.

If the region spec. you specify in the loader does not match the region spec. of the inverter, the
following problems may occur.

e The inverter model you want to connect is missing from the list box on the [Default setting]
window accessible by clicking [Function code edit...] -> [New...] -> [Default setting] from the
Quick Access menu.

e The communication wirings and the inverter and arning

loader communication settings are correct but

i i . i J_IA Failed to get the inverter model information.
an attempt to communicate with the inverter fails =
with the message "Failed to get the inverter
model information” displayed.

You can change the loader's region spec. setting by clicking [Setup] -> [Region spec.] from the
main menu.

&2 Doesa Loader - Quick Access Menu
File Menu | Setup | View Window Help

DEd Communication Setup.. (X e @D

Browse

Language

Region spec. [V] suaran |

Date time A:ASIA

C:CHINA
E:EUROPE
L:USA
K:KOREA

When you are finished changing the setting, exit from the loader.
Restart the loader to apply the new region spec.

* The new region spec. will not be applied until you restart the loader.

Tip e Normally, you set the region spec. once when you start the loader for the first time.
Refer to "Setting the Operating Environment" in "1.5.3. Starting the Loader" for
details.
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2.5. Edit

Once you open the [Function Code List] window, the [Edit] option is added to the main menu.

ﬂ Doesa Loader - Function1 - [Function1]
> File Menu Setup | Edit | View FunctionCodeEdit Window Help
Ded gl o nda i D8 S EEE

Factory shipping value

Function code edit l Auto-

Search

[Undo]: Click this button to restore the second most recent setting of the
function code you edited in the [Function code edit] window.

[Factory shipping value]: Click this button to reset the function code setting selected in the
[Function code edit] window to the factory-set value.

[Search]: Refer to "2.3.1.1. [8] Search (Search function code terminologically)".

Tip e You can open the [Function Code List] window by selecting [Function Code] from
the Quick Access menu. Refer to "2.3.1. Function Code " for details.
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2.6. View

You can specify which elements to display on the loader screen.

-File Menu Setup | View | Window Help
DS &[0 [ Tooba

Status Bar

Toolbox

Project management window

Output window

2.6.1. Toolbar

You can show or hide the toolbar.

Showing the toolbar allows you to use your desired feature (such as the Quick Access menu) by
just clicking its icon.

Toolbar

*f
| [No:Unknown

Status Bar

2.6.2. Status Bar

You can show or hide the status bar.

For information on what is displayed on the status bar, refer to "2.1. Main Window".
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2.6.3. Parameter Information and Character size

These menu items are added once you open the [Function Code List] window.

Wigw

FunctionGodeEdit

Wifindow

} — Parameter Information

Toolbar

Status Bar

Toolbo

Chtput wirdom

Parameter Ihformatio
Character zize

This menu item provides the same function as the [Function code
information] button on the [Function code edit] window.

Select it to display the information of your selected function code in

the function code information window.

Project management window

L— Character size

Select this menu item to open the [Font] window (as shown below).
The [Font] window allows you to change the font for the function
code names in the [Function code edit] window.

x
Font: Fort style:
Microsoft Sans Serf] IHeguIar QK I
Microsoft Sans SeriflE) Regular - | Cancel |
Palatino Linotype Obligue
Seqoe Print Bold
Segoe Scipt Bold Oblique
Segoe UI | =l
— Effects ~Sample
[~ Strikeout
™ Underine e
Script:
I‘Nes’[em LI

Example: Default font

Auto-tuning I File information I

[=)- Function
- Code group
- F code

Change | Mo,

Function code name Setting valug

FO0 | Data protection

Fo1

Frequency setting 1 ]

After you change the font to Tahoma, Bold Oblique, 18 pt

Function code edit | Autotuning

I File information I

[l Function

E| Code group
. Fcode
-E code
-C code
-P code

Tip

Change |

No. Function code name Setting value
FOO0 | Data protection
Frequency setting 1

FO1

e Once you close the [Function Code List] window, the font settings will be reset to

the defaults. You cannot save the font settings.

e The font settings are ignored when you print the data.

¢ You can open the [Function Code List] window by selecting [Function Code] from
the Quick Access menu. Refer to "2.3.1. Function Code " for details.

e The [Function code edit] window is actually a tab of the [Function Code List]

window.
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2.6.4. Toolbox, Project Management Window, Output Window
These menu items are activated once you open the [Customizable logic] window. They allow

you to show or hide the windows relating to the customizable logic function. For information on
these windows, refer to "2.3.3.2. Editor Screen".

Yiew | Window  Help

Toolbar 1 Toolbox
Statuz Bar Show or hide the toolbox.

] Toobox >

Project management window, — Project management window
Chutput windom ~‘ Show or hide the project management window.

|

R

Output window

Show or hide the output window.
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2.7. Function Code Edit

Once you open the [Function Code List] window, the [FunctionCodeEdit] option is added to the
main menu.

ﬂDoesaLoadef-Fun(ﬁonl-[Functiom]
¢ File Menu Setup Edit View | FunctionCodeEdit | Window Help

; D @g é& (!) 03 Import.. :«7 &

Export

£ ey

’I Auto-tuning | File inf

iomodh

Export to CSV ( Last error Info.)  » Sommur

3.2 loader compatible write Function code import

= Function
= Code group

Change | No. Function code name Change the definition file

2.7.1. Import and Export

This function allows you to save the function code setting data to a file in CSV format and
restore from the CSV file.

This is useful when you want to edit function code settings in an external application such as
Microsoft Excel and then load them into the loader.

Import

Allows you to import function code settings from a function code data file in the CSV format and display them

in the [Function code edit] window. Before you import the settings, you should open the [Function Code List]
window.

After selecting a CSV file to be imported, [Import setting] dialog is displayed.

— Import target selection

Select whether to import data that has different set values depending on the voltage series and
capacity, and read-only data such as for monitoring.

For more information for such data, refer to the “User's Manual” or "RS-485 Communication User's
Manual" for your inverter.

& Import setting

x| Continue
W Import voltage / capacity dependent data. Click this button to proceed the

import operation.

_Cameel ¢ 1 Gancel

Click this button to cancel the
import operation.

Import read-only data.

N

Additional information

Displays messages if the CSV file to be imported differs from the inverter model, voltage, capacity,
version, or etc. in the current [Function Code List] window. If it is the intended import operation,
press the [Continue] button to proceed the operation. In that case, some data may not be imported
correctly, therefore make sure that the intended result is obtained after the operation.

Nothing is displayed here if the settings of the CSV file to be imported matches to [Function Code
List] window.

2-201



Export

Allows you to export the function code settings in the [Function code edit] window to a CSV file.
Before exporting the settings, you should select the function code you want to export from the tree view of
the [Function code edit] window.

E"'m For example, to export all the function code settings, select the [Function] node at the top
E G_l:lle group of the tree.
¢ i Fcode
..... E code
=- Function To export a particular function code group, select the function code group you
El Ciode group want to export from within the tree.
----- E code

After selecting the function code(s), click [Export].

You can edit the exported CSV file in an external application such as Microsoft Excel.

Tip e You can open the [Function Code List] window by selecting [Function code edit...]
from the Quick Access menu. Refer to "2.3.1. Function Code " for details.
e The [Function code edit] window is actually a tab of the [Function Code List]
window.
o |f two or more instances of the [Function code edit] window are open, the imported
settings are displayed in the active instance of the [Function code edit] window.

¢ You cannot use [Import] or [Export] on the customizable logic function code list.

[1] CSV File Format

The following example shows the format of a CSV file that contains the exported function code
data. For more information on the format, refer to "CSV File Format" in "3.2.2. Function Code
Setting Specifications".

Column number

1 2 3 4 5 6 7 8
éu 1 Doesa DF1A 900, 900, 8, U, 4, 2022/03/01-00:00:00
S Loader,

C

% 2 | Func, Function code name, S_Gitf"_]g Factory default

~ 3| Foo0, Data protection, ro, V0
| 1

4 | FO1, Frequency setting 1, !0, 1 0
[ :
]
[comment]

Editable

Figure 2-2 Format of a CSV file that contains function code settings
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[2] Editing a CSV File

To avoid import failures, you are recommended to edit an exported CSYV file to create a CSV file
for import. In addition, you are recommended to save the function code settings to the FNL
format as well as the CSV format and manage both the FNL and CSV files. You can avoid import
failures by opening that FNL file while you are importing the data.

Basically, you should only edit the settings of the exported CSV file (the portion enclosed in
dotted lines in Figure 2-2 above). You should edit the settings correctly in accordance with the
following input rules.

Setting input rules

(1) Afunction code setting should be configured using a decimal or hexadecimal value. You
cannot use a string such as "OFF".

When using a decimal value: You can use single-byte numbers (0 to 9), minus
sign (-), and decimal point (.).

When using a hexadecimal value: Prefix the value with 0x. You can use single-byte
numbers (0 to 9), alphabets ato fand Ato F.
Example: A decimal value of 32767 is expressed in
hexadecimal as Ox7FFF.

(2) Enter a value within the valid range for the function code. A value outside the valid range will
not be imported. You can check the valid range for a function code in the [Function code edit]
window.

(3) You can enclose the setting in double quotation marks.

Example:  You can enter "32767" to represent a decimal value of 32767.

(4) The setting of 999 has a special meaning and is treated as a decimal value of 32767
(OX7FFF in hexadecimal).

Example:  The valid range of VF1A F40 torque limit value 1 (drive) is 0 to 300 %; 999,
where '999' means "no operation” rather than representing a percentage and it
is treated as 32767 in a CSV file.

(5) Strings such as "OFF", "Auto", and "Inherit" are treated as a decimal value of either O or
32767 (0x0 or OxX7FFF in hexadecimal) depending on the function code. For more
information, refer to the description of the data format in the "RS-485 Communication
User's Manual" for your inverter. Or export function code settings that include strings, open
the exported CSV file, and check the numeric values.

Example:  The valid range of VF1A F50 electronic thermal (for breaking resistor
protection) (rated discharge withstand current) is 1 to 9000 kWs; OFF,
where "OFF" is treated as a decimal value of 32767 (Ox7FFF in hexadecimal).

Tip o If in Microsoft Excel you convert an exported CSV file to a different format such as
XLS, edit it and re-export it to a CSV file, you may be unable to import the
resulting file. If this is the case, open the CSV file in a text editor (such as
Windows Notepad) and check if it complies with the rules described in "Figure 2-2
Format of a CSV file that contains function code settings".

Tip o If a warning such as "Model mismatch", "Voltage mismatch", "Capacity
mismatch”, or "Some function codes cannot be loaded" appears when you
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attempt to import a CSV file, there may be a mismatch in model, voltage,
capacity, or inverter ROM version between the CSV file and the [Function code
edit] window.

To check for any mismatch, abort the import and export the function codes from
the [Function code edit] window. Then compare the CSV file you are going to
import with the exported CSV file.

For more information on the CSV file format, refer to "Figure 2-2 Format of a
CSV file that contains function code settings".

If a mismatch is found, correct the CSV file you are going to import so that it
matches the exported CSV file.

[3] Recommended Way of Use
You are recommended to primarily use the [Function code edit] window when you configure
function code settings and use the [Export] and [Import] functions as needed for assistance.

An example of use is shown below:

Edit the function code settings in the [Function code edit] window.

i
K peu s [0 fen Peesdeeles g 3 '.:1
IR DL WL LT )

Export some of the function
code data and edit it using a
spreadsheet application or a text
e editor.

A A i
K peu s [0 fen Peesdeeles g 3 '.:1
IR DL WL LT ) .
Vv 28 [ e | £ et
_

Import the function code settings from a
CS8V file to the settings you edited in the
[Function code edit] window.

-
e
T3

M AL
=1 =5

el Ll L e |L|J
ptse =4 T =] D= |

Tip e To avoid import errors, save the function code data to the FNL format as well as
the CSV format.

Before you import the function code settings, select [Function Code] -> [Read from
the file] to open the FNL file you saved when you exported the data.

2.7.2. Export to CSV (Last error Info.)

This function is same as the [Save...] button in the error window as shown below. This is used to
save the error information to the CSV file in case closed the error window without save the
information.
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An example of the error window with the [Save...] button

Inverter access error {Write) _1Ol x|

Mum. | Function code name Error code
(N Terminal [41] function {Inwerter statuz error) It can't be written. {Aeccess toward a function which of

Terminal [¥2] function (Trverter statuz error) It can't be written. (Access toward a function which c

ok | s D

The submenu shown in right hand is activated ﬂ Communication (read or write)
after the error window is displayed even once. Function code import
~ | Ghanee the definition file

A

2.7.2.1. Commuication (read or write)

If the error window with the [Save...] button is displayed even once at reading/writing data
from/to the inverter in the [FunctionCodeEdit] window, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window

without saving the information.

2.7.2.2. Function code import

If the error window with the [Save...] button is displayed even once at importing data from a file
in the [FunctionCodeEdit] > [Import...] on the Main Menu, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window

without saving the information.

2.7.2.3. Change the definition file

If the error window with the [Save...] button is displayed even once at changing the definition file
on the [File Information] window, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window

without saving the information.
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2.8. Window

You can arrange the windows on the loader screen.

Flo Mo Setp Vew
DSHE &R0

Cascade

Tile

Arrange Icons
Tile vertically

1 Quick Access Menu

2.8.1. Cascade

Click [Window] -> [Cascade] to cascade windows.

_ﬁbmmmmmmmm
DEd&@Re /ORI PEXe@oBL 68008 E000 00335

Function cods od4. | Auto-tuning | File iformation |
Z B =] | crames |t | Furcion code e St vobe | Setin rnce | Dt setig | Mz | Matum |5 i | Oese v 2
Eﬁ FOD_|Data peotection [T | [] [] 3 1 - | Enable
- ?:; FOl  Frequency setting 1 0|ots 12 [] [ 12 1| - Dissble
_l_' H code FO2 Operation mathed 2ot s 2 [] 3 1] - | Disable
!1‘;‘* Fi3 | Maimum output frequercy | 6010|250 10 5000 _ 00 50 5000 01| Hz | Dissble
b code FOt_|Baae frequency | 500250 % 5000 | 500 250 5000 01| He | Dissble
 code FO5 |Fated voltags s base frequency | 2000 ; 80 to 240 _ 200 80 0 1| v Disable
j,'{ﬂ;, FOb | Maximum output voltage | 200 |80t 240V ;_ 200 80 o 1| v | Disatie
dcode Fo7 o tim 1 600|000 to 6000 5 600 000 soo0[ oot s Enabie
jeke _';I FOB  Deceleration time 1 600|000 to 6000 5 600 000 soo| 001 s m_'ﬂ
4| | > 4| | »
Factorg s | | Fupc. code s | Fuae.cote o || tinlamion. | advanced. | pre. | comparisen. |

Salect bverter Mo 10 11INVI v| Closs
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2.8.2. Tile

Click [Window] -> [Tile] to tile windows.

tionGodeEdn  Wrdow  Help
OXRLPHXe@FDLHE DDIREDEDDGEDODTA@E

— - =

Ghanes | o, Firctioncode mame | Seing vakin | St ranee mmi-| Mol | Mt | eyl w|°‘m,‘:"‘|m o n-j
FO)_[Data protection I ] [ 1= e [
Fil|Frequency settmg | 00t 12 ] 0 2 1 - Disable ]
F02 |Operation method 20t0F 2 0 3 1 = Disable L]

& P — 1 ennlatna. Eanmn &nn aE Eana LEANTS LIS " =

P — " _'I-I

Foctory set | Fupe.code set_ | Fune. cose nto | ptmston. | advenced_ | e | canpuison |

INn. [DEDD vI

Salect bwarter Glose

L0 masitce | System moniter | Alarm monitor | Operation stahes monitor |

Tnpust tarminal Chatput berminal
|1m-iu| | Fumction | Hormal Status ITlminl | Function | Normal Status.
|t [LE] Erable . [Open |1 (RUN] Fwerte._ |Open

[Terminat | Fimction it [ vale [Termnat | Fumction i [ Vol
|2 [More] v o [P tFm [fF-oun 1o v oo
Save G5V fike Betresh | fdvonced |
[Corrwctng. FRNOTSES-2] Togstfworter:  [Wo 1L 10T ]

2.8.3. Arrange Icons

Click [Window] -> [Arrange Icons] to minimize windows and arrange the icons at the bottom of

the main window.

2 Doesa Lo on1 - function]
~ Ele Mew Setwp Edit View FunctionCodeEdit Window Help
DedaRo//OXLPEXeEFL>LHLOE BE080EE L0008 3E

| X Functioni -mﬂ ™ Operation -
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2.8.4. Tile Vertically

Click [Window] -> [Tile vertically] to tile windows vertically.

. Bl Mew et Edit View FunclionCodeEdit Window Help
Dl &Re ORL PHEeIcsPLH6R DD E3D 000035

[Fumction code e ]| Auto-tuning | File information | V0 menitor | Systom monitor | Alaem monitor | peration staties monitor |
Tnput terminsl Dutput terminal
= Terminal Function Hormal 21 | Terminal Hormal =)
= Code group = | chanee | N, Function code name Setting value &ﬂ . || Pama
3 1 [LE] Enable .. Open 1 [RUM] bwerte.. [Opon
£ Jfata protection g 2 [552) Select - Dpen 2 0L] Mstor av.. [Open
Fil |Frequency setting | (L - i S =
732 [Operation metod T 3 [554) Select i&m 0Ry [ALM] Alarm _ |Open
FO3 | Maximum output frequency 1 6025, xa [BEKD Grswt . [Opat
Fit[Base frequeny | 50825 s [RST] Reset _ (Open
FUS | Flated voltage at base trequency 1 0 En1 — (Clise
- — - -
FO5 | Maximum output voltage 1 20080 = 1 Ll_l - | -
FO7 |Acceleration time 1 600 |00
FO8 |Deceleration time 1 600|00
Funclion - Terminal Furetion -
F09 | Torque boost | 430 ] runeta (L = . e Unit =
FI0 | Electrons: thermal averbasd prots_ i 12 (] v FMFM)  |[F-ount 1] Cut |V
FI1 | Ebsctronic thermal cverkosd prote_ 2250 (00 C1 1 functi | [More] A - FM (FMD [F-cut 1]0ut_ |mA |
Fi2 |Emectronic thesmal cverload prote. (13013 G V2 functi_ | [More] W FM (FMP) [Focut 1] 0wt [pi's
Flé |Restart mods after momentary po. Poe FM2(FMV) | [=AC] Output_ [V
FI5 |Frequency limiter {Upper limit) 0000 FM2 (FMD [I-AC] Qutpt _ | mA
Fif [Frequency limiter (Lower limit) [T
FI8 [Bias (for frequency setting 1) -1,
Al S .I—' ) 1 ."I 4 | »
Bead.. I Wite l Factory set |  Func. code sel_ I m.w.m.-' = I
Sefect Fverter |Nn. [ v| Close [Conrmctre vrin Ezinsss etor: [N 10 111NV v|
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2.9. Help

2.9.1. Search the Topics

Not available.

2.9.2. About

Displays the version and copyright information for this loader.

ﬂ Doesa Loader
Eile Menu Setup View lWindow | Help |
() n éa‘:, & [0} % O QOQ &) Search the topics & &7 ® :] ___

About...

Implemented the management function of the additional definition library files.

Version number and copyright X
Version
VED Do=sa Loadex // The main version that integrates
Version 1.1.0.32.0@

executable and definition files.
Copyright (C) 2022 IDEC CORPORATION.

A1l rights reserved. File Vi .
File Version 1.1.0.32.0 @ lle version

'[; """""" ;‘;}““;“‘ """""""""""" Version of the executable file itself.
efinitions Library ~~
Base set 0000 \

Definitions Library

Installed definition file library type and

Add-N Setting . version are listed here.

Add-IN Setting
Displays the Add-in setting window which manages additional definition library files.
The files will be provided as needed by IDEC CORPORATION.

Add-in setting *

Add an add-in

up Add with Sort

Cancel

0K
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Chapter 3

Reference Information

This chapter provides information on troubleshooting and standard specifications.






Chapter 3 Reference Information

3.1. Frequently Asked Questions

3.1.1.

Loader Specifications

Q1.

What is the supported OS?

A1,

The supported OS is Microsoft 8.1, and 10.
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3.1.2. Communication-Related Information

3.1.2.1.

Connection Methods and Connection Devices

B Recommended Cables

Q1.

Where can we get these cables?

A1,

Cables For Connecting RJ-45 Connectors
Commercially available LAN cables can be used.

Cables for Connecting Terminal Blocks
Not available from IDEC CORPORATION.

Recommended cable is as follows.

Manufacturer: Furukawa Electric Co., Ltd. AWM2789 Long distance connection
cable and so on.

For these products, please contact Furukawa Electric Co., Ltd. or their distributor.

USB Cable
Please use commercially available USB cables.

[1 Refer to "1.2.2.2. [2] Cables (for RJ-45 connector connection)".
[ Refer to "1.2.2.2. [3] Cables (using terminal blocks)".

Bl Connection Methods

Q2.

Is it possible to connect the RJ-45 connector on the inverter to the LAN terminal of
the PC directly using the LAN cable?

A2.

Both the inverter and the PC may be damaged. Never connect them directly.
They must be connected via the RS-232C/RS-485 or USB/RS-485 converter or
the remote keypad with USB.

For information on the specific connection methods, refer to "1.2.2" and "1.2.3".

[ Refer to "1.2.2. RS-485 Communication Port Connection".
[] Refer to "1.2.3. USB Communication Port Connection".
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B RS-232C/RS-485 or USB/RS-485 converter

Q3. Can we get these converters through IDEC CORPORATION? Where can we get
these converters?

A3. | Not available from IDEC CORPORATION.
The recommended converters are as follows:

System Sacom Industry Corp.

- KS-485PTI (RS-232C/RS-485 converter)

- USB-485] RJ-45-T4P (USB/RS-485 converter) and so on.

For these products, please contact System Sacom Industry Corp. or their distributor.

Q4. | The converter is not recognized by Windows 8 or later version. Any solution?

A4. | The converter may not be supported by Windows 8 or later version.

Please contact the converter manufacturer because IDEC CORPORATION does not
handle the converters.

If the converter is supported by Windows 8 or later version, it is possible that you
failed in installing the converter drive software. Please reinstall the software.
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3.1.2.2.

USB Communication

B USB Communication
Communication target : Inverter via the remote keypad with USB

: Remote keypad with USB

Q1.

USB communication does not work.

Q1.

The following message is displayed: "Failed to obtain the inverter model
information."

Al-1.

Power may not have been supplied to the inverter.

Al-2.

The USB driver may not have been installed.

Confirm that [Driver for FRENIC USB interface] is displayed under [Loader USB
device] on the Device Manager of the Windows PC.

For information on the specific confirmation procedure, refer to "1.4.1.5".

0 Refer to "1.4.1.5. Checking the USB Driver".

If [Unknown device] is displayed instead of [Driver for FRENIC USB interface], set
up the USB driver again. For information on the specific procedure, refer to
"1.4.1.4".

[J Refer to "1.4.1.4. USB Driver Installation Procedure".

If neither [Driver for FRENIC USB interface] nor [Unknown device] is displayed,
refer to "Q2".

[] Refer to "Q2.".

Al-3.

If you are using the USB hub, stop using the hub.

Al-4,

The Message Manager may not have been installed.

Confirm that the Message Manager icon M| is displayed on the task bar of the
Windows PC while the Loader is running.

For information on the specific confirmation procedure, refer to "1.5.4.1".

[ Refer to "1.5.4.1.Checking the Startup of the Message Manager".

If the Message Manager icon M| is not displayed on the task bar of the Windows
PC, uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

[0 Refer to "1.4.2.2. Uninstallation of the Message Manager".
[1 Refer to "1.4.1.6. Installation of the Message Manager".

If the Message Manager icon M. is displayed on the task bar of the Windows PC,
refer to "Q3".

[l Refer to "Q3".
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Al-5.

The timeout setting for the Loader may be too short.

If the timeout is set to a value smaller than 1.5 s, a communication error may be
detected before the Loader receives a response from the communicating device.
Set to a value larger than the default value and try to see if communication is
possible.

Set the timeout setting on [Communication Conditions] on the [Communication
setting] window. Refer to "1.5.5.1. [3]" of this instruction manual.

[l Refer to "1.5.5.1. [3] Communication Conditions".

Al-6.

When the communication target is the inverter via the remote keypad with USB
The inverter may not be applicable to the communication via the keypad.
For the correspondence table, refer to "1.1.1" of this instruction manual.

(1 Refer to "1.1.1. Features".

Al-7.

When the communication target is the inverter via the remote keypad with USB

The keypad may have been connected to the RS-485 communication port 2 of the
inverter.

Connect to the RS-485 communication port 1.

Al-8.

When the communication target is the inverter via the remote keypad with USB

If a LAN cable is used for the connection between the keypad and the inverter, the
LAN cable used may be a cross cable. If a cross cable is being used, replace it with
a straight cable.

Al1-9.

When the communication target is the inverter via the remote keypad with USB

The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that the setting is as follows: [USB connection], [Data in Inverter (via
VF1A-PH1)].

For information on the specific setting procedure, refer to "1.5.5.1".

1 Refer to "1.5.5.1. Communication Settings".

Al1-10.

When the communication target is the inverter via the VF1A-PH1 remote keypad
with USB

The address set on [Address] (for the RS-485 station address) on the [Connection
setting] window accessed from the [Communication setting] window of the Loader
may not the same as the station address of the inverter. Make sure that the address
is the same.

For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2".

1 Refer to "1.5.1. Setting Function Codes Related to Communication on the
Inverter Side".

1 Refer to "1.5.5.2. Connection Setting".

Al-11.

When the communication target is the remote keypad with USB

The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that the setting is as follows: [USB connection], [Data in Keypad].

For information on the specific setting procedure, refer to "1.5.5.1".

[ Refer to "1.5.5.1. Communication Settings".
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Q2. | When it is checked whether the USB driver is recognized by the Device Manager,
"Unknown device" is not displayed. How can | make the Device Manager properly
recognize the driver?

A2-1. | The connection between the PC with the USB device may be incomplete.

Check the connection by disconnecting and then reconnecting the USB cable,
connecting to another USB port on the PC, or replacing the USB cable.

A2-2. | It is necessary to connect the PC to the USB device to display "Unknown device".
After that, install the USB driver.

[1 Refer to "1.4.1.4. USB Driver Installation Procedure".

Q3. | Although the Message Manager is running, communication does not work.

A3-1. | The USB driver may not have been properly recognized by the Message Manager.
In such a case, the Message Manager must be restarted. Close the Message
Manager, and restart the Loader.

For information on procedures for closing the Message Manager, refer to "1.4.1.4".
00 Refer to "1.4.1.4. [1] Before Installing the USB Driver".
A3-2. | The Message Manager itself or its registry may have been damaged due to some

reason.
Uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

1 Refer to "1.4.2.2. Uninstallation of the Message Manager".

1 Refer to "1.4.1.6. Installation of the Message Manager".
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Q4.

After changing the function code from the Loader, | checked it using the keypad and
found that the function code was not changed.

A4,

If you are using the remote keypad with USB, the port setting on [Communication
setting] of the Loader may be set to [USB connection], [Data in Keypad]. If that's the
case, change the setting to [Data in Inverter (via VF1A-PH1)].

For information on the specific setting procedure, refer to "1.5.5.1" of this instruction
manual.

0 Refer to "1.5.5.1. Communication Settings".

Q5.

Set the Loader to work offline from the inverter (for example, bringing the Loader to
your office), edit the function code on the Loader, and write the edited result in the
remote keypad with USB.

Is it possible to copy the edited data to the inverter just by using the keypad (at the
work site) without using the Loader?

A5,

Yes. It must be noted, however, that it is possible only with the models that support
the keypad as standard or as an option. For information on the keypad support
details, refer to "1.1.2. Table 1-1" of this instruction manual.

(] Refer to "1.1.2. Table 1-1 Correspondence between VF1A Series Inverter
Models and Loader Functions".

If customizable logic is used, care must be taken.

If the customizable logic is used for the inverter that supports the setting specified in
[Open customizable logic setting screen] under [Function code setting], both the
basic function code settings (such as F, E, or C codes) and customizable logic
setting (Uxx) must be written when writing the data from the Loader to the keypad.

For reference information, refer to "2.3.3.9" of this instruction manual.

1 Refer to "2.3.3.9. [2] To write to the Keypad".

Q6.

USB communication is not possible after the PC enters the standby (sleep) state.

A7.

Disconnect and then reconnect the USB cable. If the communication cannot be
recovered even after that, restart the PC.
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Q7.

The seven-segment LED display on the VF1A-PH1 shows "-Ld-". What does that
mean?

A8.

It means that the connection between the VF1A-PH1 and the inverter is not
established and only the PC side is connected.

If this is displayed while using the Loader, communication with the inverter is not
possible. Check the connection between the VF1A-PH1 and the inverter and take
necessary actions.
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3.1.2.3. RS-485 Communication

B RS-485 communication
Communication target : Inverter via the USB/RS-485 converter
. Inverter via the RS-232C/RS-485 converter

Q1. | RS-485 communication does not work.

Al-1. | Power may not have been supplied to the inverter.

Check whether the power is properly supplied.

Al-2. | When using the USB/RS-485 converter
The USB driver may not have been installed.

Confirm that [USB Serial Port (COM[)] is displayed under [Port (COM and LPT)] on
the Device Manager of the Windows PC.

For information on the specific confirmation procedure, refer to "1.5.2".

(] Refer to "1.5.2. Checking Communication Ports on the PC (when Using a
Converter)".

If [Unknown device] is displayed, set up the USB driver again. For information on the
specific procedure, refer to the instruction manual of the converter currently used.

Al1-3. | When using the RS-232C/RS-485 converter

The Loader does not allow switching with RS-232C flow control signals (RTS or
DTR) from the PC. The transmission and reception switching must be done
automatically through monitoring transmission data.

If a converter other than the ones we recommend, confirm the transmission and
reception switching method specified in the instruction manual of the converter
currently used.

There is no problem with the converters we recommend because the transmission
and reception switching is done automatically through monitoring transmission data.

[J Refer to "1.2.2.2. [1] Converter".

Al-4. | The number of the COM port on the Windows may not match with the COM port
setting on the Loader. Check the COM port. For information on the specific
procedure, refer to "1.5.2" and "1.5.5.1" of this instruction manual.

[0 Refer to "1.5.2. Checking Communication Ports on the PC (when Using a
Converter)".

[0 Refer to "1.5.5.1. Communication Settings".
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Al1-5.

The Message Manager may not have been installed.

Confirm that the Message Manager icon M, is displayed on the task bar of the
Windows PC while the Loader is running.

For information on the specific confirmation procedure, refer to "1.5.4.1".

[ Refer to "1.5.4.1. Checking the Startup of the Message Manager".

If the Message Manager icon M, is not displayed on the task bar of the Windows
PC, uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

[ Refer to "1.4.2.2. Uninstallation of the Message Manager".

Refer to "1.4.1.6. Installation of the Message Manager".

If the message Manager icon M, is displayed on the task bar of the Windows PC,
refer to "3.1.2.2. Q3".

[J Refer to "3.1.2.2. USB Communication Q3".

Al-6.

The timeout setting for the Loader may be too short.

If the timeout is set to a value smaller than 1.5 s, a communication error may be
detected before the Loader receives a response from the communicating device. Set
to a value larger than the default value and try to see if communication is possible.

Set the timeout setting on [Communication Conditions] on the [Communication
setting] window. Refer to "1.5.5.1. [3]" of this instruction manual.

[1 Refer to "1.5.5.1. [3] Communication Conditions".

Al-7.

The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that it is set to [RS-485 connection].

For information on the specific setting procedure, refer to "1.5.5.1".

[0 Refer to "1.5.5.1. Communication Settings".

Al-8.

The [Baud rate] for the RS-485 connection set under the [Communication setting] of
the Loader may not be the same as the [Baud rate] of the inverter.

Make sure that the baud rate is the same. For information on the specific setting
procedure, refer to "1.5.1" and "1.5.5.2".

[0 Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter
Side".
[1 Refer to "1.5.5.2. Connection Setting".

Al-9.

The address set on [Address] (for the RS-485 station address) on the [Connection
setting] window accessed from the [Communication setting] window of the Loader
may not the same as the station address of the inverter. Make sure that the address
is the same.

For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2".

[0 Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter
Side".
[) Refer to "1.5.5.2. Connection Setting".
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A1-10. | Some models have a multiple number of RS-485 communication ports. (Example:
VF1A series)

If a communication port on the terminal block is used instead of the communication
port for keypad connection, the default value of the function code for setting the
communication protocol must be a value other than the Doesa (Loader) protocol.
Make sure that it is set to "Doesa (Loader) protocol".

For information on the specific setting procedure, refer to "1.5.1".

[ Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter
Side".

Al-11. | When using the inverter with two RS-485 ports

If both the RS-485 settings 1 and 2 of the inverter are set to "Doesa (Loader)
protocol", communication is not possible when the Loader is connected to the
RS-485 communication port 1. Connect the Loader to the RS-485 communication
port 2 or change the protocol option for the RS-485 setting 1 to a value other than
[Doesa protocol].

Q2. | Is it possible to use the Loader while communicating with the inverter with two
RS-485 ports?

A2. | It is possible to use the general-purpose communication together with the Loader.
Likewise, with the communication using the field bus option, the Loader can be used
at the same time.

It must be noted that, if the function code is changed from both of them, the data
changed later becomes valid.

Q3. | When using the Loader to control a multiple of inverters equipped with two
RS-485 ports, is it possible to connect one port to the PC and to use the other
port to make a multi-drop connection with other inverters?

A3. | No, it's not possible to use them that way.
Use either one of the ports.

A multiple of inverters can be controlled using the Loader only if they are directly
connected.

* Such connection is not allowed not only for the Loader, but also for ordinary
RS-485 communication. It is because a unique station address must be assigned to
each port.

Q4. | With using the inverter equipped with two RS-485 ports, what will happen if both of
the two ports are set to the Loader (Doesa) protocol?

A4. | We do not recommend that kind of setting.

If the ports are set that way, the one on the terminal block side has the higher priority.
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3.1.2.4. Common to Communication

Q1. | We use the inverter in an application where its continuous operation cannot be
stopped halfway. If the Loader is connected, will it cause the inverter to stop?

A1. | Even if you connect the Loader, it will not cause the inverter to stop working.
However, care must be taken because if you switch to test run, the inverter may stop.

If the operation is controlled using the keypad, care must be taken because the
inverter will stop if you disconnect the keypad by mistake when connecting the
Loader.
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3.1.3. How to Use the Loader
3.1.3.1. Function Code Settings

Q1. | When | tried to make new settings by editing the function codes for the inverter with
400-V specification, it was set to 200-V specification. How can | change the setting to
400-V specification?

A1. | From the Quick Access menu or main menu, select [Function code setting], select
[New] on the [Select data to edit] window, and on the [Initial setting] window, set
models, capacities, and voltage series for the inverter you will be using.

[0 Refer to "2.2.1. Create a New File".

Q2. | Isit possible to compare function codes set values for two or more inverters?

A2. | The function codes for two inverters can be compared simultaneously on the Loader
screen.

When comparing the codes for a multiple inverters, read the function code set values
for every converter, save them as a set data file using the file function, and then
compare a data file with the next one opened one after another.

For information on the comparison function, refer to "2.3.1.1. [6] Compare" of this
instruction manual.

The set data can also be saved in CSV format, so the data can be compared using a
commercially available software.

For information on saving in CSV format, refer to "2.7" of this instruction manual.

(1 Refer to "2.3.1.1. Function Code Edit [6] Compare".
[0 Refer to "2.7. Function Code Edit".

Q3. | | want to perform offline tuning using the Loader, but P04 is not present in the
function code under [Function code edit]. How can | perform offline tuning?

A3. | From the Quick Access menu or main menu, select [Function code edit] and then
select [Autotuning] tab on the [Function code list] window to perform the tuning.

[1 Refer to "2.3.1.2. Auto Tuning".
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Q4. | | cannot read the file where Loader's function code settings are saved.

A4. | For some reasons, the definition files required for executing the Loader may have
been lost.

When the function code settings are saved, they are linked to the definition files in
correspondence with the ROM number. Therefore, you cannot read the file if the
definition file that the Loader refers to does not exist when the file is opened.

The definition files are generated when the Loader is installed. To generate the
definition files, uninstall the Loader once and then install it again.

[0 Refer to "1.4.2.1. The Loader Uninstallation Procedure".

[1 Refer to "1.4.1.3. The Loader Installation Procedure".

Q5. | I cannot select models on [New] under [Function code settings]. (Selection options
are not displayed.)

A5. | For some reasons, the files (such as INI file, DLL file) required for executing the
Loader may have been lost or the environment definitions (such as registry setting)
may have been corrupted. Uninstall the Loader once and then install it again.

[1 Refer to "1.4.2.1. The Loader Uninstallation Procedure".
[0 Refer to "1.4.1.3. The Loader Installation Procedure".

Q6. | Model names that are not listed in the catalog are displayed as optional items.

A6. | The Loader is common to applications in Japan or abroad. Therefore, all the
applicable models that we sell in Japan and abroad are displayed.

If models not listed in the catalog are displayed, the [Regional spec.] may be set to
an optional item other than [J: JAPAN]. On the main menu, select [Setup] and set [J:
JAPAN] for [Regional spec.]. Then restart the Loader.

1 Refer to "2.4.4. Region Spec.".

Q7. | After writing function code data in the inverter using the Loader, | read the written
data. The values read were different from what | just wrote in.

A7. | Some function codes (H42, H43, H44, H47, H48, etc.) including those related to

the run time or service life are set as monitor only or updated according to
operation. Therefore, the read value may be different from what was written in.

Applicable function codes are different depending on the inverter models. Refer to
the instruction manual or user's manual for the inverter model currently used.
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Q8. | With the inverter models provided with the password function, it is not possible to set
or change the password from the Loader.

A8. | Password setting or changing via communication is disabled on the inverter side to
prevent malicious password decoding.

Unlock the password from the keypad.

3.1.3.2. Alarm History

Q1. | When | checked the alarm history using the Loader, | only found numerical data in
the function code settings.

A1. | The numerical data that can be confirmed on [Function code edit] window indicates
alarm code numbers.

Refer to the alarm code table provided separately in the RS-485 Communication
User's Manual.

If you access the [Alarm monitor] tab on the [Operation monitor] window selected
from the [Operation monitor settings] on the Quick Access menu, the alarm codes
can be checked in the same format as those displayed on the keypad.

[ Refer to "2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information)".
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3.1.3.3.

Customizable Logic

Q1. | What should | enter in the [Version] displayed for [Inverter model selection] when |
select [New] after selecting [Customizable logic] and [Select edit data] on the Quick
Access menu?

A1. | Setthe ROM version of the inverter.

For information on checking the ROM version, refer to the instruction manual or
user's manual for the inverter model currently used.
If the Loader is connected to the inverter, you can confirm the ROM version on
[Inverter ROM version] displayed on the [System monitor] tab on the [Operation
monitor] window that can be accessed from the [Operation monitor settings] on the
Quick Access menu.
The set values entered in [Model] and [Version] affect the usable number of steps
and usable circuit types. The entry in [Version] can be changed at a later stage.
However, if any change is made to [Version], an error may occur when step numbers
are assigned. You are recommended to select a version number that is as
appropriate as possible when creating a new circuit.
0 Refer to "2.3.3.1. Select Customizable Logic Project to Edit"
U Refer to "2.3.2.2. System Monitor
(for monitoring the internal setup information and maintenance status of the
inverter)".
[1 Refer to "2.3.3.12. Project Properties".
Q2. | The newly created project does not work properly.

A2-1. | Check whether the customizable logic is started.
If "UOQ", the inverter’s function code, is 1, it means that the customizable logic has
been started.

A2-2. | Use the comparison function to check if the project is properly written in the inverter.
[J Refer to "2.3.3.10. Comparison".

A2-3. | Check if the user set values required for the customizable logic and the set values
for the storage area are properly written.
[0 Refer to "2.3.3.6. Settings for the User Setting Area and the Memory Area".
[) Refer to "2.3.3.9. Write".

A2-4. | Use the on-line monitoring function to check if symbols and FB inputs and outputs
operate properly.
[1 Refer to "2.3.3.11. Debug Function".

A2-5. | The process execution sequence may not be correct. Check the execution
sequence.
The execution sequence is represented by step numbers.
[0 Refer to "2.3.3.7. Step Number Assignment".
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Q3.

How can | debug a newly created project?

A3.

After you finish assigning the step numbers, use the following functions to debug the
project.

- On-line monitoring function that displays status in the vicinity of symbols

- Trace monitoring function that displays I/O of symbols in waveforms as a realtime
trace

00 Refer to "2.3.3.11. Debug Function".

[ Refer to "2.3.4.10. Combination with the Customizable Logic Function".

Q4.

Can | print the newly created project?

A4.

Either the project layout area or the selected portion of the area can be printed.

U Refer to "2.3.3.15. Printing the Customizable Logic".

Q5.

The newly created project may contain unique know-how. Is it possible to hide
symbols or their connections or to disable any changes to them?

A5.

You can hide or display with a password by using the lock function.

However, it must be noted that the lock function is enabled on the PC, but disabled
on the inverter. If you write the circuit that is protected with the lock function into the
inverter, the circuit can be freely displayed and edited on the inverter. To apply
restrictions to display or edit of the circuit on the inverter, you need to use the
inverter's password function (H197, H198, and H99)

[ Refer to "2.3.3.13. Lock Function".




Q6. | Is it possible to operate processes with different cycles within a project?

A6. | Itis possible depending on the inverter model.
For the customizable logic specifications for each inverter model, refer to
“3.2.4.Customizable Logic Specifications”
However, even for inverter models that do not support such operation, it is possible
to make it appear to process with multiple cycles by adjusting the process 1/O refresh
timing.
For example, for a project whose number of steps for the VF1A model is 75, the
execution cycle is 10 ms.
It is not possible to allow processes with cycles such as 2 ms or 5 ms that is shorter
than 10 ms. Accordingly, the latch function or hold function will be added so that the
I/O signals of the target processes are updated at the integer multiple of 10 ms.

Q7. | Is it possible to share the newly created function blocks (FBs) with other people or
with other PCs?

A7. | The import/export function allows you to use your created FB in the VFD

Doesa-Loader software installed on another PC.

[1 Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]".
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Q8. | Can | use the newly created project on different models?

A8. | If a project is created using only the symbols that are common to different models,
the whole project can be set as an FB so that it can be used among different models
using the import/export function.

By clicking the [Change] button on the [Properties] screen of the project, you can
also change the model on the [Inverter model selection].

If symbols that are not common among different models are used, the newly created
project cannot be used when the number of steps of the created circuit exceeds the
maximum number of steps of another model.

[ Refer to "2.3.3.3. [4] Creating a Function Block (FB)".
[0 Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]".
U Refer to "2.3.3.12. Project Properties".

3.1.3.4. Trace

Q1. | Is it possible to use the waveform data obtained through the realtime trace or
historical trace on a commercially available software?

A1. | The waveform data can be saved in CSV format and thus the data can be used with
commercially available software applications.

Besides, if the waveform data has already been saved in the file formats (extensions:
RT2, HT2, RTM, HIM, or RT1) dedicated to the Loader, read the data on the Loader
by clicking [File] -> [Open], and then save the data in CSV format by clicking [Save
as].

Note that the data saved in CSV format cannot be opened with the Loader.

[1 Refer to "2.3.4.4. Saving the Trace Data".
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3.1.3.5.

Test Run

Q1.

When | try to change [Switching frequency/operation command], the following
message appears and | cannot make any changes: [Cannot communicate with the
inverter. Retry communication?]

Al-1.

An error may have occurred in the communication between the Loader and the
inverter.

Access the [Connection setting] window from the [Communication setting] window of
the Loader and then click the [Browse] button on the [Connection setting] window to
check the state of communication. For information on checking methods, refer to
"2.3.5.3" and "1.5.5.2" of this instruction manual.

[0 Refer to "2.3.5.3. If You Cannot Use the [Drive operation] Menu".
[0 Refer to "1.5.5.2. Connection Setting".

If "Not connected" is displayed, check communication cable connections or
communication settings. For information on checking methods, refer to "3.1.2.2. Q1."
and "3.1.2.3. Q1." of this instruction manual.

[ Refer to "3.1.2.2. USB Communication Q1".
[] Refer to "3.1.2.3. RS-485 Communication Q1".

If "Connected" is displayed, refer to "A1-2" on the following section.

Al-2.

If you cannot change [Switching frequency/operation command] even if "Connected"
is displayed when the the [Browse] button is clicked, the inverter may be rejecting the
[Switching frequency/operation command] request. With the inverter provided with
the password function, the cause could be that the password protection has been
enabled.

If the [Password protected] dialog is displayed when [Read from Inverter] is selected
on [Function code setting], it means that the password protection is enabled.

If that dialog is not displayed, select [Read from Inverter] on [Function code setting],
and then try writing in the function code y99 on the [Function code edit] window. If the
[Password protected] dialog is displayed, it means that the password protection is
enabled.

If the password protection is enabled, it needs to be removed.

For information on password protection, refer to the instruction manuals or user's
manuals of relevant inverters.
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3.1.4. Terminology

Q1. | What does the "Message Manager" (hereinafter referred as "the MM")?

A1. | Itis a software that controls communication between our Loader and the inverter. If
the Message Manager is not installed, if it was deleted, or if the existing one was
overwritten by reinstalling the Message Manager, communication may be disabled.

[ Refer to "1.5.4. Overview of the Message Manager".

Q2. | What does the "definition file" mean?

A2. | It is a file that contains information required to identify various models and their
functions.

If new function codes are added as functional improvement to a certain model, a new
definition version (file name) is given to the new one of the same model.

Our naming rule specifies that a file name must include the ROM number. When
function codes with attributes are read from the inverter, optimum definition files are
automatically detected. If you attempt to write function code set values in the inverter
with different ROM number, a warning will be displayed.

In such a case, select definition files again and perform writing. Writing should be
normal now.

[0 Refer to "2.3.1.3. [3] Changing a Definition File".
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3.2. The Loader Standard Specifications

ltem

Specification

Remarks

Name

VFD Doesa-Loader

Supported inverters

Doesa VF1A series

- With special inverters other than
standard series models, function
codes may not be properly
displayed.

Number of connected
inverters

For USB connection: Only one inverter
For RS-485 connection: 31 inverters max.

Supported keypads

Remote keypad with USB: VF1A-PH1

+ The VF1A-PH1 is an optional
product.

- For information on the kepyad
support detail, refer to "1.1.2. Table
1-1  Correspondence between
VF1A Series Inverter Models and
Loader Functions" or catalogs of
relevant inverters.

Recommended cable

RS-485: Shielded twisted-pair cable for long
distance transmission

USB: USB cable (mini B connector)

RS-485 connection: Refer to "1.2.2.
RS-485 Communication Port
Connection".

USB connection: Refer to "1.2.3.
USB Communication Port
Connection".

Supported OS

Microsoft Windows 8.1
Microsoft Windows 10

32bit/64bit
Japanese/English

Memory

2 GB or more

4GB or more is recommended

Storage

Approx. 800 MB or more of free space

Serial port

Operating environment

RS-232C, USB

In case of RS-232C, conversion to
RS-485 is required to connect to the
inverter.

In case of USB, remote keypad with
USB or conversion to RS-485 is
required to connect to the inverter
not equipped with USB.

Monitor

Monitor with 1024 x 768 or higher resolution

FHD (1920 x 1080) or higher is
recommended.

Communication
port

COM1 to COM255

PC port used for loader

Baud rate

Transfer specification

USB connection:
12 Mbps between the Loader and the
Remote Keypad with USB port
Between the Remote Keypad with USB
port and the inverter

VF1A-PH1: 19200 bps

For RS-485 connection:
115200, 76800, 57600, 38400, 19200,
9600, 4800, 2400 bps

- 19200 bps or faster is
recommended

- The available communication
speed varies depending on the
inverter model and communication
protocol.

Communication
protocol

Doesa protocol (Loader protocol)
Modbus RTU protocol

+ The available communication
protocol varies depending on the
inverter model.

Character length

8 bits

Common between protocols.
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Item Specification Remarks

Stop bit length Doesa protocol: 1 bit (fixed)
Modbus RTU protocol:
1 bit or 2 bits without parity
1 bit with parity

Parity Doesa protocol: Even (fixed)
Modbus RTU protocol: None / Even / Odd
Retry count None, 1 to 10 times Retry count to communication

timeout error detection

Timeout setting | 100 ms, 300 ms, 500 ms, 1.0 sto 1.9 s, 2.0 to | Set a time longer than the y09 or y19
9.0s,10.0t060.0s response interval time.
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3.2.1.

Type of Files Used by VFD Doesa Loader
Table 3-1 List of Files Used by the Loader
i File operation
File types Flle. Related section
extension Save | Open
2.2.2
224
StanQard Function FNL O O
function 2.2.5
code data
codes 2.3.1.1. [4]
Csv O O 2.7
Function
; 222
code setting Customizable Function 2924
logic function code data FBL @) @) 2'2'
codes 2.5
2.3.1.1.[4]
Error information
- File read error Csv O X -
- Inverter access error
o Monitor data Ccsv O X
monitoring Display  item TXT O O 2.32.1
selection
Mon!tor data of the system csv o % 23292
Operation monitor
monitor i
Mon!tor data of the alarm csv o % 2323
monitor
Operating Monitor data CcSsv O X
state i i 2324
> Dlsplgy item TXT o 0O
monitoring selection
2.2.2
224
Project data CML O O
2.25
2331
. User setting area and
Cu§tom|zable customizable logic memory Csv O O 2.3.3.6
logic area
Input/output check Csv O X 2.3.3.8.[1]
Logic check Ccsv O X 2.3.3.8.[2]
Comparison results Csv O X 2.3.3.10
Common  function blocks EXFBL o o 23314
(FBs)

O: Possible

X: Not possible
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. File File operation .
File types . Related section
extension Save Open
2.2.2
2.2.4
RT2 O O
Waveform data 225
. 2344
Realtime
trace
Csv O X
225
JPG O X
Waveform images 2344
BMP O X
Advanced EXRTM O O 2.3.4.9
222
224
HT2 O O
Waveform data 225
2344
Historical
trace csv o %
225
JPG O X
Waveform images 2344
BMP O X
Advanced EXHIM O O 2.3.4.9
O: Possible X: Not possible
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3.2.2. Function Code Setting Specifications

B CSV File Format

The following section shows an example of CSV file format when the function code data is
exported by selecting [Export] on the [FunctionCodeEdit] window accessed from the main

menu.
Column number
1 2 3 4 5 6 7 8
EE:U 1 | Doesa Loader, VF1A, 900, 900, 8, U, 4, 2022/03/01 - 00:00:00
2 2| Func, Function code name,  Setting, Factory default
% 3 | FOO, Data protection, 0, 0
K 4 | FO1, Frequency setting 1, 0, 0
[comment]
st row
:Srl:g; r: Iltem name Description lt::;c:tt
1 Loader name Fixed at "Doesa Loader". O
2 Inverter model Indicates the model number of the inverter O
3 Inverter ROM | Indicates the ROM version of the inverter O
version
4 Func?tion code set | Indicates the function code version.
version
5 Capacity code Refer to "Table 3-2" shown below.
6 Regi.o!wal. J: Japan, A: Asia, C: China, E: Europe, U: USA, T: Taiwan, i
specification K: South Korea
e A
8 Date and time Indicates the date and time when the data is exported. -
O: Used for importing. -: Not used for importing.
Table 3-2 List of Capacity Codes
Code Ca[xv(;lty Code CTIS\?VC]IW Code CTE\:;VC]IW Code C&E":\?\thy Code CTE\E:V(;IW
1 0.1 8 55 15 37 22 160 29 400
2 0.2 9 7.5 16 45 23 200 30 450
3 0.4 10 1 17 55 24 220 31 500
4 0.75 11 15 18 75 25 250 32 560
5 1.5 12 18.5 19 90 26 280 33 630
6 22 13 22 20 110 27 315 - -
7 3.7 14 30 21 132 28 355 - -
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2nd row

Indicates the item name for the 3rd row and onwards. Not used for importing.

From the 3rd row down to the row above the [comment]

Column Item Description Import
number target
1 Function code nge as the No. column on the [Function code edit] O
window.

2 Function code Same as the function code name on the [Function code i

name edit] window.

Numerical values that correspond to the set values on the

3 Set value ) i O
[Function code edit] window.
Numerical values that correspond to the factory default

4 Fact fault -

actory defau values on the [Function code edit] window.
O: Used for importing. -: Not used for importing.

Row below [comment] and onward

Same as the comment on the [File information]. Not used for importing.
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3.2.3. Tracing Specifications

Table 3-3 Tracing Specifications

Item Realtime Historical

When using the special communication
commands (*1)

Sampling 2 ms to 200 ms (*2)

0.5 ms to 200 ms (*2)

time When not using the special communication
commands
200 ms

Number of 15000 points/channel 500
samplings (Number that can be continuously displayed) points/channel
Numberof | Apajog: 4 channels
displayed data o .
items Digital: 8 channels (*3)

(*1) The special communication commands, the historical trace can be used by the inverters
that support those functions.

(*2) The sampling time setting range differs depending on the inverter model. Also, if the
sampling time is extremely short in real-time tracing, the graph display may be interrupted
depending on the communication speed and communication status.

(*3) If four analog channels are selected, digital selection is not possible.
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3.2.4. Customizable Logic Specifications
B Number of steps

Depends on the inverter models.

Doesa VF1A Series Inverters

Version 300 or earlier
100

Number of steps
Version 400 or later

200

B Execution cycle

Depends on the inverter models.

Doesa VF1A Series Inverters

Execution cycle Depends on the maximum step No. (following table)
1-10 2ms
; 11-20
Maximum step 5ms
No. 21 -50
1) 51 — 100 10 ms
101 — max 20 ms
Multitask function Not available

(*1) If 75 is manually assigned to the step number even if only one step is used, the maximum
step No. becomes 75 and the execution cycle becomes 10 ms.

B Multitask function

Processes with multiple different execution cycles can be mixed and executed at the same
time in one project. The multitask function can be enabled by setting U100 = 127 on the
inverter model which supports it.

For details, refer to the user's manual for each inverter model.
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3.2.5. Replacement of Inverter ROM Versions

When selecting definition files for the function code settings, when newly creating a
customizable logic, or when setting the version using the customizable logic project

properties, for the following inverter models, replace the ROM version and select it according
to the table.

Doesa VF1A series

ROM version Replaced version Remarks
1000 900 VF1A-G21A5S4 or more
6200 900 VF1A-G12A0S4 or less
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